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Getting started

Atlassian's FishEye is the on-premise source code repository browser for enterprise teams. It provides your
developers with advanced browsing and search for SVN, Git, Mercurial, Perforce and CVS code repositories,
from any web browser.

Browse repos from your browser!

SVN, Hg, Git, CVS, P4

files, changesets, revisions, branches, tags, diffs, annotations
side-by-side diffs

unified diffs for word-level changes

see details at the repository, branch, directory, or file levels
filter commits by log message, path, author, date, branch

Search everything

File names, commit messages, authors, text, JIRA issue keys, partial paths, wild cards, camel case
QuickNav

Simple search

Advanced search - SQL-like syntax (EyeQL)

Bookmarks any query

Download search results

Link to any revision, changeset, diff view, line of code, search

Monitor and visualize

Understand what, when, where, who, how changes were introduced
Commit graph for changesets

Activity streams

Charts and reports

Notifications for code activity byemail, RSS, OpenSocial dashboards

Integrate with JIRA and other Atlassian applications

See related JIRA issues
Use smart commits to transition issues
Crucible reviews

[ ]
[ ]
[ ]
® Bamboo builds

Enterprise ready

User management and authentication
Database support and migration
Security

Performance

Backup and restore

Ecosystem

® Marketplace for add-ons
® REST API to write your own custom add-ons e.g. to integrate with other applications
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Get started!

Install and start FishEye on either Windows, or Linux and Mac.
Work through Starting to use FishEye.

Tell FishEye about your repositories.

4. Set up users and groups.

Supported platforms

wn e

This page lists the supported platforms for FishEye 4.0.x and its minor releases.

Key: o = Supported /I, = Deprecated ﬂ = Not Supported
Java
Oracle JRE / JDK O 1.8 FishEye requires the Java Runtime (JDK or
17 JRE), version as noted. Pre-release/Early
access versions of Java are not supported.
OpenJDK @ 1.8 (Linux only)

We highly recommend that you use the Oracle
JVM (or OpendDK for Linux only). Other Java
implementations have not been tested.

You can download an Oracle Java Runtime.

For the OpenJDK, download and install
instructions for Linux flavors are at http://openjd
k.java.net/install/.

Please note:

® Once you have installed Java, you must set
the JAVA_HOME environment variable.
See Installing FishEye on Windows or Insta
lling FishEye on Linux and Mac.

® If you are using a 64-bit JVM, please
ensure that you've set your max heap size (
- - Xnx) to a reasonable value, considering
the RAM requirements of your system.

® |f you intend to run FishEye as a Windows
Service, using the Java Service Wrapper,
you should use the Java JDK rather than
the JRE so as to take advantage of the - se
rver parameter. If you're using the Windo
ws Installer distribution, which handles the
FishEye service differently, using the Java
JRE should suffice.

® You'll need the JDK for the JSP source
download.

® For OpenJDK, you'll need the DejaVu font
package installed. Installation instructions
can be found here: http://dejavu-fonts.org/w
iki/Download.

ﬂ Support for Java 7 was removed in FishEye
3.9, as previously announced.

Operating systems

Microsoft Windows 0 ® FishEye is a pure Java application and
should run on any platform provided the
Linux ] requirements for the JRE or JDK are
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Apple Mac OS X

Databases

HSQLDB

MySQL

PostgreSQL

Oracle

SQL Server

Web browsers

Microsoft Internet
Explorer

Mozilla Firefox

Safari
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@ Bundled; for evaluation use only

© MySQL Enterprise Server 5.1+
© MySQL Community Server 5.1+

E3 MysQL 5.0
E3 MariaDB, Percona

©090,91,9293,94
383,84

EBs2

O 12c

@119

® 2012

@ 2008, 2008 R2

E3 2005

® 100, 11.0

oo

Q Latest stable version supported

Ed36,40

O Latest stable version supported

a5

satisfied.

Although FishEye can be run in
virtualized environments, Atlassian is
not yet able to provide technical
support for performance-related
problems in a virtualized environment.
If you do choose to run FishEye in a
VM, please ensure that you choose a
VM with good 10 throughput.

The FishEye built-in database, running HSQLD
B, is somewhat susceptible to data loss during
system crashes. We recommend that you do
not use HSQLDB for production systems.

External databases (such as MySQL) are
generally more resistant to data loss during a
system crash.

See the FishEye Database documentation for
further details.

For MySQL:

° ﬂ For 5.1, versions earlier than 5.1.10 are
not supported

e [ For 5.6, versions earlier than 5.6.11 are
not supported

e B3 For 5.7, versions earlier than 5.7.5 are
not supported

* B3 Support for MySQL 5.0 was removed in
FishEye 3.3. See End of Support
Announcements for FishEye.

i ﬂ MariaDB and Percona variants of
MySQL are not supported, and are known
to cause issues when used with FishEye.

ﬂ Support for PostgreSQL 8.2 was removed
in FishEye 3.3. See End of Support
Announcements for FishEye.

ﬂ Support for SQL Server 2005 was removed
in FishEye 3.3. See End of Support
Announcements for FishEye.

ﬂ Support for Internet Explorer 9 was
removed in FishEye 3.9. See End of Support
Announcements for FishEye.

m Support for Firefox 3.6 and 4.0 was
removed in FishEye 3.7.

ﬂ Support for Safari 4 and 5 was removed in
FishEye 3.7.
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Chrome o Latest stable version supported

Version control

systems

Subversion Server:
@ 11,12,13,14,15,16,1.7,
1.8
Client:

© SVNKit (bundled & the default)

® Native JavaHL 1.8
L@ Native JavaHL 1.7
+4 Native JavaHL 1.6

CVS (and CVSNT) @ All versions

Perforce @ Client version 2007.3 or later

Git ®2382

9273
@265
®254
®2410
®23.10
®223
D214
®2o05
®195

©1803,1815,1.8.23,1.8.34,
1.8.4.5,1.8.5.6

o 1.7.1.1,1.7.25,1.7.35,1.7.4.5,
1.754,1.76.6,1.7.7.7,1.7.8.6,
1.7.9.7,1.7.10.5,1.7.11.7,1.7.12.4

ﬂ FishEye 3.1, and later, do not support the
native JavaHL 1.6 client.

See Native support for SVN for discussion.

The Server must support the ztag tagged
protocol.

ﬂ Perforce Streams, introduced in 2011.1, is
not currently supported. See

FE-3886 - support for Streams in p4
OPEN

These are the versions of Git that we currently
test FishEye against.

E3 Git 1.8.4.3 is not supported. See

BSERV-4101 - Clone and fetch fail with
"protocol error: impossibly long line" CLOSED|

Externally-hosted repositories only are
supported.

[Security vulnerability CVE-2014-9390]
affects multiple Git versions. FishEye
itself is not affected, however you
should update your clients to a patched
maintenance version: v1.8.5.6, v1.9.5,
v2.0.5,v2.1.4 and v2.2.1 or newer.

Git for Windows is the only supported
distribution when running FishEye on

Windows. Cygwin Git is not supported
and has known issues.
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Mercurial o 3.0.2,3.1.2,3.24,3.3.3,34.2,
3.5.2,3.6.3,37.2

o 20.2,2.1.2,223,23.2,2.4,
252,263,27.2,282,29.1

o 151,154,1.6.4,1.7.5,1.8.4,

1.9.3
Atlassian
applications
Crowd @ crowd 2.4.x+

@ crowd client library: 2.4.1

JIRA ® JIRA 5.0+

Hardware requirements

These are the versions of Mecurial that we
currently test FishEye against.

As of version 3.6.3, FishEye supports Mercurial
3.

E3 Mercurial 2.1 has a bug that makes it
incompatible with FishEye. Please use
Mercurial 2.1.1 or later.

You should restart FishEye after upgrading
Mercurial.

From version 2.8.x, FishEye bundles the
Crowd 2.4.1 client library, and supports the Cro
wd 2.4.x server, and later versions.

FishEye to JIRA communication requires JIRA
5.0.x or later. Communication the other way,
from JIRA to FishEye, depends on the JIRA
FishEye Plugin.

Note that the JIRA FishEye Plugin is bundled
with JIRA. If you are using a version of JIRA
earlier than JIRA 5.0 you can upgrade the
plugin in JIRA to get support for FishEye.

FishEye should ideally run on a dedicated server. The most important aspect for a large-repository deployment
will be 1/0O speed. You definitely want a fast local HDD for FishEye's cache. Note that NFS and SAN are not

supported.

Component Specifications

CPU 1.8GHz or higher, a single core is sufficient. More cores or higher GHz will result in better

load-handling ability.

RAM 1GB minimum, 2GB will provide performance "headroom". Your Java heap should be sized at
512MB with the FISHEYE_OPTS environment variable, adjustable up to 1024MB depending

on performance.

1/0 FishEye's input/output is an important element of its overall performance. If FishEye accesses
your repository remotely, make sure that the throughput is maximum and the latency minimum
(ideally the servers are located in the same LAN, running at 100Mbps or faster).

Monitor Minimum screen resolution of 1024x768. Recommended screen resolution of 1280x768 or

above.

While some of our customers run FishEye on SPARC-based hardware, Atlassian only officially supports
FishEye running on x86 hardware and 64-bit derivatives of x86 hardware.

Disk space requirement estimates

Disk space requirements for FishEye may vary due to a number of variables such as the repository
implementation, file sizes, content types, the size of diffs and comments being stored. The following table
contains some real-world examples of FishEye disk space consumption.
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Repository technology Commits Codebase size (HEAD of trunk) FishEye index size
Subversion 14386 466 MB in 12151 files 647 MB

CVS 8210 115 MB in 11433 files 220 MB

I These disk space estimates are to be used as a guideline only. We recommend you monitor the disk space
that your FishEye instance uses over time, as needs for your specific environment may vary. It may be
necessary to allocate more space than indicated here. Additionally, you can reduce disk space consumption by t
urning off diff storage in FishEye.

Deployment notes for version control systems

Subversion FishEye can communicate with any repository running Subversion 1.1 or later.
(server)

Subversion FishEye now bundles the SVNKkit client, which becomes the default Subversion interface. An
(client) alternative is to use the native subversion client, using JavaHL bindings. Please see Subversio
n Client Setup for more information.

Perforce FishEye needs access to the p4 client executable. Due to some problems with earlier versions
(client) of the client, we recommend version 2007.3 or later.
CVS If you are using CVS, FishEye needs read-access to your CVS repository via the file system.

It does not support protocols such as pser ver atthe moment.

Support for other version control systems is planned for future releases. Let us know what SCM system you
would like to see supported by creating a JIRA issue or adding your vote to an issue, if the request already
exists.

WAR deployment

FishEye/Crucible is a standalone Java program. It cannot be deployed to web application servers such as
WebSphere, Weblogic or Tomcat.

Single sign on with Atlassian Crowd

From version 2.8.x, FishEye bundles the Crowd 2.4.1 client library, and supports the Crowd 2.4.x server, and
later versions.

Native support for SVN

This page describes an advanced feature of FishEye's Subversion support. It explores the technical background,
and some of the issues you may encounter, if you wish to use the native JavaHL access feature.

For most users we recommend that you use the default SVNKit Subversion access client that is bundled with
FishEye. You are only likely to need the native JavaHL access described on this page for certain edge case
repositories.

FishEye Subversion access

FishEye interacts with Subversion repositories though a layer, defined by the Apache Subversion project, known
as JavaHL. This is the high-level Java language binding for Subversion. There are two implementations of the
JavaHL interface available:

Bundled SVNKit

The SVNKIit implementation is a largely Java-based implementation provided by the SVNKit project. It is bundled
with FishEye and is the default JavaHL implementation used. As a Java implementation it operates on all of
FishEye's supported platforms.

Native JavaHL
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The INI-based implementation, coupled with a shared dynamic library, is referred to here as native JavaHL. As
a native library, native JavaHL is platform-dependent. The shared library is C-based and must be compatible
with the remaining Subversion client components installed on the platform. It varies across each platform and
distribution.

On this page:

FishEye Subversion access
Native vs. bundled
Native JavaHL support
Installing JavaHL for your platform
®* Windows 7
® Ubuntu 12
® Cent0S 6.4
® JavaHL considerations when
upgrading FishEye

Native vs. bundled

Given that FishEye bundles the SVNKit implementation, why might you want to use the native implementation of
JavaHL? In general our recommendation is to stick with the bundled SVNKit implementation. It is the simplest to
use and works in the widest variety of scenarios. Nevertheless, there are some scenarios where it may be
desirable to use the native implementation, if it is available.

The two implementations have quite different characteristics — these can affect the decision about which to use.
Here is a high-level list of some of the considerations we have encountered over the years:

Aspect SVNK:it - bundled with FishEye Native JavaHL - platform dependent

Memory Usage SVNKit uses the Java Heap. It therefore shares  The native JavaHL implementation uses
the heap that is being used for all FishEye's the native process heap and not the Java
operations. It does benefit, however, from heap. It can increase the overall process
Java's garbage collection mechanism and we memory usage but does not interfere with
have not seen any memory leaks. the Java heap usage.

In some rare instances, we have seen
memory leaks in the C-based JavaHL
code. As FishEye is a long running
service, these can cause problems over
the life of the FishEye process.

Speed In general, when using any of the Subversion If you are using file:// access to talk to a
network protocols, the JavaHL implementation Subversion repository on the same
speed is not a significant factor in the overall server, then native JavaHL will most
speed of Subversion operations as they are likely give the highest performance.

dominated by the network latency.

Even for file:// access SVNKit is rarely the
bottleneck.

Compatibility SVNKit has proven to be highly compatible with ~ JavaHL uses predominantly the same
Subversion across all releases. The project is code as Subversion itself so it is virtually
very responsive to bug reports when any 100% compatible.
differences become apparent.

As an alternative implementation of JavaHL
there will be differences between the SVNKit
and the native Subversion JavaHL. This may
affect some edge case repositories.
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Availability SVNK:it works on all of FishEye's supported It can be difficult to get an install of the
platforms JavaHL jar and shared library that is
compatible with the version of Subversion
installed on your platform.

Native JavaHL support

The native JavaHL interface and implementation naturally change with every release of Subversion. Normally
these changes are incremental and backward compatible.

The compatibility matrix for recent FishEye versions is:

SVNKit Native JavaHL 1.6 Native JavaHL 1.7 Native JavaHL 1.8
client client client

FishEye 3.3+
1.8 Subversion Server

1.7 Subversion Server

1.6 Subversion Server

FishEye 3.1 - 3.2

1.8 Subversion Server (not file:// Unsupported
access)
1.8 Subversion Server (file:// Unsupported
access)
1.7 Subversion Server Unsupported
1.6 Subversion Server Unsupported

FishEye 3.0 and earlier

1.7 Subversion Server (not file://
access)

1.7 Subversion Server (file://
access)

1.6 Subversion Server any
access

Note that:

® FishEye 3.1, and later, is not compatible with the JavaHL 1.6 client (or older versions) — it uses the
org.apache.subversion package which is not provided in 1.6 JavaHL builds
®* From FishEye 3.1, you must use a 1.7 or later JavaHL library if you want native JavaHL access.
~ Click here to read about compatibility changes from SVN 1.6 to 1.7...
The change from Subversion 1.6 to Subversion 1.7 was much more significant and for a number of FishEye's
usages of the interface, it broke compatibility.

In Subversion 1.7, the JavaHL interfaces were updated and moved from the org.tigris.subversion package to
the org.apache.subversion package. This coincided with the move of the Subversion project to the Apache
Software Foundation. In addition to moving the package, the interface was modernized in a number of ways:

Extended use of callbacks.

Use of Java collections rather than native arrays.

Properties were clarified as byte arrays rather than Java Strings.
Use of typed Enums rather than primitive integer and char fields.

The existing org.tigris package was retained in most 1.7 distributions and was implemented as an adapter
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layer over the new org.apache package classes. Unfortunately a number of incompatibilities in the adapter
layer meant that FishEye could not use the 1.7 native implementation:

1. Property returning methods were wrapped in a String constructor to convert from the byte[] type of the
new interface to the String type used in the old interface. This meant that any null returns would throw
NullPointerExceptions rather than returning null Strings.

2. Some of the callbacks were changed from plain interfaces to being interface extensions of the
corresponding callback in the new package. This changed the type definition of the callback from an
untyped Map to a typed Map. This caused ClassCastExceptions because the code is expecting a map
containing byte[] but the underlying code was passing in a map containing strings.

For this reason, FishEye did not support native access using the 1.7 native library prior to FishEye 3.1.

Installing JavaHL for your platform

Atlassian FishEye bundles the SVNK:it library to make connecting to your Subversion repository a painless
process out of the box. If you do wish to use native JavaHL, it is your responsibility to install it onto your platform.
Different organizations have different operating procedures and policies regarding how and what packages they
are able to install on production servers.

In some cases the distribution you use will not provide a compatible JavaHL from an official package. In this
case you will either need to build everything from source yourself (hard) or use a package from a Subversion
vendor. We have used packages from two vendors over time, CollabNet and Wandisco. More recently, we have
found it easier to use the Wandisco packages for JavaHL support.

The following sections detail our experiences when we investigated deploying JavaHL 1.7 on a variety of
platforms. This is not a definitive list or guide. It is to give you an idea of the some of the issues you are likely to
encounter getting a compatible JavaHL install working on a range of platforms and distributions.

32-bit / 64-bit: The DLL file is platform dependent so it needs to match the architecture of your VM. The
JAR file however, contains only metadata for the JVM about how to load the DLL so the same JAR will
work across 32-bit and 64-bit operating systems as long as the subversion binaries match.

Windows 7

Windows does not include a Subversion client by default so you will need to install a Subversion package. We
installed the 1.7.11 "client only" install from Wandisco.This installs Subversion, including the javahl components,
in C:\Program Files\WAN(disco\Subversion. It is interesting to note that the JavaHL package in this install does
not include the org.tigris package adapter layer.

Ubuntu 12

Ubuntu provides pckages for both core subversion and the JavaHL library for Subversion. We installed these for
Subversion 1.7.5 as follows:

® sudo apt-get install subversion
® sudo apt-get install libsvn-java

Unfortunately the version installed seems to have a consistent assertion failue:

java: /build/buildd/subversion-1.7.5/subversion/libsvn_subr/dirent_uri.c:1519:
uri _skip_ancestor: Assertion “svn_uri_is_canonical (child_ uri, ((void *)0))" failed.

We then removed the two Subversion packages from Ubuntu itself:

® sudo apt-get renove libsvn-java
® sudo apt-get renove subversion

We installed the Wandisco packages by downloading and running the Wandisco installer:

svnl. 7_ubunt u_wandi sco- preci se. sh
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This configures the Wandisco servers as a source of packages and installs the core Subversion install. At the
time of writing this installed 1.7.11. Once installed, reinstall the javahl package:

® sudo apt-get install libsvn-java

This will now come from the Wandisco package repository. The location of the shared library and JavaHL jar is:
fusr/lib/jni/libsvnjavahl-1.so
/usr/share/javal svn-javahl .jar

..............................................................................................................................................................................

CentO0OS 6.4

If you install the Subversion packages (subversion and subversion-javahl) using yum, you will have a 1.6.11
install of Subversion which is not compatible with FishEye if you wish to use JavaHL as descibed above.

If you have previously upgraded to a version of SVN 1.7 before 1.7.11 you may see the message below in your
logs. If you do, please upgrade to the Wandisco SVN 1.7 as described below:

java: /build/buildd/subversion-1.7.5/subversion/libsvn_subr/dirent_uri.c:1519:
uri _skip_ancestor: Assertion “svn_uri_is_canonical (child uri, ((void *)0))' failed.

You will need to remove the standard yum packages and use a Wandisco install, svnl.7_centos6_wandisco.sh.
This installs plain subversion and configures the Wandisco servers as a source of packages. You can then use
yum to install subversion-javahl. The following files are installed:

..............................................................................................................................................................................

$ repoquery --1list subversion-javahl
fusr/lib/libsvnjavahl-1.so
/fusr/lib/svn-javahl/svn-javahl.jar
/fusr/1ib64/libsvnjavahl -1.so
lusr/lib64/svn-javahl/svn-javahl.jar

If you are using a 64bit JVM, use the /usr/lib64 library, otherwise use the 32bit library in /ust/lib.

JavaHL considerations when upgrading FishEye

If you are currently using SVNKit with FishEye (the default), then you do not have to do anything when
upgrading to FishEye 3.1 and later. FishEye will continue to use the bundled SVNK:it library.

FishEye's Admin Ul now displays information about the Subversion client in use — click Server, under 'Global
Settings'. With no native client, configured, the display would look like:

Subversion client @

The bundled Subversion client, SVNKIt, is being used for Subversion operations.
The JavaHL client version is SYMNKIt v1.8.3.10190.
JAR  not set
Dynamic library  not set

Edit Details
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If you have been using native JavaHL prior to FishEye 3.1, FishEye will detect that you have configured a
pre-1.7 version of JavaHL and fallback to the bundled SVNKit client and start up normally. You will see the
following in the Server section of the admin Ul:

Subversion client @

The configured Subversion client, a pre 1.7 native JavaHL client, is no longer supported.
The bundled Subversion client, SVNKit, is being used for Subversion operations.
Please update the configuration to a 1.7 or later version to continue using the native JavaHL Subversion client.

JAR Jopt/subversion/lib/svn-javahl/svn-javahl.jar
Dynamic library  foptisubversion/lib/libsvnjavahi-1.0.dylib

Edit Details

You can use the FishEye admin Ul to update the JavaHL client information to point FishEye to a 1.7 or later
JavaHL jar and shared library. FishEye will perform some checks that the configured library supplies the correct
classes. You will need to restart for the changes to take effect. If there are problems with the JavaHL library on
restart, FishEye will again fallback to SVNKit. Once you have updated the configuration, FishEye will show a
message that the configuration has been changed and a restart is required:

Subversion client @

The Subversion client configuration has been changed and will take effect after restart.

JAR  not set
Dynamic library  not set

Edit Details

Upon restart, the display will show the operation of the native library and its version:

Subversion client @

The configured Subversion client, native JavaHL, is being used for Subversion operations.
The JavaHL client version is 1.8.0 (r1490373).

JAR Jopt/subversion/lib/svn-javahl/svn-javahl.jar
Dynamic library /opt/subversion/lib/libsvnjavahl-1.0.dylib

Edit Details

Installing FishEye on Windows

This page... Upgrading? Using Linux or Mac OS X?
... describes how to perform a If you're upgrading your If you're on one of these
clean install of FishEye on FishEye installation, read the platforms read Installing
Windows. FishEye upgrade guide first. FishEye on Linux and Mac ins
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tead.

1. Check supported platforms

Better check the Supported platforms page first; it lists the application servers, databases, operating
systems, web browsers and JDKs that we have tested FishEye with, and that we recommend.

Atlassian only officially supports FishEye running on x86 hardware and 64-bit derivatives of x86 hardware.

2. Create a dedicated FishEye user (recommended)

For production installations, we recommend that you create a new dedicated Windows user that will run
FishEye on your system. This user:

® Should not have admin privileges.

® Should be a non-privileged user with read, write and execute access on the FishEye install directory
and instance (data) directory. These directories are described below.

® Should only have read access to your repositories.

If you have created a dedicated FishEye user, ensure you are logged in as this user to complete the
remaining instructions.

3. Check your version of Java

In a command prompt, run this:

.........................................................................................................................................................................

The version of Java should be 1.8.x.

The recommended way to install FishEye is to use the installer, which installs FishEye as a Windows
service — see step 5 below.
~ |f you don't see a supported vesion of Java, then get Java...

Download and install the Java Platform JDK from Oracle's website.

I We recommend that the Java install path should not contain spaces, so don't install into C:\
Program Files\Java\. Instead, use a path like C:\Java.

Now try running 'j ava - ver si on' again to check the installation. The version of Java should
be 1.8.x.

4. Check that Windows can find Java

Windows uses the JAVA_HOME environment variable to find Java. To check that, in a new command
prompt, run:

.........................................................................................................................................................................

You should see a path to the Java install location. We recommend that this path does not contain
spaces, and that JAVA_HOME should point to the JDK home path.
~ If you don't see a path without spaces...

Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
http://www.oracle.com/technetwork/java/javase/downloads/index.html

User Documentation for FishEye 4.0 16

® If you see a path with spaces, like C:\ Program Fi | es\ Java\, then sorry, but go
back to 3. and reinstall Java to a location that doesn't have spaces.

* |f you don't see a path at all, or if you just see %JAVA HOME%, then set JAVA_HOME
as follows:

For Windows 7:

1. Go to Start, search for "sys env" and choose Edit the system environment variables.

2. Click Environment Variables, and then New under 'System variables'.

3. Enter "JAVA_HOME" as the Variable name, and the absolute path to where you
installed the Java JDK as the Variable value, that is, something like C: \ Java\j dk1. 7
. 0_51. Don't use a trailing backslash. We recommend that JAVA_HOME should point
to the JDK home path.

4. Now, in a new command prompt, try running 'j ava -ver si on'. You should see the
same version of Java as you saw above.

5. Now it's time to get FishEye

Download the FishEye installer from the Atlassian download site.

There are 32-bit and 64-bit installers for FishEye on Windows. Each installer adds FishEye as a Windows
service, and starts the service, automatically. The express install creates, by default, a Dat a directory and
a separate install directory in C: \ At | assi an. The custom install mode allows you to choose different
locations for the install and Dat a directories, with the restriction that the Dat a directory must not be
contained in the install directory.

® The installer creates the FI SHEYE_| NST system environment variable. This points to the location of
the instance (data) directory.

® The path to the installation location is referred to as the <Fi shEye install directory> inthese
instructions.

® You need separate FishEye instance (data) directories if you want to run multiple copies of FishEye.

® If you expect to have a large number of users for this FishEye installation, and FishEye will be connect
ed to an external database, consider installing FishEye on a different server from the one running the
external database, for improved performance.

® If you have a large number of repositories, we recommend you increase the default number of files
that FishEye is allowed to open. See the following knowledge base article for more info: Subversion
Indexer Paused with "Too many open files" Error.

® For FishEye 3.4.4 and later, you can edit JVM parameters for the Windows service by going to Start >
All Programs > FishEye > Configure FishEye. Ensure that you restart the FishEye service when
finished. Do not reference any environment variables in the settings (e.g. %FISHEYE_INST%).
Instead, set the actual path.

6. Visit FishEye!

Give the FishEye service a minute to launch. Then, in a web browser on the same machine, goto http:/ /|
ocal host : 8060/ (or, from another machine, type htt p: / / host name: 8060/ , where host nan® is the
name of the machine where you installed FishEye).

Enter your license, then an admin password, to finish the setup. Note that this password is for the 'built-in'
FishEye admin user. You can log in as this user, if necessary, by clicking the Administration link in the page
footer. See also How to reset the Administration Page password in FishEye or Crucible.

You can postpone setting up JIRA integration until later if you wish; see Configuring JIRA integration in the
Setup Wizard.
7. Add repositories

Now you can tell FishEye about any existing repositories you have. Please read Starting to use FishEye for
the detalils.

FishEye will perform an initial index of your repositories, during which it accesses, indexes and organizes a
view of your repositories (including all historical items) back to the earliest commits. If you are evaluating
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FishEye, we suggest that you index a single project, so you can use FishEye as soon as possible. If you
choose to index your entire repository, be aware that this can take a long time (possibly days) for massive or
complex repositories and can be more complex to set up (especially for Subversion). The basic process is
slightly different for each SCM type.

8. Add users and groups

You will want to set up your users and groups in FishEye. You can add users directly to FishEye, or connect
to an external user directory. Please read Starting to use FishEye for an introduction.

9. Set up your mail server

Configure the FishEye email server so that users can get natifications from FishEye. See Configuring SMTP.

10. Connect to an external database (recommended)

If you intend to use this FishEye installation in a production environment, it is highly recommended that you
use one of the supported external databases. See Migrating to an external database.

If you are evaluating FishEye, or don't wish to do this now, FishEye will happily use its embedded HSQL
database, and you can easily migrate later.

11. Stop FishEye (optional)

Control the FishEye service from the Windows administration console. Alternatively, in a command prompt,
change directory to <Fi shEye install directory> and run this:

.........................................................................................................................................................................

12. Tuning FishEye performance

To get the best performance from your new FishEye installation, please consult Tuning FishEye performance

Installing FishEye on Linux and Mac

Hey! We're going to install FishEye on a Linux box, or a Mac. There are a few steps involved, but we think you'l
find it easy to follow along. If you are upgrading an existing installation, please refer to the FishEye upgrade
guide instead.

1. Check supported platforms

Better check the Supported platforms page first; it lists the application servers, databases, operating systems,
web browsers and JDKs that we have tested FishEye with, and that we recommend.

Atlassian only officially supports FishEye running on x86 hardware and 64-bit derivatives of x86 hardware.
Related pages:

Installing FishEye on Windows
Starting to use FishEye
Supported platforms

FishEye upgrade guide

2. Create a dedicated FishEye user (recommended)

For production installations, we recommend that you create a new dedicated user that will run FishEye on your
system. This user:
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® Should not have admin privileges.

® Should be a non-privileged user with read, write and execute access on the FishEye install directory and
instance (data) directory. These directories are described below.

® Should only have read access to your repositories.

If you created a dedicated FishEye user, ensure you are logged in as this user to complete the remaining
instructions.

3. Check your version of Java

In a terminal, run this:

..............................................................................................................................................................................

The version of Java should be 1.8.x.
~ If you don't see a supported version of Java, then get Java...

Download and install the Oracle JVM (JDK or JRE), or OpenJDK.

Now try running 'j ava - ver si on' again to check the installation. The version of Java should be
1.8.x.

4. Check that the system can find Java

In a terminal, run this:

..............................................................................................................................................................................

You should see a path like / Syst eni Li br ary/ Fr anewor ks/ JavaVM f r anewor k/ Ver si ons/ Current JD
K/ Hone/ .
~ If you don't see a path to the Java location, then set JAVA_HOME...

Linux

Do either of the following:

* |f JAVA HOME is not set, log in with 'root’ level permissions and run:

.............................................................................................................................................................

where pat h/ t o/ JAVA_HOVE may be like: / Syst em Li br ary/ Fr anewor ks/ JavaVM f r amewo
ons/ Curr ent JDK/ Hone/

* |f JAVA HOME needs to be changed, open the /et ¢/ envi ronnment file in a text editor and m
value for JAVA HOVE to:

JAVA_HOVE="npat h/ t o/ JAVA_HOMVE"

It should look like:

JAVA HOME=/ Syst em Li br ary/ Fr amewor ks/ JavaVM f r anewor k/ Ver si ons/ Curr ent ,

5. Now it's time to get FishEye

1. Download FishEye from the Atlassian download site.
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2. Please check your unzip program before extracting the downloaded zip file. Some archive-extract
programs cause errors when unzipping the FishEye zip file:
® Windows users must avoid the Windows built-in unzip utility, as it doesn't extract all the files. Use a
third-party unzip program like 7-Zip or Winzip.
® Solaris users will need to use GNU tar to handle the long file names.
3. Extract the downloaded file to an install location:

® Folder names in the path to your FishEye executable should not have spaces in them. The path to
the extracted directory is referred to as the <Fi shEye install directory> inthese
instructions.

* If you expect to have a large number of users for this FishEye installation, and FishEye will be con
nected to an external database, consider installing FishEye on a different server from the one
running the external database, for improved performance.

6. Tell FishEye where to store your data

The FishEye instance directory is where your FishEye data is stored.

I You should not locate your FishEye instance directory inside the <Fi shEye install directory> —
they should be entirely separate locations. If you do put the instance directory in the <Fi shEye i nstal |
di rect ory> it will be overwritten, and lost, when FishEye gets upgraded. And by the way, you'll need separate
FishEye instance directories if you want to run multiple copies of FishEye.

For production installations, we recommend that the FishEye instance directory be secured against unauthorized
access.

Create your FishEye instance directory, and then tell FishEye where you created it by adding a FISHEYE_INST
environment variable as follows:

Linux Mac
Open the / et ¢/ envi ronnent file in a text Open the ~/ . profi | e file for the current user in
editor and insert: a text editor and insert:

FI SHEYE_| NST="pat h/ t o/ <Fi shEye

. . " FI SHEYE_| NST="pat h/ t o/ <Fi shEye
i nstance directory>

i nstance directory>"
export FI SHEYE_| NST

You need to log out and log in again so the new environment variable is set.

Alternatively you can run
export FI SHEYE_| NST="pat h/t o/ <Fi shEye i nstance directory>"

to avoid logging out and in.

Now, copy the <Fi shEye install directory> /config.xmn tothe root of the FI SHEYE | NST directory,
so that FishEye can start properly.

Also, if you have a large number of repositories, we recommend you increase the default number of files that
FishEye is allowed to open. See the following knowledge base article for more info: Subversion Indexer Paused
with "Too many open files" Error.

7. Start FishEye!

In a terminal, change directory to <Fi shEye i nstall directory>and run this:

bi n/start. sh
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After a few moments, in a web browser on the same machine, goto http://1 ocal host: 8060/ (or, from
another machine, type http://host nane: 8060/, where host nane is the name of the machine where you
installed FishEye).

Enter your license, then an admin password, to finish the setup. Note that this password is for the 'built-in'
FishEye admin user. You can log in as this user, if necessary, by clicking the Administration link in the page
footer.

You can postpone setting up JIRA integration until later if you wish; see Configuring JIRA integration in the
Setup Wizard.

8. Add repositories

Now you can tell FishEye about any existing repositories you have. Please read Starting to use FishEye for the
details.

FishEye will perform an initial index of your repositories, during which it accesses, indexes and organizes a view
of your repositories (including all historical items) back to the earliest commits. If you are evaluating FishEye, we
suggest that you index a single project, so you can use FishEye as soon as possible. If you choose to index your
entire repository, be aware that this can take a long time (possibly days) for massive or complex repositories and
can be more complex to set up (especially for Subversion). The basic process is slightly different for each SCM

type.

9. Add users and groups

You will want to set up your users and groups in FishEye. You can add users directly to FishEye, or connect to
an external user directory. Please read Starting to use FishEye for an introduction.

10. Set up your mail server

Configure the FishEye email server so that users can get notifications from FishEye. See Configuring SMTP.

11. Connect to an external database (recommended)

If you intend to use this FishEye installation in a production environment, it is highly recommended that you use
one of the supported external databases. See Migrating to an external database.

If you are evaluating FishEye, or don't wish to do this now, FishEye will happily use its embedded HSQL
database, and you can easily migrate later.

12. Stop FishEye (optional)

In a terminal, change directory to <Fi shEye install directory> and run this:

..............................................................................................................................................................................

13. Tuning FishEye performance

To get the best performance from your new FishEye installation, please consult Tuning FishEye performance.

Starting to use FishEye
This page will guide you through the basics of using FishEye. By the end of it you should be able to:

® Create accounts for your collaborators, and organize them into groups.
® Add repositories that need to be indexed and setup permissions.
® Use the Commit Graph to trace the history of your code

This page assumes that:
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®* You have installed and started the latest version of FishEye. See Installing FishEye on Linux and Mac or |
nstalling FishEye on Windows for details.
® You are using a supported browser.
On this page:

® Create users in FishEye
® Add a repository
®* Move forward

Related pages:

Installing FishEye on Windows
Installing FishEye on Linux and Mac
Supported platforms

Managing your repositories

Setting up your Users and Security

Create users in FishEye

FishEye doesn't have any user accounts after you have installed it for the first time. You need to go to the
Administration interface to add the first users of the system.

Click on the Administration link in the footer:

Atlassian FishEye analysis with Crucible code review. (Version:3.10.0 Build:r62dc31d 2015-08-07) - Administration - Page generated 2015-08-11 04:30 +0000

In the Users listing page click Add user to go to the user creation form:

Users @

The User Browser allows you to browse all the users in the system. Filters allow you to limit the users that you see.
Reset filter

Filter In group Any s Filter Add user

Fill in the form and create your user:
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lin
Iings
e Add New User e
hmits Information about the new user
S
. Username | jdoe
Display name  john Doe
ings Emall | john@doe.com
N Autn Type
Amin Password Password | seeess
tion
tors Confirm Password | eseess|
h Schemes Cancel
3
URL Mappings
B Customization
h Links
ngs

From the User page you can click on Create another user to repeat this operation:

User e

The user John Doe has been created.
Create another user.
User Details @
Username jdoe
Display name John Doe
Email john@doe.com
Type built-in
Admin false
Edit | Change Password | Rename | Delete
Group Details @
Groups No groups.
Edit Groups
List of users

Return to the list of users

Add a repository

In this section we're going to add a repository to FishEye.
Click on Add repository in the Repositories listing of the Administration.

Now choose the repository type and fill in the name and description:
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Add Repository - Page 1 of 3

Basic Details

Reposiory Type:

Name: * Jjaplot ®

Description: | Js charts library| @

Back Add.

In the repository configuration, add the location of your repository. Fill in the authentication details if necessary.

Add Repository - Page 2 of 3

Mercurial Connection Details

Repository Location: * [hltp5:,.’fbilbucket,org,.’cleonello,quplot

Mercurial Authentication

Authentication Style: [ No authentication i@

FishEye will not add any autt ication to r ts. Authentication will be handled transparently by the SCM.

[J show advanced settings

Add) (Cancel)

Finally indicate whether or not you would like diff indexing should be turned on and if the repository should not
be indexed right away.

Click Add to finish the process.

Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.

23


http://creativecommons.org/licenses/by/2.5/au/

User Documentation for FishEye 4.0

Add Repository - Page 3 of 3

Final Settings
Store Diff Info: [ )

Enable Repository @ (3
After Adding:

Next)  (Add)  (CanceD

Move forward

Once it's created you can click Browse, in the repository options menu, to access your repository.

Repositories

MNative Repository Access (1)

FishEye natively supports Subversion, CVS, Perforce, Git and Mercurial repositories @

Add Existing... Create New... Refresh Ler reposit Page 1 of 1
Mame Type Description Location State Last Actions
Update
japlot Mercurial JS charts library https://bitbucket.org/cleonello/jgplot/  Running @ -
d AYIT=ITT] l
Bowse |
otup
Restart

You can now browse your files in FishEye, search through your code or track modifications via the commit
graph.
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[= Stats Al Reviews W Filter commits: Expand all
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1e:a7 Nick Pellow 1hrago @~
i
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Configuring JIRA integration in the Setup Wizard

This page describes the Connect to JIRA tab of the FishEye setup wizard.

Connecting FishEye to a JIRA application allows you to manage your users with JIRA. See Connecting to JIRA
for user management for more information.

On this page:

® Connecting to a JIRA application in the Setup Wizard
®* Troubleshooting

Related pages:

® Starting to use FishEye

® Linking FishEye to JIRA
applications

® JIRA Integration in FishEye

Connecting to a JIRA application in the Setup Wizard

To configure JIRA integration while running the FishEye setup wizard:

1. Configure the following setting in the JIRA application: Allow remote API access.
2. Enter the following information on the '‘Connect to JIRA' step of the setup wizard:

JIRA Base The base URL set for your JIRA application. Examples are:
URL http://ww. exanpl e. com 8080/ jiral
http://jira. exanpl e.com

Admin The credentials for a user with the 'JIRA System Administrators' global permission in
Username the JIRA application.

Admin

Password

FishEye Click Advanced Options to see this field. The JIRA application will use this URL to

Base URL access your FishEye server. The URL you give here will override the base URL
specified in your FishEye administration console, for the purposes of the JIRA
connection.

Groups to Click Advanced Options to see this field. Select at least one JIRA application group to

Synchronize synchronize. The default group isj i r a- user s. The JIRA application will synchronize
all changes in the user information on a regular basis. The default synchronization
interval is 1 hour.
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Admin Click Advanced Options to see this field. Specify a JIRA group whose members
Groups should have administrative access to FishEye/Crucible. The default group is j i r a- adm
inistrators.

3. Click Connect to JIRA.
4. Finish the setup process.

1. License

Connect to JIRA

3. Connect to JIRA If you have JIRA 4.3 or later, Crucible can use JIRA for user management. This
is not recommended for more than 500 users. Learn more here.

2. Inclusions

JIRA Base URL:
For example: http://jira.mycompany.com or
http://mycompany.com/jira

Admin Username:

This username must have system administrator rights on your
JIRA server.

Admin Password:

Advanced
Options...

Connect to JIRA | | Skip |

Troubleshooting

~ Click to see troubleshooting information...
This section describes the possible problems that may occur when integrating your application with JIRA via
the setup wizard, and the solutions for each problem.

Symptom Cause Solution
The setup wizard displays one of The setup wizard failed to Remove the partial configuration if
the following error messages: complete registration of the it exists, try the 'Connect to JIRA'
. iied lication link peer-to-peer application link step again, and then continue with
Failed to create application link iy 3RA. JIRA integrationis  the setup. Detailed instructions are

from JIRA server at <URL> to
this <application> server at
<URL>.

® Failed to create application link
from this <application> server
at <URL> to JIRA server at
<URL>.

® Failed to authenticate
application link from JIRA
server at <URL> to this
<application> server at <URL>.

® Failed to authenticate
application link from
<application> server at <URL>
to this JIRA server at <URL>.

only partially configured. below.
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The setup wizard displays one of
the following error messages:

® Failed to register <application>
configuration in JIRA for
shared user management.
Received invalid response
from JIRA: <response>

® Failed to register <application>
configuration in JIRA for
shared user management.
Received: <response>

The setup wizard displays the
following error message:

® Error setting Crowd
authentication

The setup wizard displays the
following error message:

® Error reloading Crowd
authentication

The setup wizard displays the
following error message:

® An error occurred:

java.lang.lllegalStateException:

Could not create the
application in JIRA/Crowd
(code: 500). Please refer to the
logs for detalils.

No users can log in after you have
set up the application with JIRA
integration.

Solution 1. Removing a Partial Configuration — The Easiest Way

The setup wizard failed to
complete registration of the
client-server link with JIRA for
user management. The
peer-to-peer link was
successfully created, but
integration is only partially
configured.

The setup wizard successfully
established the peer-to-peer
link with JIRA, but could not
persist the client-server link for
user management in your conf
i g. xm file. This may be
caused by a problem in your
environment, such as a full
disk.

The setup wizard has
completed the integration of
your application with JIRA, but
is unable to start synchronizing
the JIRA users with your
application.

The setup wizard has not
completed the integration of
your application with JIRA. The
links are only partially
configured. The problem
occurred because there is
already a user management
configuration in JIRA for this
<application> URL.

Possible causes:

® There are no users in the
group that you specified on
the 'Connect to JIRA'
screen.

® For FishEye: There are no
groups specified in the
‘groups to synchronize'
section of your
administration console.

® For Stash: You may not
have granted any JIRA
groups or users
permissions to log in to
Stash.

27

Remove the partial configuration if
it exists, try the 'Connect to JIRA'
step again, and then continue with
the setup. Detailed instructions are
below.

Please investigate and fix the
problem that prevented the
application from saving the
configuration file to disk. Then
remove the partial configuration if
it exists, try the 'Connect to JIRA'
step again, and then continue with
the setup. Detailed instructions are
below.

Restart your application. You
should then be able to continue
with the setup wizard. If this
solution does not work, please
contact Atlassian Support.

Remove the partial configuration if
it exists, try the 'Connect to JIRA'
step again, and then continue with
the setup. Detailed instructions are
below.

Go to JIRA and add some
usernames to the group.

®* For FishEye: Go to the
FishEye administration
screens and specify at least
one group to synchronize. The
default is ‘Yjira-users'.

® For Stash: Grant the Stash
User permission to the
relevant JIRA groups on the
Stash Global permissions pag
e.

If this solution does not work,
please contact Atlassian Support.

If the application's setup wizard fails part-way through setting up the JIRA integration, you may need to
remove the partial configuration from JIRA before continuing with your application setup. Please follow the
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steps below.

Remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the
setup wizard:

1. Log in to JIRA as a user with the 'JIRA System Administrators' global permission.
2. Click the 'Administration’ link on the JIRA top navigation bar.
3. Remove the application link from JIRA, if it exists:
a. Click Application Links in the JIRA administration menu. The '‘Configure Application Links'
page will appear, showing the application links that have been set up.
b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For
example:
* If you want to remove a link between JIRA and FishEye, look for the one where the Appl
ication URL matches the base URL of your FishEye server.
® If you want to remove a link between JIRA and Confluence, look for the one where the A
pplication URL matches the base URL of your Confluence server.
® |f you want to remove a link between JIRA and Stash, look for the one where the Applic
ation URL matches the base URL of your Stash server.
c. Click Delete next to the application link that you want to delete.
d. A confirmation screen will appear. Click Confirm to delete the application link.
4. Remove the user management configuration from JIRA, if it exists:
a. Go to the JIRA administration screen for configuring the applications that have been set up to
use JIRA for user management:
® In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the
JIRA administration screen.
® InJIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
b. Look for a link to your application. It will have a name matching this format:

<Type> - <HostNane> - <Application |D>

For example:

Fi shEye / Crucible - Iocal host -
92004b08- 5657- 3048- b5dc- f 886e662bal5s

Or:

Confl uence - | ocal host -
92004b08-5657- 3048- b5dc- f 886e662bals

If you have multiple servers of the same type running on the same host, you will need to match
the application ID of your application with the one shown in JIRA. To find the application ID:
® Go to the following URL in your browser:

<baseUr| >/ rest/applinks/ 1.0/ manifest

Replace <baseUr | > with the base URL of your application.
For example:

http://1 ocal host: 8060/ rest/applinks/ 1.0/ manifest

® The application links manifest will appear. Check the application ID in the <i d> element.
c. InJIRA, click 'Delete' next to the application that you want to remove.
5. Go back to the setup wizard and try the 'Connect to JIRA' step again.
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Solution 2: Removing a Partial Configuration — The Longer Way

If solution 1 above does not work, you may need to remove the partial configruration and then add the full
integration manually. Please follow these steps:

1. Skip the 'Connect to JIRA' step and continue with the setup wizard, to complete the initial configuration
of the application.
2. Log in to JIRA as a user with the 'JIRA System Administrators' global permission.
3. Click the 'Administration’ link on the JIRA top navigation bar.
4. Remove the application link from JIRA, if it exists:
a. Click Application Links in the JIRA administration menu. The 'Configure Application Links'
page will appear, showing the application links that have been set up.
b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For
example:
® |f you want to remove a link between JIRA and FishEye, look for the one where the Appl
ication URL matches the base URL of your FishEye server.
* If you want to remove a link between JIRA and Confluence, look for the one where the A
pplication URL matches the base URL of your Confluence server.
® |f you want to remove a link between JIRA and Stash, look for the one where the Applic
ation URL matches the base URL of your Stash server.
c. Click Delete next to the application link that you want to delete.
d. A confirmation screen will appear. Click Confirm to delete the application link.
5. Remove the user management configuration from JIRA, if it exists:
a. Go to the JIRA administration screen for configuring the applications that have been set up to
use JIRA for user management:
® In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the
JIRA administration screen.
® InJIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
b. Look for a link to your application. It will have a name matching this format:

<Type> - <Host Nane> - <Application | D>

For example:

Fi shEye / Crucible - |ocal host -
92004b08- 5657- 3048- b5dc- f 886e662bal5s

Confl uence - | ocal host -
92004b08- 5657- 3048- b5dc-f 886e662bals

If you have multiple servers of the same type running on the same host, you will need to match
the application ID of your application with the one shown in JIRA. To find the application ID:
® Go to the following URL in your browser:

<baseUr | >/rest/applinks/ 1.0/ manif est

Replace <baseUr | > with the base URL of your application.
For example:

http://1 ocal host: 8060/ rest/applinks/ 1.0/ manifest

® The application links manifest will appear. Check the application ID in the <i d> element.
c. InJIRA, click 'Delete’ next to the application that you want to remove.
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6. Add the application link in JIRA again, so that you now have a two-way trusted link between JIRA and
your application:
a. Click Add Application Link. Step 1 of the link wizard will appear.
b. Enter the server URL of the application that you want to link to (the ‘remote application’).
c. Click Next.
d. Enter the following information:
® Create alink back to this server — Check to add a two-way link between the two
applications.
®* Username and Password — Enter the credentials for a username that has administrator
access to the remote application.
Note: These credentials are only used to authenticate you to the remote application, so
that Application Links can make the changes required for the new link. The credentials
are not saved.
® Reciprocal Link URL — The URL you give here will override the base URL specified in
your remote application's administration console, for the purposes of the application links
connection. Application Links will use this URL to access the remote application.
e. Click Next.
f. Enter the information required to configure authentication for your application link:
®* The servers have the same set of users — Check this box, because the users are the
same in both applications.
® These servers fully trust each other — Check this box, because you trust the code in
both applications and are sure both applications will maintain the security of their private
keys.
For more information about configuring authentication, see Configuring authentication for
an application link.
g. Click Create.
7. Configure a new connection for user management in JIRA:
a. Go to the JIRA administration screen for configuring the applications that have been set up to
use JIRA for user management:
® In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the
JIRA administration screen.
® InJIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
b. Add an application.
c. Enter the application name and password that your application will use when accessing JIRA.
d. Enter the IP address or addresses of your application. Valid values are:
® Afull IP address, e.g. 192. 168. 10. 12.
* A wildcard IP range, using CIDR notation, e.g. 192. 168. 10. 1/ 16. For more
information, see the introduction to CIDR notation on Wikipedia and RFC 4632.
® Save the new application.
8. Set up the JIRA user directory in the application.
® For Confluence:
a. Go to the Confluence Administration Console.
b. Click 'User Directories' in the left-hand panel.
c. Add a directory and select type 'Atlassian JIRA".
d. Enter the following information:
®* Name — Enter the name of your JIRA server.
® Server URL — Enter web address of your JIRA server. Examples:

http://ww. exanpl e. com 8080/ jira/
http://jira. exanpl e.com

® Application name and Application password — Enter the values that you
defined for Confluence in the settings on JIRA.

e. Save the directory settings.
Define the directory order by clicking the blue up- and down-arrows next to each
directory on the 'User Directories' screen.
For details see Connecting to Crowd or JIRA for User Management.
® For FishEye/Crucible:

a. Click Authentication (under 'Security Settings").

b. Click Setup JIRA/Crowd authentication. Note, if LDAP authentication has already been

-
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set up, you will need to remove that before connecting to JIRA for user management.
c. Make the following settings:

Authenticate Select a JIRA instance

against

Application Enter the values that you defined for your application in the
name and pass settings on JIRA.

word

JIRA URL The web address of your JIRA server. Examples:

http://ww. exanpl e. com 8080/ jiral
http://jira. exanpl e.com

Auto-add Select Create a FishEye user on successful login so that your
JIRA users will be automatically added as a FishEye user when
they first log in.

Periodically Select Yes to ensure that JIRA will synchronize all changes in the
synchronise user information on a regular basis. Change the value for Synchr
users with JIRA  onise Period if required.

When Select an option depending on whether you want to allow
Synchronisation changes to user attributes from within FishEye.
Happens

Single Sign On Select Disabled. SSO is not available when using JIRA for user
management and if enabled will make the integration fail.

d. Click Next and select at least one user group to be synchronised from JIRA. If
necessary, you could create a new group in JIRA, such as 'fisheye-users', and select this
group here.

e. Click Save.

® For Stash:

a. Go to the Stash administration area.

b. Click User Directories in the left-hand panel.

c. Add a directory and select type Atlassian JIRA.

d. Enter the following information:

®* Name — Enter the name of your JIRA server.
® Server URL- Enter web address of your JIRA server. Examples:

http://ww. exanpl e. com 8080/ jiral
http://jira.exanpl e.com

* Application name and Application password — Enter the values that you
defined for Stash in the settings on JIRA.
e. Save the directory settings.
f. Define the directory order by clicking the blue up- and down-arrows next to each
directory on the 'User Directories' screen.
For details see Connecting Stash to JIRA for user management.

Using FishEye

® Using the FishEye screens
® Browsing through a repository
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Viewing file content
Viewing a file history
Using side by side diff view
Viewing the changelog
Searching FishEye
FishEye charts
Using favourites in FishEye
Changeset discussions
Viewing the commit graph for a repository
Viewing people's statistics
Using Smart Commits
Changing your user profile
® Re-setting your password
Pattern matching guide
Date expressions reference guide
EyeQL reference guide
Integrating FishEye with Atlassian applications
¢ JIRA Integration in FishEye
® Integrating FishEye with Bitbucket Server
® Transitioning issues in JIRA

Using the FishEye screens

The sections below describe the different screens in FishEye and the information you can retrieve from them.
Each page (tab) has a number of panes, each of which is described separately below.

Header

= /%)+M Repositories ~ Projects ~ People ~ Reviews v | Create review ~ +  Search

The header along the top of each FishEye page provides the following:

® The application navigator, at the left of the header, connects you directly to your other applications, such
as JIRA and Bamboo. Admins can configure which apps appear in the navigator — just click Application
navigator in the admin area.

* FishEye logo (with the logo for Crucible if you are using that) — click to go to the dashboard, to see your
personal code commits, your reviews (if you are using Crucible) and your activity stream.

® Repositories — the list of all FishEye repositories. Click a repository name to browse the repository.
A number of sub-tabs become available, as described below (see 'Repository sub-tabs' below).

®* Projects (when used with Crucible) — a link to all projects (see the Crucible documentation ). Logged-in
users can see links to recently visited projects.

®* People —tab to view statistics about commiters to your FishEye repositories (see Viewing People's
Statistics ). Logged in users can see links to users they have recently visited.

* Reviews (when used with Crucible) — go to your code reviews (see the Crucible documentation). Logged-
in users can see links to recently visited reviews as well as to the Crucible 'Inbox' and 'Outbox'.

® Create review (when used with Crucible) — click the down arrow to choose Create snippet.

® +—add a new repository. See Adding an external repository.

® Search — use FishEye's powerful search engine to find changesets, committers and files. See Searching
FishEye.

® Click your avatar to change your user settings (see Changing your user profile).

Repository tabs

Once you have selected a repository, you can navigate through it by selecting files and folders in the
navigation tree on the left. The available tabs change according to whether you are viewing a repository or a file:

Tab Repo File Description
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Files 0 Provides details about the files in the repository. See Browsing through a repository
Revisions 0 Shows the latest revisions of the file. See Viewing a file history.
Activity o o Shows recent activity on the item. There are a number of sub-options here (see Vie

wing the changelog):

® All — The default view, showing commits, reviews (when used with Crucible)
and JIRA issues (when used with JIRA).

® Commits — Shows commits in the activity stream.

* Reviews — Shows review activity in the activity stream (when used with Crucibl
e).

® Filter — Applies constraints to the current activity stream.

® Scroll to Changeset — Opens the changeset ID specified in the text field (press
Enter to carry out the action).

Commit O Provides a visual representation of commits to, and branches in, the repository. See

graph Viewing the commit graph for a repository.

Users (] @  Shows the commit history of the different users that have committed changes on
the item.

Reports O 0 Shows activity charts for the item. Various chart options can be selected in the left
navigation bar (see FishEye charts).

Source @  Shows the contents of the file. See Viewing file content.

Search (] Gives access to the advanced search capabilities in FishEye.

Browsing through a repository

Browse your repositories in FishEye to see information about the files in the repository and related activity,
including commits to the repository. You can also generate charts, and search for specific file revisions in the
repository.

On this page:

Browse a repository

View information about a repository or directory
View information about a file

Hide empty directories and deleted files

Watch a repository

Browse a repository
1. Click Repositories in the header and choose either a recently viewed repository, or All repositories.

2. Click the name of a repository to view its contents.
3. If required, use the branch/tag selector (just above the file tree) to change context.

View information about a repository or directory
Click a folder/directory name to see information about that on these tabs:

Files View the contents of the repository/folder.

Activity = View the commit, review and issue (requires JIRA) activity related to the repository/folder. The
activity stream is similar to the changelog activity stream. See Viewing the changelog.

Commit Visualize the repository, using the commit graph. See Viewing the commit graph for a repository.
Graph
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Users View the commit history of the users that have committed changes to files in the repository/folder.
See Viewing People's Statistics.

Reports View activity charts for the repository/folder. See FishEye charts.

Search  Search the repository/folder. See Searching FishEye.

o A greyed out item is either deleted or empty.

FE-hg F,Clone [ Share = £t Tools ~

Files Activity Commit Graph Users Reports Search

D default ~
n o Download Hide deleted files &
Name Revision Age v Author
» @ amps-jira-plugin
. B artwork README.md 7809905 5 weeks Piotr Swiecicki
> [ build-dependencies B src 4955816 5 weeks Conor MacNeill
» [ bundled-plugins
» BB dbdriver I fecru-rest-plugin dd732c3 5 weeks Maciej Swinarski

View information about a file

Click a file name to see information about the file on these tabs:

Revisions The history of revisions for the file. See Viewing a file history.
Activity The commits and reviews activity related to the file. See Viewing the changelog.

Users Commit histories for users who have committed changes to the file. See Viewing people's
statistics.

Reports Charts for the file activity. See FishEye charts.

Source The raw file can be downloaded from this tab. See Viewing file content.

FE-hg / bundled-plugins
¥, Clone

pom.xml
Revisions Activity Users Reports Source

D default ~

> [ amps-jira-plugin Dif 2 selected | Difflatest = 57 Filter = [MOENCCXINEUETM  Show all details $E 8

> I artwork

> [ build-dependencies 215 revisions

v (@@ bundled-plugins

. Thomas Davies Source | Diff | Changeset 22 May
pom.xml N ‘.‘ ecfed25 on ¥ 3.5-FECRU-4709-upgrade-to-platform-2.21 | +6 -0

» BB dbdriver o NONE: merge from default to 3.5-FECRU-4709-upgrade-to-platform-2.21

> [ dependencies

» [ doc £ tukasz Pater Source | Diff | Changeset 08 May

» | etc N i 5 6bb9862 on ¥ 3.5-FUSE-1170-switch-to-remote-events-plugin |+3 -2 @ CR-FE-8601

> [ fe-vis-highlighter-plugin = FUSE-1170: switch to using remote event plugin instead of devstatus for IssueChanged events

Hide empty directories and deleted files

FishEye tracks deleted files for your repository. Deleted files will be greyed out in the left-hand navigation tree. If
all of the files in a directory are deleted, the directory will also be greyed out.
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You can hide deleted files and empty directories in the left navigation tree:

1. Click Repositories in the header and browse to a repository.
2. In the left hand navigation panel, click the 'Actions’ menu and choose either:
* Hide empty directories — hide all empty (greyed out) directories and their contents (i.e. deleted
files and empty sub-directories).
* Hide deleted files — hide all deleted (i.e. greyed out) files. This does not affect directories.

FE-hg

Files Activity Commit Graph Users Reports Search

I’ default ~
% — Download
Hide empty directories
Hide deleted files Name

B amps-jira-plugin
BB artwork

o If you hide both empty directories and deleted files, you will only see files and directories that exist on the He
ad of that path. In repositories other than Subversion repositories, this could mean files/directories on any
branch.

Watch a repository

You can "watch" a repository in FishEye/Crucible. Watching the repository allows you to receive email
notifications when changes are made to the repository.

1. Navigate to the repository that you want to watch.
2. Choose Tools > Watch.

You can view all of your watches and configure the frequency of your watch emails in your user profile. See Cha
nging your user profile.

To remove the watch, choose Tools > Unwatch. You can also remove watches from within your user profile.
The option to add a watch will only be available if the administrator has enabled watches for the repository.

Viewing file content

You can search or browse your repositories in FishEye to view a specific file. Once you find the file, you can
view the diffs between different revisions of the file, and see any annotations.

You can also download the source code for the file.

View the source code for a file

1. Search, or browse through a repository, to find the file.
2. Click the file name to see the revision history for the file.
3. On the Source tab:

Displaying  Click the arrow buttons to see the previous or next revisions of the file. Pick revision
a diff numbers (e.g. 'b3ebfaf’) from the two lists to display the diff for those two revisions.

Changeset View the changeset that the revision was a part of.

Raw Download the raw source code for the file.
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Reviews Select Create Review to create a Crucible review from the file, or go to a review that
relates to the file. (Requires Crucible)

Blame Press to display authors and revision numbers next to each line of code in the file

FE-git/ src/ bundled-plugins / bundled / fecru-admin-plugin / src/ main/ resources / global-permissions

global-permissions.less

&, Clone [ Share

Revisions  Activity Users Reports Source

m, [& ssoss [J( a7eoss [ 4] Changeset Raw Reviews~ Blame

BcreateRowButtonsWidth: 290px;
= BcreateRowSelectWidth: BcreateRowButtonsWidth - T0px; // minus "Add™ button width
BoperationsCellwWidth: BcreateRowButtonsWidth - 32px; // minus "status" column (the last one)

/== The “"table"” prefix is necessary to override other styles =/
table.force-aui.global-permissions-list {

. amna.

Viewing a file history

You can view a specific file when browsing a repository. This allows you to see information about the file,
including the history of file revisions.

View the history of revisions for afile

1. Log into FishEye/Crucible.

2. Search, or browse through a repository, to find the file.

3. Click the Revisions tab. The history of revisions for the file will be displayed. See the 'File Revisions'
screenshot below.

Diff 2 Check boxes for two file revisions and then click to view the diff for those revisions.

selected

Diff View the diff of the two most recent file revisions.

latest

Filter View the file filter. Enter the desired fields to filter the file history results on.

Include Include revisions of the same file from other branches.oA file can have many physical

other paths, all of which relate to the same filename in your project structure, or repository's

branches logical structure. This applies to Subversion's branching and tagging directory structure in
particular.
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Show all  Toggle expand or collapse of all file revisions to show additional information including the
details revision ID, parents and the branch where it is head, denoted with this graphic:

HEAD

See the 'Overview of a File Revision' diagram below for an explanation of the information provided about

individual revisions.

Screenshot: File Revisions

FE-hg / bundled-plugins
pom.xml

Revisions Activity Users Reports Source

D default ~

> W artwork
» [ build-dependencies 215 revisions
v (& bundled-plugins

» Im dbdriver

> [ dependencies

> [ doc —
> I etc

tukasz Pater

¥, Clone

m, > B ampsijira-plugin Diff2 selecied | Diff latest 7 Filter Include other branches Show all details LE 18

mSource Diff | Changeset 22 May #~

_ Thomas Davies
pom.xml B 1 » ecfed25 on ¥ 3.5-FECRU-4709-upgrade-to-platform-2.21 |+6 -0

NONE: merge from default to 3.5-FECRU-4709-upgrade-to-platform-2.21

Source | Diff | Changeset 08 May &~

» 6bb9862 on ¥ 3.5-FUSE-1170-switch-to-remote-events-plugin | +3 -2 @ CR-FE-8601
> [ fe-vis-highlighter-plugin FUSE-1170: switch to using remote event plugin instead of devstatus for IssueChanged events

Diagram: Overview of a file revision

Toggle Click to see Choose the  Lines of code added Show diff to the
display of  author's profile branch or removed previous version
details

LN I A

54e9c83 on §F default [+1 -1

T
.\Bluld.u\ Humphru‘,i/ / Source | Diff | Changeset 10 Mar 11

NONE: move infdb to right place, fix IDEA deps
Revision ID 54e9c83e7e233de94baled3181fe5aa4038a7869

Parents locations. properties 47e634761cebbB391c87c66b7abeb55baded6ec18
Branch points: 2.7-FECRU-2258-infinitydb-3

Tags 2.7.6 2.6.0-RC2 DF20110530-2 2.6.0-RC1 | (+117 more)

Head on 2.6  2.7-CRUC-6075 | 2.7-FE-3985 | 2.7-FECRU-2279-TESTS | (+15 more)

Using side by side diff view

FishEye's 'side-by-side diff' view allows you to see how a file's content has changed. Different versions of the file

are displayed together to make line-by-line comparisons easy.

Choose:

*Raw

* DIff to latest
“View in Graph
* Permalink
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1 FE/ trunk
build.xml
Actiaty Revisions Users Reports Source
¢ 107305 ~ 107905 - Annotation Highlighting >  Columns = Reviews =
=% <import file="ecli s 4 <import file="eclipse/build.=ml"/>
<import file="idead/build.xs 5 <imporTt f£ile=’ v I 1.0
<import file="ideas/ build.ml" [ <import f£ile="parfmon/bnoild.xml® >
i <import file="ibnilder/build. xml" /> 7
<import file="jdeveloper/build.xml" /> ] ] <property name="test.results.dir” valoe="§{build.dir]}/test/ht
- a
O <macrodef names"subts 0 10 <macrodef names"subtar
<attribute names® 1 1 <attribute name
ibUtE B F AttEibute name-"t:
<sequential> 13 <sequential>
<subant target modulel arget} "> 14 4 <subant target ule) "trw
<dirset dir="." file : 15 15 <dirset dir="." file="
</fsubant> 1 </subant>
</ aequentials HEE </ sementials
</macrodefs </macrodef>
smacrodef names"do 2 <macrodef name="doall®s
<atbribute names=*target” /> 1 2 ttribute names*target®/>
2 Al 23 caGqmentiale
<subtarget m <subtarget " target=" Tget} /S
<subtarget m btarget target=" mt )
<subtarget v 25 csubtarget ~#{tar
<subtarget modoles=" ] J it 26 26 <subtarget
<anbtarget modnle="; 27 27 canbtarget
<subtarget module="f 28
<subtarget module="« 79 29
<subtarget module=" 30 30
<subtarget modoles=" 31 3 | </macrodef>
<subtarget module="ibnilder”
<subtarget module="jdeveloper” a3 <target name="global.bs
</sequential> <doall ta

Show the side-by-side diff view

1. Open the source code view for the file. See Viewing file content.
2. Use the elect a range of revisions to compare.
3. Choose View > Side-by-side Diff.

Note that:

Green highlighting indicates where lines have been added; red shows where they've been removed.
Grey highlights indicate that a line's internal content has changed.
Each addition or deletion is linked to the adjacent pane by a colored triangle to show the location of that
change in the comparison file.

® Line numbers in the margin are permanent links ("permalinks") that can be sent to colleagues. When
they open those links, the view will automatically open in side by side diff mode.

Alternative ways to open side-by-side diffs

From the FishEye Dashboard

You can also open side by side diffs from the Dashboard screens, by clicking the 'Delta’ triangle icon next to an
item when it appears in the stream of events. This will open the file in the diff view. If you have currently selected
side by side diff as the viewing mode, then the diff will automatically be displayed in that mode. If not, you can
select side by side diff from the View menu.

From the Revisions History view

When in the revisions view, you can show a diff by checking the boxes next to two revisions, then clicking the Dif
f in the top control bar. If you have currently selected side by side diff as the viewing mode, then the diff will
automatically be displayed in that mode. If not, you can select side by side diff from the View menu.

You can also launch into a diff of the latest revision and the second most recent by clicking Latest Diff in the top
control bar.

Viewing the changelog

The changelog is a record of the commits and reviews for a repository, branch, directory or file. You can view the
recent activity in the changelog when browsing a repository/branch/directory.

On this page:
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® View changelog activity
® Filter commit activity in the changelog
® Watch the changelog activity

View changelog activity

1. Browse to the desired repository, branch, or directory.

2. Use the branch/tag picker (under the repository or file name) to change context, if required.

3. Click the Activity tab.

4. Use the following functions of the Activity tab to see different aspects of the changelog activity:

All Click to show commits, reviews (requires integration with Crucible) and JIRA issues
(requires integration with JIRA) activity in the activity stream.

Commits Click to show only commits in the activity stream.

Reviews Show only review activity. (Requires integration with Crucible)
Filter See Filter commit activity in the changelog (below) for more information.
commits

Expand all =~ Show all modified files related to each changeset.

Scroll to Enter a changeset ID (e.g. 107856) to scroll to that changeset in the activity stream.
changeset
FE-hg ¥, Clone [ Share ¥ Tools ~

Files Activity Commit Graph Users Reports Search

D default ~
» @ amps-jira-plugin Al Reviews 7 Filter commits Expand all
> [m artwork

» I build-dependencies

> [ bundled-plugins

» [ dbdriver

» W dependencies

> [ doc

> I etc

> [l fe-vis-highlighter-plugin
» [ fecru-gadgets-plugin

» | fecru-rest-plugin

> [ fisheye-feedback-plugin
> I lib

> [l licenses

» [ modules

» | plan-templates

Wednesday 04 Jun

g Piotr Swigcicki
[El 7809905 changed 1 file ¥ default
~

README.md edited online with Bitbucket

Tuesday 03 Jun

Cezary Zawadka
[El ¢5d1005 changed 2 files $ default

FECRU-4620: fix fecru-review-issue-transition-plugin after merges

g Piotr Swigcicki
[E 97f9f03 changed O files ¥ default
~

MERGE (3.5-FECRU-4879-hgignore-to-gitignore to default)

10:48 am

1:19 pm

12:50 pm

Filter commit activity in the changelog

You can filter the commits that are displayed in the activity streams on the All and Commits tabs of the Activity
tab. Note that you cannot use the commits filter to filter reviews.

1. Goto the Activity tab, as described above.
2. When viewing either the All or Commits tab, click Filter commits.
3. Enter filtering criteria:

Committer Changesets checked in by the given committer/author.

Log Changesets where the commit comment matches the given text.
Comment
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File Changesets that contain files with the specified file extension.
Extension

File Name Changesets that contain a given file.

Start Date Changesets created on or after that date. Must be of the form YYYY-MM-DDTHH:mm:ss,
YYYY-MM-DD, YYYY-MM or YYYY (you can use /' instead of '-").

End Date  Changesets created on or before that date. Must be of the form
YYYY-MM-DDTHH:mm:ss, YYYY-MM-DD, YYYY-MM or YYYY (you can use '/" instead of

l_l).
4. Click Apply.

® Use Clear to clear the filter.
® Click Filter commits again to turn off the filter.

m Commits Reviews T Filter commits. Expand all

Committer: A File Extension: Start Date:

Log Comment: File Name: End Date: Apply

Watch the changelog activity

You can "watch" a changelog's activity stream in FishEye and Crucible. Watching the activity stream means that
you receive emails when updates occur in the activity stream. You can even add filtering criteria for the watch,
so for example you can restrict watches for commits by a particular user.

Note, the option to add a watch will only be available if the administrator has enabled watches for the repository.

1. Navigate to the activity stream that you want to watch, as described above.
2. If required, add filtering criteria, as described in the Filter commit activity in the changelog section above,

and click Apply.
3. Choose Tools > Watch.

To remove the watch from the activity stream, choose Tools > Unwatch. The watch will be removed.

You can also view all of your watches, configure the frequency of your watch emails, and remove watches, in
your user profile. See Changing your user profile for more information.

Searching FishEye
FishEye has a powerful search engine that allows you to find changesets, committers and files. There are
two methods for searching in FishEye:
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Quick Search

® Searches across all repositories
connected to FishEye.
® Suggests "quick nav" results as

you type.

Repositories B crucible-confluen® m-plugin

(] crucible-filesystem-scm-plUg
5 crucible-git-scm-plugin
] crucible-issue-transition-plugin
) crucible-jira-blockers-plugin

Changesets  [E] 13c3868 (FECRU-4292: upgrade naviinks plugin)
[E] 4cab6fa (FECRU-3973: improve plugin xsf handii..
[E 81af734 (FECRU-3802: quicknav plugin stub, mo

® Has extra search tools, such as
'handles'.
® Press <Enter> to see filters:

q test Search
o, Source By relevance By date
T B sesfzs0 B conor MacN
¥ Files and directories 14152 FE-4954: Add unit test f
E]l Commit messages 203
9 El adsade7 B conor Mac
A Diffs 56129 Improve fail message in
= content 7681
El 5590384 @ Conor Mac|
& Comnitters L Move test to its correspg
Reviews El eeedbob B conor Mac
FECRU-4055: Add a tes
@ Reviews F El esae626 Bl conor Mac
Correct sense of test
Q Comments 94
Last modified = dodi721 @ Conor MacN
Test passes with these d
Any date
Yesterday Bl 5330779 B conor Mac
Last week Correct Unit Test
Last month
El 5330779 B conor Mac
Last year Correct Unit Test
By
El 402c73b B Conor Mac
Conor MacNeill - Fix some test failures
Bl 402c730 B Gonor Mac
Fix some test failures

Use Quick Search

Simply enter your search criteria in the search box in the FishEye header to search across file, repository,

Advanced Search

® Click the Search tab when viewing
a repository.
Searches a single repository.
Access the EyeQL query
language, if required.

® Enter search criteria for a range of
attributes:

Search Criteria
() Search HEAD only

Comments: |

Added Text: |

Contents: | |

Removed Text: |

Author(s): |<andrea@cenqua.com>
@atlassian.com

Adam Ahmed

adrian deccico <adeccico@at
adrian hempel <ahempel@at
Alex Wei

File name | |
( Ant-globs ):

Branch: | - ‘

Tag: | - ‘

After: | |

Before | |
( YYYY-MM-DD ):

Order by:

| Date descending $

Group by:

| Changeset s

Display data:

@ Path @/ Revision @/ Author o/ Date

@ ChangesetID () Comment () Total Lines
()Lines Added ()Lines Removed () Tags

() Reviews

Switch to EyeQL Search

| Search |

committer and user names, as well as commit messages and reviews (if you are using Crucible with
FishEye).

Use search tools and filters to refine your results. See Refining your Quick Search Criteria and Filterin

g Quick Search Results below.

Results are weighted by edit date; files edited within the last twelve months are given greater

weighting.

There is a 100-repository limit on searches, to prevent FishEye becoming unresponsive when there
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are large numbers of repositories. FishEye will also limit the search to the specific repository that you
are looking at, if you are already navigating within a specific repository

® If FishEye is integrated with JIRA you can see a summary of a JIRA issue in your search results by
hovering over the issue key. See JIRA Integration in FishEye.

® See also Searching Crucible in the Crucible documentation.

Refine your Quick Search criteria

The FishEye Quick Search has a number of powerful tools that you can use to refine your search criteria
before executing the search.

Tool

CamelCase
pattern
matching

Path/File
pattern
matching

Field
handles

Search
within a
directory

Search for
discrete
phrases

Description

Enter a
CamelCase
pattern to find
matching files and
directories.

Enter a path/file
pattern to find
matching files and
directories.

Use a field handle
to restrict your
search to a
particular field:

* file—
file/directory
names

® commit —
commit
messages

® diff —lines
added/removed

® content —
file contents

® committer —
committer
names

Use AntGlobs to
search a specific
directory.

Enter a phrase in
quotation marks.

Not case-sensitive.

Filter Quick Search results

Example
BooQCTest returns results like Bool eanQuer yCoor dTest

and Bool eanQuer yd assTest .

common/ final / Acti ons returns results like / src/ cormon/ eu/ syst €
/ speci al projects/final/Actions.java.

file:build.xm returns files with names matching bui | d. xm .

Search for/ src/**/ gwt/*. xm and FishEye will return all files with a .
X

that are below both a src and a gwt directory. e.g. src/j ava/ comf atl a
fecru/ gw/ FecruCore. gwt.xm butnotsrc/javal conl atl assi ¢
u/ Appl i cati onCont ext . xm

"updat e version in buil d"returns matches for the exact string, i.e.
return "updat e build version" or"update version in file".

Once you have a set of search results on the Quick Search page, you can filter them to a subset of the
original results. The filter controls are in the left panel of the Quick Search page in the 'Source' section.
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Filter

All
repositories

Files and
directories

Commit
messages

Diffs

Content

Committers

All projects

Reviews
Comments

Last
modified

Author
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Description

By default, searches across all repositories.

Choose a repo to restrict the search to just that one. For example, if you enter 'FE' then the
search results page will refresh to display only files and directories in the 'FE' repository.

Filter your results to files and directories that have nhames that match the search criteria, se
e details below.

Filter your results to changeset comments that match the search criteria.

Filter your results to diffs (lines added/removed) that match the search criteria.

Filter your results to files that have content that match the search criteria, see details
below.

Filter your results to committers that match the search criteria.

When using Crucible with FishEye, there is a 'Reviews' section. The All projects dropdown
allows you to filter reviews returned in the search results. See Searching Crucible.

Search in reviews
Search for review comments

Filter by the date of the last change.

Filter by author name.

Use Advanced Search

The Advanced Search can only be run against a specific repository, however you can specify more precise
criteria against a number of fields for that repository.

1. Navigate to the repository that you want to search, as described in Browsing through a repository.
2. Click the Search tab.
3. Enter your search criteria:
® Standard Search — Enter criteria in the 'Search Criteria' panel. See Specify criteria using the
search interface below for details.
® EyeQL Search — Enter your "EyeQL" query. See Specify criteria using EyeQL section below
for more details.

Use Switch to EyeQL Search and Switch to Standard Search at the bottom of the 'Search Criteria'
panel to toggle between the two search methods.

Specify criteria using the search interface

The Advanced Search interface allows you to specify search criteria for multiple fields, order the results,
group the results and choose the display fields in the results. You can link to the search results, as well as
save the results to a CSV file.

Please note the following:

® Contents — Files must be non-binary, less than 5MB, and for SVN repositories, on trunk only. Only
HEAD!/tip revisions are searched. For older revisions, use the added/removed text search criteria.
®* File names — Antglobs can be used to specify the criteria for this field.
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Specify criteria using EyeQL

Advanced Search also allows you to run searches using FishEye's powerful EyeQL query language.

Click Switch to EyeQL Search at the bottom of the 'Search Criteria' panel.

See the EyeQL reference guide for more information. If you're unfamiliar with EyeQL, consider using the Stan
dard Search Interface to build your initial query, then switch to EyeQL to modify that.

FishEye charts

When browsing a repository, the Reports tab displays a chart of the lines of code (LoC) committed to the
repository over time. The following options are available:

® Charts

® Code Metrics

® Notes

Charts

Click Reports and then Charts when browsing a repository to see charts of activity in the repository.

You can control the chart type that is displayed and various chart options. Click the cog icon on the left, select
the required options, and click Apply. The available options include:

Setting
Branch/Tag
selector

Chart type

Author

Extension

Subdirectory

Start Date

End Date

ﬂ *The 'Change’ chart displays the change in lines of code, for a specific date range, expressed as a line graph.

Explanation

Limits the chart to the selected branch/tag.

Changes the chart's presentation.

Limits the chart to show specific author(s).

Limits the chart to show specific file type(s).

Limit the chart to a folder under the current branch. Files
in the current directory are represented by an element
labeled ".(this dir)'.

Date of the earliest data to show.

Date of the latest data to show.

Values

Any branch/tag
from the current
repository.

Area, line, pie or
change* chart.

Any author
configured in the
system.

Any file extension;
e.g. java'

A single folder.

Date in format
YYYY-MM-DD.

Date in format
YYYY-MM-DD.

Default
Displays the
default/trunk.

Area

All

All

None (show
all)

None (show
all)

None (show
all)

For example, if the lines of code at the start date is 100, the start point will be zero and the rest of the graph
shifted by 100 lines.

Screenshot: FishEye custom chart settings
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trunk 1]

Gy Chart types

i@ Area @ Line Pig Change

& Chart options
Break down by:

Mone (@ Subdirectery ()
Author &) User &
Extension &)
Date Range:
Start Date:
Author(s):
.
Adam Ahmed (aahmed) F

Anna Buttfield (abuttfield)
Ben Speakmon (bspeakmaon)
Brendan Humphreys (bhumphreys) -

File Exten=ion:

Maone E
MF
TXT
.cfs =

Screenshot: FishEye per-author LOC chart

LOC and Commit History - Path /, Branch: (trunk)
GOOK
400K
200K
0
2K
1K
- - —t - |
ul-2002 Jan-2003 Jul-2003 Jan-2004 Jul-2004 Jan-2005 Jul-2005 Jan-2006 Jul-2006 Jan-2007 Jul-2007 Jan-2008 Jul-2008

Screenshot: FishEye per-author LOC chart showing multiple authors
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LOC and Commit History - Path /, Branch: (trunk), Show by author

GO0K

400K

200K

I 1K
L— J_--I
- . W= -

. . — : ! 0
ul-2002 Jan-2003 Jul-2003 Jan-2004 Jul-2004 Jan-2005 Jul-2005 Jan-2006 Jul-2006 Jan-2007 Jul-2007 Jan-2008 Jul-2008

. pate . pmcneil . tim matt . conor . Other

Screenshot: FishEye LOC chart by file extension

LOC and Commit History - Path /, Branch: (trunk), Show by file extension

. JJava (160,180 - 40%)
. s (116,129 - 29%)
. .map (20,098 - 5%)

— cml (16,599 - 429
. Jsp (14,161 - 4%)
. A1 (13,036 - 3%)

[ Other (63,087 - 16%)

Per-Author Lines of Code Statistics

You can view per-author statistics for lines of code as a chart. This allows you to see how many lines of code
were contributed to your project by each author, over time. You can easily view this information on the charts
page. Note, if you are upgrading from a previous version of FishEye, you will need to re-index the repository in
order to show the per-author information.

Code Metrics

A number of built-in reports are also provided:

Screenshot: Commit Time/Volume
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Commit Time/Volume

Mon ® o o

e . ° ® ®

Sat

1iam 1 2 3 4 & & i 8 a o 11 1ipm 1 2 3 4 & & i 8 a 10 1

Screenshot: Top Committers

Top Committers — By LOC Top Committers — By Revision
mstudman 1167 andrea 38
npellow 431 npellow 26
andrea 320 brendan 14
nick [523 nick 10
gorain 30 rstudman 7
brendan g gcrain 1

Top Committers — By Commit

npellow 14

nick 10

andrea 7

brendan 3

gCrain 1

mstudman 1
Notes

Related Topics

Browsing through a repository

Using favourites in FishEye

FishEye allows you to add changesets, files, people and repositories as favorites. You can view your favorites,
or see a stream of all activity relating to your favorites. We suggest that you select items that you are currently
working on as favorites, to create a more relevant personalized view.

You can always view your favorites from the menu at the top of the screen, next to your username.

If you are using Crucible, you can also add code reviews to your favorites.

On this page:
® Adding favorites
® Managing favorites

Adding favorites

To add an item to your favorites, follow one of the options below:
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People Hover the mouse cursor over their avatar or username. In the context menu, click Follow.
Changesets Open the changeset and click the grey star icon next to its name, near the top of the screen.

Files or Open the file or folder and click the grey star icon that appears next to its name. The name
folders appears in the breadcrumb links at the top of the screen.

Repository  Click the Source tab and then the grey star icon that appears next to the name of the desired
repository.

Managing favorites

To change the display name for, or remove, a favorite:

1. Choose Favorites from your user menu at the top right.
2. Click the yellow star beside a favorite to edit the display name or remove the favorite.

Due to FE-2348 you cannot currently rename favorite directories, users or committers

Changeset discussions

Please see the Crucible documentation for instructions on this feature.

Viewing the commit graph for a repository

The commit graph shows changesets in their respective branches, using configurable "swimlanes”. This allows
you to see key information such as branching and merging (and if you are using Git or Mercurial, you will be able
to see anonymous branches as well).

The Highlight feature of the commit graph allows you to highlight different types of information in the swimlanes
or changeset list:

® ancestors and descendants for a changeset
® commits with JIRA issues
* reviewed and unreviewed changesets.

For example, if you have the JIRA issues highlight active, clicking a changeset with a JIRA issue in the
commit comment will show all other changesets with the same JIRA issue.

Before you begin:

® Subversion repositories currently do not show lines between branch swimlanes (i.e. merging). But in
some cases, FishEye might pick up associations based on SVN branch points.

® Some features of the commit graph are only available if you are using Crucible with FishEye. For details,
see the description below.

® Some features of the commit graph are only available if you are using JIRA with FishEye. For details, see
the description below.

On this page:

Viewing the commit graph for a repository

Highlighting the lineage of a changeset

Highlighting JIRA issues

Highlighting reviewed changesets

Highlighting commits by an author

Highlighting search results

Viewing changesets across all branches

Reordering swimlanes for Git repositories
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Related pages:

® Subversion Changeset Parents and
Branches

® \What are Subversion root and tag

branches?

Perforce Changesets and Branches

Using the FishEye screens

Browsing through a repository

JIRA Integration in FishEye

Viewing the commit graph for a repository

To view the commit graph for a repository:

49

1. Navigate to the desired repository, as described on Browsing through a repository.

2. Click the Commit Graph tab.

Selecting, or hovering on, a changeset (regardless of highlight) will display the following in the row for the

changeset:

* an ) icon. Click this icon to see details for the changeset.

® acog icon with a menu that allows you to see the changeset ID, view the full changeset, view the
changeset in the activity stream, or to create a review for the changeset.

Highlight selector Changeset shown Branch "Swimlane" selector

on its branch

Changeset/Tag search

Actiity | Comiwit Graph  Files | Users Search

Highlight Lineage -

Reports
Goto

seledt branches

default

Link to the URL for
<— this commit graph

L] 30 May 11
. 30 May 11

. 30 May 11

L] 30 May 11

L ] 30 May 11

. 30 May 11

L ] 30 May 11

. 30 May 11
L ] 30 May 11

) 30 May 11
[ ] 30 May 11

f Added tag DF20110530-2 for changeset 31553322372
Bl FECRU-1010 : make isUsernGroup call the cache first
B8 Creating branch for FECRU-1010
! FECRU-241 - Animate the accordion on IE9
B FECRU-718 : fix build after merge from default
B FECRU-718 - merge default to branch
MNone: Bump version number to RC1

None: Merge 2.6-FECRU-365-docs-changes to 2.6
None: Merge 2 6-FECRU-309
None: Merge 2 6-FECRU-909

# DF20110530-2
None: Merge 2 6-FECRU-365-docs-changes to 2.6 to default

° 30 May 11

) 30 May 11
L] 30 May 11

] 30 May 11
. 30 May 11

) 30 May 11
P 200dadd

CRUC-4771 - Fix autacomplete dropdown lacation on IE8 in
None: Merge 2.6-FE-3043-source-columns to 2.6 to default
None: Merge 2 6-FE-3043-source-columns to 2.6

None: Merge 2 6-FECRU-998-autocomplete-enter to 2 6 to
None: Merge 2.6-FECRU-398-autocomplete-enter to 2.6
None: Merge 2.5 to 2.6 to default Pickup security fix for CS

2L o

Y Y Y LY

o o ool

|

Changeset showing:
| * date of commit
* user avatar of committer
* commit message (including
JIRA issue key, if mentioned)

Branch "Swimlanes”

Changeset list

Highlighting the lineage of a changeset

Choose Highlight > Lineage to show the ancestor and descendant changesets for a selected changeset.

Action Behavior

Click on a changeset
in the changeset list

Hover over a
changeset in a
swimlane

Highlights where a changeset comes from and where it propagates to, i.e. its
ancestors and descendants.

Displays the changeset number and all the branches that the changeset is referenced
in. This will include branches that you may not have swimlanes displayed for.
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Activity Commit Graph Files Users Reports Search
Highlight |ineage E| Goto

select branches_..

[ ] 30 May 11§ Added tag DF20110530-2 for changeset e315533a2372 it
30 May 11 . FECRU-1010 : make isUserinGroup call the cache first
: 30 May 11 [ Creating branch for FECRU-1010
_Q__:1 30 May 11 % FECRU-441 : Animate the accordion on IE9
B FEcrRU-718
B recru-718
None: Bump version number to RC1  # DF20110530-2
MNone: Merge 2. 6-FECRU-365-docs—changes to 2.6 to
MNone: Merge 2.6-FECRU-365-docs—changes to 2.6
MNone: Merge 2.6-FECRU-909
Mone: Merge 2 6-FECRU-309 D -
CRUC-4771 : Fix autocomplete dropdown location on

m

30 May 11
30 May 11
30 May 11
30 May 11
30 May 11
30 May 11

30 May 11 None: Merge 2.6-FE-3043-source-columns to 2.6

"D wb = 4 =D " =D =D =D

30May 11§ None: Merge 2 6-FECRU-998-autocomplete-enter to
£
30Mav 11 @ Mone: Rearrange merged code so disposer wraps the

Highlighting JIRA issues

Choose Highlight > JIRA issues to highlight all the changesets that have a JIRA issue key in the commit
message.

This highlight type is only available if you have integrated FishEye with JIRA and linked your repository to a JIRA
project.

Action Behavior

Click on a changeset in the Highlights all other changesets that have the same JIRA issue key in the
changeset list commit message.

Hover over a changeset in a Displays all branches that the changeset is referenced in, and all
swimlane referenced JIRA issues.

Activity Commit Graph Files Users Reports Search
Highlight | JIRA issues [x] ot
select branches._.

) -

® 30 May 11 B FECRU-1010 : make isUserInGroup call the cache first L

® 30 May 11 B Creating branch for FECRU-1010 i

® 30 May 11 %' FECRU-441 : Animate the accordion on IE9
Q 30 May 11 [ FECRU-718 : fix build after merge from default
O 30 May 11 [ FECRU-718 - merge default to branch 0 o~
£ 4 DF20110530-2
£
£
£
£
e 30 May 11 [l CRUC-4771 - Fix autocomplete dropdown location on

£
£
£
£
£
g
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Highlighting reviewed changesets

Choose Highlight > Reviewed changesets to highlight the changesets that have been reviewed (i.e. included
in a Crucible review):

® Red: unreviewed, i.e. the changeset is associated with a review in the 'Dead' or 'Rejected' state, or no
review is associated.

L : under review, i.e. the changeset is associated with a review not in the 'Dead’, 'Rejected’ or
'Closed' state.

* Green: reviewed, i.e. the changeset is associated with a review in 'Closed' state.

This highlight type is only available if you are using FishEye with Crucible.

Action Behavior

Click on a changeset in the Highlights the changesets that are part of the same review as the select
changeset list ed changeset.

Hover over a changeset in a Displays all branches that the changeset is referenced in, and the
swimlane Crucible review key.

Activity Commit Graph Files Users Reports Search
Highlight Reviewed changesets IZ| Goto

default

select branches...

® 23May 11§ None: Merge 2 6-FECRU-134-focus-deeplink to 2.6
23May 11§ FE-3452 : Add option for Jetty to ignore do CR-FE-5570
® 23May 11§ None: Merge 2 6-FECRU-886-tags-in-graph to 2.6 to
® 18May 11 § None: Merge Sebs work rom default - missed due to
® 18 May 11 ﬁr NOME: Set a CR-FE-5528 # Seb-Example

m

® 18 May 11§ None: merge from 2.6 to reolve build number changes
® 18May 11 § None: Bump version number to 2.6.0-M3
® 18 May 11§ Removed tag 2. 6-RC
® 18 May 11§ Added tag 2 6-M8 for changeset eBabc7e58832
o} 18 May 11 [} NONE: merge
® 18 May 11§ None: Bump next release number to 2.7.0-M1
® 18May 11 § None: Create branch 2.6
® 18 May 11 J§1 FECRU-792 : Make maximum collapsed items 20
® 18 May 11 J§1 FE-3448 - Ensure watch emails get sent CR-FE-5526
L 18 May 11 J§1 Automated merge with ssh-//hg@bitbucket.or € 2 6-Ma
Q 18 May 11 J§¥ FECRU-792 : Cleanup lozenge highlighter CR-FE-5525
O 18 May 11 [ FECRU-792 : Initial work to allow highlight CR-FE-5525 @
® 18 May 11§ None: Add tests srcs to eclipse src path

Highlighting commits by an author
Choose Highlight > Author to highlight all the changesets submitted by a particular author.

Action Behavior

Click on a changeset in the Highlights the changesets that were submitted by the same author.
changeset list

Hover over a changeset in a Displays the changeset number and all the branches that the changeset
swimlane is referenced in.
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Activity Commit Graph Files Users Reports Search
Highlight | Author ¥ Goto
ROTP-859
[ ] 07 May 13 B APL-1002 JRADEV-21055 Remove custom link color so that Authorize links are ADG compliant.
ROTP-887
[ ] 07 May 13 [l Merge branch ‘master' into issue/ ROTP-827
ROTP-887
* 05 May 13 [ ROTP-927 Styles to add delete icon and change to .
] 03 May 13 [ ROTP-927 Refactor of edit and delete application handlers and their wizard dialog code.
] 02 May 13 [ ROTP-927 Move warning messages to external file.
] 02 May 13 B ROTP-927 Began simplification of varios message displays on the applinks list table.

Highlighting search results

Choose Highlight > Search to highlight all the changesets where the commit message contains the search
term.

Action Behavior

Click on a changeset in the Highlights the changesets that match the search term.
changeset list

Hover over a changeset in a Displays the changeset number and all the branches that the changeset
swimlane is referenced in.
Activity Commit Graph Files Users Reports Search
Highlight = search H Goto Search workflow
Select branches...
ROTP-848
ROTP-848
ROTP-848
[o] 17 Mar 13 Bl ROTP-848 Document methods in new ui workflow.
ROTP-848
ROTP-848
ROTP-848
[o] 15 Mar 13 Bl ROTP-848 Fetch manifest and display information in new Ul workflow.
APL-986

Viewing changesets across all branches

The "All Branches' mode allows you to view commit activity across all branches of a repository. In this mode, the
swimlane headers are not displayed. However, you can hover over any changeset to display information about
the changeset, as described in the 'Highlighting Information in the Commit Graph' section above.

To see all the repository's branches in the commit graph:

1. Click Select branches... when viewing the commit graph.
2. In the 'Select Branches' dialog, click Switch to all branches mode.
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Activity Commit Graph Files Users Reports Search

Highlight, Lineage [x] ot
Select branches ..
® 27 May 11 @l BAM-8783 - User can change manual flag for stage: FT -
o 27 May 11 @ Refactored UTs to remave PowerMock (it clashes with parallel tests due to bytecode rewriting and causes weird
L 27 May 11 # closing branch BAM-8782 , code review summarized
L] 27 May 11 my first merge.. merging BAM-8782 with the tip - wonder if this brokes smthing
® 27 May 11 # BANM-8782 User can specify on stage creation it is manual import/export of BuildResultSummary restartCount
® 27 May 11 @ BAM-7720 Bamboo elastic AMI should have an updated operating system from 2011 instead of 2008 3

27 May 11§ BAM-8815 Hide some options under "Advanced” tab for HG / Bitbucket repo I'm finishing this issue according to Jens
! 27 May 11 i@l BAM-2785 Ul tweaks for manual stages

*default 27 May 11 gl UT fix

27 May 11 i@l BAM-2796 REST API prettyfied esp. for Jason @

27 May 11 i@l BAM-2796 REST API support for continus/restart build

27 May 11 E BAM-8797 REST api should handle manual stages to automatically execute stages passed as parameters +

27 May 11 B Merge

® 27 May 11 EX BAM-7265 Changed the way how executed command is displayed in the build log.
® 27 May 11 E¥ BAM-8205 Grails builder cannot find test results
[ ] 27 May 11 ¥ Make @MotMull
® 27 May 11 ¥ Automatic merge
® 27 May 11 [ BAM-8844 Set up a temporary way to configure App Links in Bamboo. Must revisit before final release.

Reordering swimlanes for Git repositories
Reordering swimlanes is useful if you just want to show branches in a certain order. However, ordering

swimlanes is vital for Git repositories, as it is the only way to determine which branch a commit is from.

When you view the commit graph for a Git repository, FishEye works from the leftmost swimlane to the right and,
for each swimlane, checks if the commit is in that branch:

® |f the commit is in the branch, a dot is shown representing the commit.
® |f the commit is not in the branch, the dot for the commit is moved to the next column on the right.

For example, if the 'master' swimlane is to the left of another swimlane, e.g. 'fisheye-2.6' branch, there will be no
changesets shown in the ‘fisheye-2.6' swimlane, as all the commits will be picked up in the 'master' swimlane.
However, if you move the 'fisheye-2.6' swimlane to the left of the 'master' swimlane, it will pick up all of the
FishEye 2.6 commits.

For more information, read this Knowledge Base article: Ordering of Branches Important When Visualizing Git
Changeset

Viewing people's statistics

To see charts and activity of everyone who commits code to your FishEye repositories, click the People tab at
the top of the screen.

Screenshot: List of all commiters in FishEye
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Sourcei » Projectsi~ Reviews ! + Create Snippet  + Create Review

2 3 4 5 6 7 »
Commit History (12 Months) Commits Reviews
Aleksander I |
- ! e 178 75
u Mierzwicki Ill (T || o B '..I'.I“.l-.-

Alex Manusu ] ]

Alex Wei 2,530 38
B v |I||||._-|II| eallla L :

Alex Zuzin ] ]

ﬁ Alexander DICkson ---IIIIIIIII-III IIII I-I- ll||-|l__ 49? 153

E Alexander Hennecke | 982 13

> Al dru L 49 0
f“" exandr tazar i III | | IIIIII|| 1 IIIIIII

Alison Winterflood [] |__|-“.|. I 1 _.ll M 1,025 57
- -

8 Pe-lheie ) LM

The All Users screen shows all those with accounts on the system. You can see their commit history (expressed
as a bar graph) and their total number of commits.

Click on a person's name to see detailed information about their additions to the repository, and issue updates. If
you are using FishEye with Crucible and have JIRA integration set up, you can see their review activity.

Screenshot: Statistics on a Person in FishEye

Dashboard  Source !~ Projects | v WaClelRR Reviews: - + Create Snippet  + Create Review
’
e gt Tools ™
*. Joe Xie &
Activity
About All Commits Reviews Expand all
Li]
jxie@atlassian.com Morayios)Deo
First commit 20 January 2008
Latest commit 02 August 2012 Joe Xie 7:09 pm
Last Week Al Time W @ CR-FEP-87 finished reviewing
Commits: o 2,789
Files changed: 0 4718 Sunday 02 Dec
Change in LOC: (1] 62,845
Joe Xie 9:03 pm
( Help with these stats ) W () Re: CR-FEP-87 commented on review
Follow Joe Xie What is a ClearCacheEvent? and is it something that would occur during normal operation in jira? Also, there
Reviews
D Re: CR-FEP-87 commented on review 9:00 pm
0 active reviews
if its true that only tests uses this event, then perhaps a quick comment here would be great.
Line History Manday 19 Nov
Joe Xie 11:43 pm
. /—/\é i @ CR-FE-6898 finished reviewing
20K [
[ C) Re: CR-FE-6898 replied to ﬁg Richard Stephens 11:43 pm
10K / |
/ ﬁ. 50 is the problem with the way 10Utils toString() not using the correct encoding?
C) Re: CR-FE-8898 replied to :ﬁg Richard Stephens 11:38 pm
WOW.
M committer jxie in FE Wednesday 07 Nov
Committers joe xie <jxie@atlassian.com=,
. joe xie <jxie@atlassian.com and joe xie Joe Xie 10:15 pm
<jxie@atlassian.com> in FE-hg (Line » .
history not available) LT @ CR-FE-6862 finished reviewing
. Committer jxie in FEP :
Committer joe xie <jxie@atlassian.com= in o
atlassian-http (Line history not available) ) Re: CR-FE-6862 replied to [lll Richard Stephens 10:14 pm
. g%ﬁmg;zugﬁjfeﬂﬁa@wﬂgfiﬂgigg‘gr n these classes are copied from jira. You should check if these classes are now part of atlassian-http, and if

Some users may not appear to have the correct number of Files Changed, despite regularly committing.
In this situation, if they have committed to a directory which is not covered by the regexes in your
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symbolic definition (i.e. they have committed to a directory that is neither trunk, branches or tags) then
that directory will be counted as part of trunk. Also note that creating tags and branches themselves
does not count toward the totals in FishEye.

Avatars

By default, each user has a unique avatar that is randomly formed from the text in their email address. You can
add your own avatar by uploading an image to an external service such as Gravatar, which Crucible supports.
See changing your user profile.

If you are using Crucible, statistics for each person's code reviews are also available.

Using Smart Commits

Smart Commits allow repository committers to perform actions such as On this page:
transitioning JIRA Software issues or creating Crucible code reviews by

embedding specific commands into their commit messages. * Smart
Commit
You can: commands
. ® Smart
® comment on issues Commit
® record time tracking information against issues commands
® transition issues to any status defined in the JIRA Software project's for
workflow. Crucible
There are other actions available if you use Crucible. See below for more reviews
information. * Advanced
examples
Each Smart Commit message must not span more than one line (i.e. you ® Get Smart
cannot use a carriage return in the command), but you can add multiple Commits
commands to the same line. See this example below. working

Related pages:

* Enabling
Smart
Commits

® Transitioni
ng JIRA
issues

® \Write your
own Smart
Commit

Smart Commit commands

The basic command line syntax for a Smart Commit message is:

<i gnored text> <I SSUE KEY> <ignored text> #<COMAND> <opti onal
COVWAND_ARGUMENTS>

Any text between the issue key and the Smart Commit command is ignored.
There are three Smart Commit commands you can use in your commit messages:
® comment
® time
® transition

Comment
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Description
Syntax

Example

Notes

Time
Description

Syntax

Example

Notes

Adds a comment to a JIRA Software issue.
<ignored text> | SSUE_KEY <ignored text> #comrent <coment_string>

JRA- 34 #comment corrected i ndent issue

® The committer's email address must match the email address of a single JIRA Software
user with permission to comment on issues in that particular project.

Records time tracking information against an issue.

<ignored text> | SSUE KEY <ignored text> #time <val ue>w <val ue>d
<val ue>h <val ue>m <coment _stri ng>

JRA-34 #tinme 1w 2d 4h 30m Total work | ogged

This example records 1 week, 2 days, 4 hours and 30 minutes against the issue, and adds
the comment 'Tot al wor k | ogged'in the Work Log tab of the issue.

® Each value for w, d, h and mcan be a decimal number.

® The committer's email address must match the email address of a single JIRA Software
user with permission to log work on an issue.

® Your system administrator must have enabled time tracking on your JIRA Software
instance.

Workflow transitions

Description

Syntax

Example

Transitions a JIRA Software issue to a particular workflow state.

<ignored text> | SSUE_KEY <i gnored
text > #<transition_nane> <coment _string>

JRA- 090 #cl ose Fixed this today
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Notes

This example executes the close issue workflow transition for the issue and adds the
comment 'Fi xed t hi s today'to the issue. Note that the comment is added automatically
without needing to use the #comment command.

You can see the custom commands available for use with Smart Commits by visiting the
JIRA Software issue and seeing its available workflow transitions:

1. Open an issue in the project.
2. Click View Workflow (near the issue's Status).

The Smart Commit only considers the part of a transition name before the first space. So,
for a transition name such as f i ni sh wor k, then specifying #f i ni sh is sufficient. You
must use hyphens to replace spaces when ambiguity can arise over transition names, for
example: #f i ni sh-wor k.

If a workflow has two valid transitions, such as:

® Start Progress
® Start Review

A Smart Commit with the action #st art is ambiguous because it could mean either of the
two transitions. To specify one of these two transitions, fully qualify the transition you want
by using either #st art - r evi ewor #st art - pr ogr ess.

® When you resolve an issue with the #r esol ve command, you cannot set the Resoluti
on field with Smart Commits.

® If you want to add a comment during the transition, the transition must have a screen
associated with it.

® The committer's email address must match the email address of a single JIRA Software
user with the appropriate project permissions to transition issues.

Smart Commit commands for Crucible reviews

When creating a new review using a Smart Commit the default project objectives are added to the review,
and since Fisheye/Crucible 2.10.2, the commit message is also copied to the review objectives.

Note that you cannot add arbitrary objectives to the review using a Smart Commit.

Create a review

Description

Syntax

Example

Notes

Create a review in Crucible.

<comit nessage> +revi ew <project key>

Fix a bug +revi ew CR- TEST

The +r evi ew command creates a new review in the project CR-TEST with the content of
the changeset. The review will be in a draft state unless the project has default reviewers or
reviewers are explicitly mentioned. If you only have one project in Crucible, or a repository
is a project's default repository, it is not necessary to mention the project key.

Add reviewers

Description

Syntax

Example

Add reviewers when creating a new review in Crucible.

<comit nessage> +revi ew <proj ect key> <reviewer 1> <reviewer_2>...
<r evi ewer _n>

Fi x a bug +review CR-TEST @ cage @khan
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Notes The command will create a new review in PROJ and add the users jcage and skhan to the
review. The review will be automatically started if reviewers are specified.

Note that you cannot add reviewers to existing reviews using Smart Commits.

Update a review

Description Iteratively add new code changes to a review

Syntax <conmit nessage> +revi ew <review key>
Example I mpl enent rework on past work +review CR-TEST-123
Notes Often, reviews require rework and changes in response to comments left by the team.

When committing these changes, adding the review key will iteratively add these new
changes to the review.

Note that:

® Each commit command in the Smart Commit must not span more than one line (i.e. you
cannot use carriage returns). However, you can use multiple commands in the same
commit message, and these can be on the same line.

® Creating a review in Crucible using a Smart Commit requires that the author of the
changeset has already been mapped to a Crucible username. See 'Author mapping’' on
Changing your user profile.

Advanced examples

Multiple commands on a single issue

Syntax <| SSUE_KEY> #<COWAND_1> <optional COVMAND 1_ARGUMENTS> #<COVMAND 2>
<optional COVWAND 2 ARGUMENTS> ... #<COWAND n> <opti onal
COVVAND_n_ ARGUMENTS>

Commit  JRA-123 #tine 2d 5h #comment Task conpl eted ahead of schedul e
message #resol ve

Result Logs 2 days and 5 hours of work against issue JRA-123, adds the comment 'Task completed
ahead of schedule’,
and resolves the issue.

Multiple commands over multiple lines on a single issue

Syntax <| SSUE_KEY> #<COWAND_1> <optional COVMAND 1 ARGUMENTS> #<COVMAND 2>
<optional COVWAND 2 ARGUMENTS> ... #<COWAND n> <opti onal
COVWAND_n_ ARGUVMENTS>

Commit  JRA-123 #comment |Imagine that this is a really, and |

message .
mean really, long conmrent #time 2d 5h
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Result Adds the comment 'Imagine that this is a really, and I', but drops the rest of the comment. The
work time of 2 days and 5 hours is not logged against the issue because there is no issue key
for the #t i me command in the second line. That is, each line in the commit message must
conform to the Smart Commit syntax.

This example would work as expected if set out as:

JRA- 123 #conment I magine that this is a really, and | nean really,
| ong conment

JRA-123 #tine 2d 5h

A single command on multiple issues

Syntax <| SSUE_KEY1> <| SSUE_KEY2> <| SSUE_KEY3> #<COMMAND> <opt i onal
COMVAND_ARGUMENTS> et c

Commit JRA- 123 JRA-234 JRA- 345 #resol ve
message
Result Resolves issues JRA-123, JRA-234 and JRA-345.

Multiple issue keys must be separated by whitespace or commas.

Multiple commands on multiple issues

Syntax <l SSUE_KEY1> <I| SSUE_KEY2> ... <I|SSUE_KEYn> #<COWAND 1> <opti onal
COVWAND 1 ARGUMENTS> #<COVMAND 2> <optional COVMAND 2 ARGUMENTS> . ..
#<COMWAND _n> <optional COVMAND n_ ARGUMENTS>

Commit  JRA-123 JRA-234 JRA-345 #resolve #tine 2d 5h #comment Task conpl et ed
message ahead of schedul e

Result Logs 2 days and 5 hours of work against issues JRA-123, JRA-234 and JRA-345, adds the
comment
"Task completed ahead of schedule' to all three issues, and resolves all three issues.

Multiple issue keys must be separated by whitespace or commas.

Get Smart Commits working

Your FishEye administrator must have:

® Enabled Smart Commits in FishEye. See Enabling Smart Commits.
® Configured an application link between FishEye/Crucible and JIRA Software. See Linking to another
application.

Note that:

® Smart Commits only support the default JIRA Software issue key format (that is, two or more
uppercase letters, followed by a hyphen and the issue number, for example BAM-123).

® Smart Commits don't provide for field-level updates in JIRA Software issues.

®* When using Smart Commits you can use linkers that create a hyperlink to the JIRA Software issue.
See Linkers for more information.

® |f there are any errors during the processing of Smart Commits, they will be logged to FishEye's error
console, as well as emailed to the actioning users. Speak to your FishEye administrator about Configu
ring SMTP.
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If the application link is configured as OAuth
If the application link to JIRA Software is configured to use OAuth, the committing user must
authenticate with JIRA Software before any Smart Commit will work with JIRA Software.
~ Click to see how to authenticate with JIRA Software...

1. Create a test review in FishEye.

2. Log in as the committing user.

3. Open the review and click Edit Details.

4. Enter a JIRA Software issue key for 'Linked Issue' and click Link. You'll be prompted to
authenticate.
Do this for every committing user (there's no need to create a new review, just link the
review to any JIRA Software issue).

el

Changing your user profile

You can change FishEye (and Crucible) settings such as password, notifications, profile image and display
settings.

To change your FishEye settings:

1. Log into FishEye.
2. Choose Profile settings from the User Menu (with your avatar) at the top of the screen.
3. Update your user settings as required. Each tab is described in more detail below.
4. Click Close.
On this page:

Display settings
Profile and email
Change password

Display settings

OAuth authentication
Author mapping
Watches
Reviews

Display File history  Defaultis Logical.

Settings view mode  In Subversion repositories, FishEye is able to show all operations on a single
logical file spread across a number of physical paths - i.e. operations in different
branches. When this is set to Logical, FishEye will show all the operations
across all branches. In Physical mode, only the operations related to the
physical path whose history is being viewed are shown.

Timezone Default is the timezone of the FishEye server.

Changelog Changesets The default is 30 per page.

per page

Always Default is Yes.
expand

changesets

in stream

Diff view Diff mode Default is Unified.

Line Default is None i.e. long lines will never word-wrap. Soft is when long lines will
wrapping word-wrap.

Context Default is 3. The number of lines to show (for context), if the diff contains more
lines than three lines of code.
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Source Tab width Default is 8. Can be changed to a number between 1 and 10.
view

Profile and email

Email Display Name displayed for the user currently logged in.
settings Name

Email The address to which all email notifications will be sent.

Address

Email Default is Text. Can be sent as HTML.

Format
Email Send The frequency at which emails will be sent for watch notifications. Immediately is
watches Watch the default value. Daily sends a summary of changes.

Emails
Profile Choose Upload an avatar image of your choice. This image will be displayed next to your
Picture  picture username throughout FishEye/Crucible.

Accepted formats are JPG, GIF and PNG. Image file size limit is 2Mb. Images will
be automatically cropped on upload.

This is disabled if avatars are served from an external server — see Configuring
avatar settings.

Change password

Change your password from this tab, if required. Please note that passwords are case-sensitive.

I'. This tab is not displayed if your FishEye instance is connected to an external LDAP authentication source,
such as LDAP. You will need to contact your administrator for assistance.

OAuth authentication

Configure your OAuth settings on this page. You can choose to allow gadgets/applications to access FishEye
data using your account.

Read more about Linking to another application.

Author mapping

The Author Mapping tab allows you to make an association between you (as a logged-in user) and a
committer, for each repository.

This is only necessary if the name or email of the user within FishEye is different from the committer name or
email within the repository. By default, FishEye will automatically match users to committers where it can.

Note that FishEye/Crucible administrators can control whether author mapping is available. See Configuring
user managed mappings.

Watches

By adding a 'watch’, you can ask to receive emails about changes made to the repository. Any watches that you
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have set up in FishEye/Crucible will be displayed on this tab. You can watch the dashboard activity stream, chan

gelogs and repositories. Watching an activity stream/repository allows you to receive emails when updates
occur. Note, the option to add a watch may only be available if the administrator has enabled watches for the

repository.

You can delete any of your watches by clicking Delete next to the watch.

Reviews

This functionality is used by Crucible.

If the SMTP server is set up, then you will receive emails when different actions occur within Crucible.

You can change the options described below, to specify the stages at which emails will be sent.

Auto-mark
files as 'read’

Review
Notifications
Events

Default is Yes.

State change

Comment added

Comment reply

added

Participant
finished

General message

File revision added

Uncomplete
review if defect is
raised:

Uncomplete
review if revision
is added:

My actions

Default is Immediate. A Crucible review moves through different state

s e.g: 'Draft’, 'Under Review'. An email is sent when the state changes.

Default is Immediate. An email is sent when a comment is added to a
review.

Default is Immediate. An email is sent (to the Moderator only) when
any reviewer has completed their review.

Default is Immediate. An email is sent when a reviewer is added or
removed from a review, after it has gone into the 'Under Review' state.

Default is Immediate. An email is sent when a reviewer is added or
removed from a review, after it has gone into the 'Under Review' state.

Default is Immediate.
Default is Yes. This allows reviews to be resurrected automatically to

deal with new code or defects.

Default is Yes. This allows reviews to be resurrected automatically to
deal with new code or defects.

Default is No. If set to Yes, an email is sent every time you perform an
action on a review.

Batch Notifications will be sent out by Crucible every 30 minutes. All notifications will be rolled up into
a single digest e-mail.
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Profile settings

Display Settings
Display Settings pay g

File history view mode: (") Physical @ Logical
Profile & Email v Y O Log
_ o Timezone: Default (Etc/UTC)
Authorized Applications
Changelog

Author Mappin
pping Changesets per page: 30

Watch
aienes Always expand changesets

Favourites in streams: ) Yes @ No
Review settings Diff view
Tools Diff mode: @ Unified " Side-by-side
Line wrapping: @ None ) Soft
Context lines: | 3
Source view
Tab width: g
IDE Connector
Enable IDE icons: @ Yes
Port number: 51235
JIRA Servers

Ignored Servers: None

Re-setting your password

If you need to reset your password, FishEye has a mechanism to generate a new password and send it to the
email address in your profile.

To reset your password:

1. On the log in screen, click Unable to access your account?.

2. Enter your username or email address and complete the Captcha step. An email will be sent to the email
address specified in your profile.

3. Click the link in the email.

On the resulting web page, you will see the message 'A new password has been sent to your account." An email
will arrive in your inbox, containing your new password.

0 If you receive a password-reset email that you did not request, simply disregard it to continue using your
current password.

Pattern matching guide

FishEye supports a powerful type of regular expression for matching files and directories (same as the pattern
matching in Apache Ant).

These expressions use the following wild cards:

?  Matches one character (any character except path separators)
* Matches zero or more characters (not including path separators)

**  Matches zero or more path segments.

Remember that Ant globs match paths, not just simple filenames.

¢ |f the pattern does not start with a path separator i.e. / or \, then the pattern is considered to start with / **
/.
* |f the pattern ends with / then ** is automatically appended.
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® A pattern can contain any nhumber of wild cards.

Also see the Ant documentation.

Examples

* txt Matches / f 0o. t xt and/ bar/f oo. t xt
butnot/f oo.txty or/bar/foo.txty/

[* txt Matches / f 0o. t xt
but not / bar/ f oo. t xt

dirl/file.txt Matches/dirl/file.txt,/dir3/dirl/file.txt and/dir3/dir2/dirl/file.
t xt

**/dirl/file.txt Same as above.

[**[dir1/file.txt Same as above.

[dir3/**/dirl/file.txt Matches/dir3/dirl/file.txt and/dir3/dir2/dirl/file.txt
butnot/dir3/file. txt,/dirl/file.txt

/dirl/** Matches all files under / di r 1/
/dir1* Matches all filesas/dir11,/dir12,/dir12345 and so on.
/dir?? Matches all filesas / di r 11,/ di r 22 and so on, replacing just 2 characters.

Date expressions reference guide

FishEye supports a wide variety of date expressions. A date has the two possible general forms:

* DATE[ +- ] TI MEZONE] +- | DURATI ON, or
* DATECONSTANT][ +- ] DURATI ON.

The TI MEZONE and DURATI ON parts are both optional.

TI MEZONE can be an offset from GMT HHMMor HH: MM or simply the letter Z to denote GMT. If no timezone is
given, the FishEye server's configured timezone is used.

DATE can be either of the following:

YYYY- MM DDThh: nm ss = Specifies a time and date (separated by a T). The seconds part may contain a
fractional component. A/ can be used instead of - as a separator.

YYYY- M DD Specifies 00:00:00 on the given date. A / can be used instead of - as a separator.

DATECONSTANT can be any of:

now This very instant (at the time the expression was evaluated).

t oday The instant at 00:00:00 today. (server-time* or GMT)

t odaygnt

t hi sweek The instant at 00:00:00 on the first day of this week. Sunday is considered the first day.

t hi sweekgnt (server-time* or GMT)

t hi smont h The instant at 00:00:00 on the first day of this month. (server-time* or GMT)
t hi smont hgmt
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t hi syear The instant at 00:00:00 on the first day of this year. (server-time* or GMT)
t hi syear gnt
* The timezone used for server-time is part of the FishEye configuration

The syntax for DURATION is similar to the XML Schema duration type. It has the general form
PnYnMnDTnHnMnS. See Section 3.2.6 of the XML Schema Datatypes document for more details.

Examples
2005-01-02 The start of the day on January 1, 2005 (server's timezone)
2005- 01- 02- 0500 The start of the day on January 1, 2005 at GMT offset -0500 (New York)

2005- 01-02T12: 00: 00Z Midday, January 1, 2005 GMT

t oday- P1D Yesterday (start of day)

t oday+P1D Start of tomorrow

t hi snont h- P1M Start of last month

t hi syear +P1Y Start of next year

now PT1H One hour ago

now+PT1H2M3S One hour, two minutes and three seconds from now

EyeQL reference guide

FishEye contains a powerful query language called EyeQL. EyeQL is an intuitive SQL-like language that allows
you to write your own specific queries. See examples.

EyeQL allows you to perform complex searches either within the Advanced Search or incorporated in scripts
when programming the FishEye API.

query: select revisions
(from (dir|directory) word)?
(where clauses)?
(order by date (asc | desc)?)?
Notes: asc produces 'ascending order'.
desc produces 'descending order".
(group by (file|dir|directory|csid|changeset))?
(return return-clauses)?
(limit limit-args)?

clauses: clause ((or|and|,) clause)*
Notes:
and binds more tightly than or.
') (comma) means 'and'.
clause: ( clauses)

not clause

path (not)? like word
Notes:
word is an Antglob.
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path = word

Notes:

Defines an exact path without wildcards or variables. path must represent a
complete (hard-coded) path.

path != word

Notes:

Defines an exact path exclusion without wildcards or variables. path must represent
a complete (hard-coded) path.

datein ( (| [) dateExp, dateExp () |]1)
Notes: The edges are

inclusive if [ or] is used.

exclusive if ( or) is used.

date dateop dateExp
Notes:
dateopcanbe <, >, <=, >= = == or !=.

author = word
author in (word-list)

comment matches word
Notes:
Does a full-text search.

comment = string

Notes:

Matches string exactly.

Most comments end in a new line, so remember to add \ n at the end of your string.

comment =~ string
Notes:
string is a regular expression.

content matches word

Notes:

Does a full-text search.

At this time searches are restricted to HEAD revisions.

(modified|added|deleted)? on branch word

Notes:

Selects all revisions on a branch.

modified excludes the branch-point of a branch.

added selects all revisions on the branch if any revision was added on the branch.
deleted selects all revisions on the branch if any revision was deleted on the branch.

tagged op? word

Notes:

opcanbe<, > <=, >= = ==or !=,

op defaults to == if omitted.

These operators are 'positional' and select revisions that appear on, after, and/or
before the given tag.

between tags tag-range

after tag word

before tag word
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is head (on word)?
Notes:
This selects the top-most revision on any branch, if no branch is specified.

is (dead | deleted )

Notes:
Means the revision was removed/deleted.
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tag-range:

word:

string:

dateExp:

return-clauses:

return-clause:

is added
Notes:
Means the revision was added (or re-added).

csid = word
Notes:
Selects all revisions for the given changeset ID.

p4:jobid = word
Notes: finds revisions whose Perforce jobid is word.

p4:jobid =~ word
Notes: finds revisions whose Perforce jobid matches regex word.

reviewed
Notes: (applies to Crucible reviews) alias for in or before any closed review.

(in | before | in or before) review word
(in | before | in or before) any (review states)? review

Notes:

word is a review key.

in selects reviewed revisions. If a review contains a diff, then only the most recent
revision is considered in the review.

before selects all revisions in a file prior to the revision in the review.

review states is a comma-separated list of open, closed, draft.

((|[) T2l:word, T2:2word ()| 1)
Notes:
A range of revisions between those tagged T1 and T2.
The edges are:
inclusive if [ or] is used.
exclusive if ( or) is used.
You can mix edge types. These are all valid: (T1, T2),[T1, T2],(T1, T2] and [ T1
, T2).

Having trouble with Subversion tags? See How tags work in Subversion for more
information.

Any string, or any non-quoted word that does not contain white space or any other
separators.

A sequence enclosed in either " (double quotes) or' (single quotes).

The following escapes work: \* \" \n \r \t \b \f.

Unicode characters can be escaped with \ uXXXX.

You can also specify strings in 'raw' mode like r " f 00" . (Similar to Python's raw
strings. See Python's own documentation).

See our Date expressions reference guide for more information on date formats.

return-clause (, return-clause)*
A return clause signifies that you want control over what data is returned/displayed.

(path | dir | directory | revision | author | date | comment | csid | isBinary | totalL
ines | linesAdded | linesRemoved | isAdded | isDeleted | isCopied | isMoved | ta
gs | reviews | aggregate)

(as word )?

The attribute to return, optionally followed by a name to use for the column.

Notes: reviews applies to Crucible reviews.
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aggregate-return-field:  ( count(revisions ) | count( binary-field ) | count(distinct other-field ) | sum( numeri
c-field ) | average( numeric-field ) | max( numeric-field ) | min( numeric-field ) )

The aggregate field to return.
Notes:

binary-fields are isBinary, isAdded, isDeleted, isCopied, isMoved. e.g. count(isA
dded) will return the number of added files.

numeric-fields are totalLines, linesAdded, linesRemoved.

other-field can be path, dir, author, date, csid, tags or reviews. e.g. count(distinct
path) will return the number of unique paths. count(distinct tags) will return the
number of unique tags.

If a gr oup by is given, give sub-totals for each group.
With no gr oup by clause, you can have:

® return normal columns
® ret urn aggregates

With a group by changeset | csi d clause:

® return normal columns
® return csid, conment, date, author, aggregates

With agroup by fil e| path clause:

® return normal columns
® return path, aggregates

With agroup by dir]|directory clause:

® et urn normal columns
® return dir, aggregates

i.e. The EyeQL can contain a returns clause that contains all non-aggregate
columns, or all aggregate columns.

Non-aggregate and aggregate columns can only be mixed if the columns are unique
for the grouping.

limit-clause: (length | offset, length | length offset offset )

Notes: Limits the number of results to return. offset specifies the starting point of the
truncated result set and length specifies the set length. offset is zero-based.

Examples

The following examples demonstrate using EyeQL to extract information from your repository.

Find files removed on the Ant 1.5 branch:
sel ect revisions where nodi fied on branch ANT_15 BRANCH and is dead group by
changeset

As above, but just return the person and time the files were deleted:
sel ect revisions where nodified on branch ANT_15 BRANCH and is dead return path,
aut hor, date

Find files on branch and exclude delete files:
sel ect revisions where nodi fied on branch ANT_15 BRANCH and not is del eted group by
changeset

Find changes made to Ant 1.5.x after 1.5FINAL:
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sel ect revisions where on branch ANT_15 BRANCH and after tag ANT_MAI N_15FI NAL group
by changeset

Find changes made between Ant 1.5 and 1.5.1:
sel ect revisions where between tags (ANT_MAI N 15FI NAL, ANT_151 FI NAL] group by
changeset

As above, but show the history of each file separately:
sel ect revisions where between tags (ANT_NMAI N 15FI NAL, ANT_151 FINAL] group by file

Find Java files that are tagged ANT_151_FINAL and are head on the ANT_15_BRANCH: (i.e. files that
haven't changed in 1.5.x since 1.5.1)

select revisions fromdir /src/min where is head and tagged ANT_151 FI NAL and on
branch ANT_15 BRANCH and path |like *.java group by changeset

Find changes made by conor to Ant 1.5.x since 1.5.0:
sel ect revisions where between tags (ANT_NMAI N 15FI NAL, ANT_154] and aut hor = conor
group by changeset

Find commits that do not have comments:
select revisions fromdir / where comment = "" group by changeset

Find the 10 most recent revisions:
sel ect revisions order by date desc limt 10

Find the 5th, 6th & 7th revisions:
sel ect revisions order by date limt 4, 3

Find commits between two dates:
sel ect revisions where date in [2008-03-08, 2008-04-08]

Find revisions that do not have any associated review:
sel ect revisions where (not in any review)

Return number of matched revisions, the number of files modified, authors who modified code,
changesets, tags, and reviews:

sel ect revisions

where date in [ 2003-10-10, 2004-12-12 ]

return count(revisions), count(distinct path), count(distinct author),
count (di stinct csid), count(distinct tags), count(distinct reviews)

As Sub-totals for each distinct changeset, Return csid, the author, date, comment, number of matched
revisions, the number of files modified, the lines added/removed:

sel ect revisions

where date in [ 2003-10-10, 2004-12-12 ]

group by changeset

return csid, author, date, comment, count(revisions), count(distinct
pat h), sun(linesAdded), sum(linesRenoved)

For each matched file, return the file name, number of matched revisions, the lines added/removed:

sel ect revisions

where date in [ 2003-10-10, 2004-12-12 ]

group by file

return path, count(revisions), sun(linesAdded), sumn(linesRenoved)

Show all the changesets that are not in or before any closed review:
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..............................................................................................................................................................................

sel ect revisions

fromdir /

where not revi ewed

group by changeset

return csid, author, count(revisions), conment

..............................................................................................................................................................................

sel ect revisions

where not in any closed review and not in any open review
group by changeset

return path, revision, author, date, csid, reviews

Integrating FishEye with Atlassian applications
You can integrate FishEye with the following Atlassian applications:

When FishEye is integrated =~ When a JIRA application is
with a JIRA application you  integrated with FishEye, you can:

a%a o
w ' ® View an issue's FishEye
® Use smart commits to changesets
transition JIRA issues ® Add the FishEye Charts Gadget
. ® Delegate user and to your JIRA application dashbo

group management to ard

the JIRA application ® Add the FishEye Recent
Changesets Gadget to your
JIRA application dashboard

® View an issue's Crucible reviews

* Transition JIRA applicati ® Add the Crucible Charts Gadget

on issues

When Crucible is integrated
with JIRA, you can:

See Configuring development tools f
or detailed information.

When FishEye is used with Crucible, you can:

c = bl In FishEye:
ruc I E ® Use smart commits to create Crucible reviews, add reviews to

new reviews and update an existing review.
In Crucible:

®* When using lterative reviews in Crucible, you will be prompted
when a new version of a file is available.

® Files and changesets displayed in activity streams (e.g. the
dashboard activity stream) render as links to the relevant
files/changesets.

® See your content roots and repositories associated with
projects.

® See repository lists and browse repositories using the Files tab

® View charts or code metrics.

See Crucible and FishEye.
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= When FishEye is integrated with Bitbucket Server:
9 Bitbucket

® You can easily add Bitbucket Server repositories to FishEye
with a single click. Once added, the repository behaves just like
a native repository in FishEye, so your team gets all the
benefits of FishEye indexing, browsing and searching.
Furthermore, the repository becomes available to Crucible, so
you can perform in-depth code reviews for changes in the
repository.

® A push to a Bitbucket Server repository that has been added to
FishEye automatically triggers FishEye to run an incremental
index. You don't have to configure polling for new commits, or
set up dedicated FishEye web hooks in your Bitbucket Server
instance.

See:

® |ntegrating Crowd with Atlassian FishEye
w l rOWd ® |ntegrating Crowd with Atlassian Crucible

When FishEye is integrated with your Bamboo continuous
e integration server, you can view the code changes that triggered a
& i B m h build. When a build fails due to a compilation error or failed test,
".. ‘-' a oo you can explore the failed build in FishEye and jump directly into
the changeset that broke the build. You can view the history of that
changeset to see what the author was trying to fix, take advantage

of the the side-by-side diff view to analyze the change and then
open the correct files in your IDE.

For more details see Viewing the Code Changes that Triggered a
Build.

JIRA Integration in FishEye

When FishEye is integrated with JIRA Software, you and your team get all the benefits described on this

page. Go straight to Linking FishEye to JIRA Software if you want to connect FishEye to a JIRA Software
server.

You can also use JIRA Software for delegated management of your FishEye users. See JIRA and Crowd
authentication.

See Configuring development tools for the full story of how Atlassian tools work together to give you a fast
and guided software development process.

Starting in JIRA 6.2.2 the Source and Reviews tabs are only displayed if JIRA Software is unable to
display the associated information in the Development Tools panel.

Related pages:

® Linking FishEye to JIRA Software
® Enabling Smart Commits

Your user tiers don't need to match between JIRA Software
and FishEye/Crucible in order to integrate them. JIRA Soft
ware users that are not FishEye users will see the same
view as FishEye users within JIRA Software, but will not be
able to log in to FishEye to view the source/reviews.
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Check development progress of a version in JIRA Software FISHEVYE 3.3+

JIRA 6.4+

The Release Hub in JIRA Software shows the relevant issues and development information for a version

— so you can determine which issues are likely to ship at a glance. With JIRA Software and FishEye
connected, the release page can warn you about potential development issues that could cause problems for
your release.

Version 2.0 (UNRELEASED
Start: 03/Nov/14  Release: 15/Feb/15 Release Notes

4 8 2 7 Issues in 262 Issues Issues Issues
Warnings version done in progress to do

Unreviewed Code
These issues have been marked complete but the commits are not part of a pull request or review.

1-40f4

1-40f4

Warnings indicate when the status of a JIRA issue doesn't reflect related development activity. For example: an issue marked complete that has an open pull request should be marked as still being in progres

P T Key Summary Assignee

® O SSP-1663 Ulis notloading in IE8 a Andrew Swar
® [ SSP-1979  Incorrect permissions for new report a Andrew Swar
+ [l SSP-1555 As adeveloper, | want to view the build status for an issue ﬁ Bruce Temple
+ [ SSP-1660 Missing error message when Bamboo is unavailable Eduardo Soal

From the Release Hub you can also:

Release a version

Mark a version as complete

Move incomplete issues to other versions

Trigger release builds (if JIRA is connected to Bamboo)

Warnings that help you reconcile what is happening in development with JIRA Software data.

To view the Release Hub (with the project sidebar enabled), navigate to a project, click on Releases, then
select a version listed. See Checking the progress of a version for more detailed information about using the
Release Hub in JIRA Software.

See in JIRA Software the FishEye repository branches related to an FISHEYE 3.3+

issue JIRA 6.2+

For FishEye 3.3 and later, the FishEye repository branches related to a JIRA Software issue are summarized
in the Development panel for the issue, when JIRA Software and FishEye are connected with an application
link. To see details of the branches, simply click the branches link. You can see which repository each
branch is in and when the last commit was made. As long as the issue key is included in the branch name
the branch is automatically linked to the JIRA Software issue.
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FUSE-601: 2 branches

Bitbucket 1 FishEye / Cru

Repository

FE-hg

cible ©1

Branch

Ir 3.3-FUSE-601-more-commit-details

Last commit

1013418

See in JIRA Software the commits related to an issue

For FishEye 3.3 and later, the FishEye repository commits related to a JIRA Software issue are summarized
in the Development panel for the issue, when JIRA Software and FishEye are connected with an application
link. You can click the commits link to see detailed information such as who made each commit, when they

FISHEYE 3.3+
JIRA 6.2+

commited, and how many files were changed. Click through to see a particular commit in the FishEye

instance where the commit was made. A developer only needs to add the issue key to the commit message
for that commit to be automatically linked to the JIRA Software issue.

FUSE-113: 62 unique commits (and 56 duplicates)

Bitbucket 40 FishEye / Cru

bamboo-git (atiaseye

Author Commit

9b9b83b
cfba88b
Jdeadid

2b68f%e

O

563fa3b

cible 56 Stash (22

)

FUSE-113 Functional tests

FUSE-113 FT for anonymous access

FUSE-113 post review

FUSE-113 post review

FUSE-113 post review

Ir55

181

1r81

2

1r81

Create

Reviews Date File
05/Dec/13 11:24 AM 8 fil

18/Nav/13 1:27 PM 3 fil

18/Nov/13 11:00 AM

18/Nov/13 11:00 AM

18/Nov/13 10:58 AM

1 fil

1 fil

1 fil

See the JIRA Software issues related to commits

FISHEYE 3.1+

FishEye recognizes JIRA Software issue keys, and displays those as links in places such as the activity

stream, side-by-side diffs, and ¢

ommit messages:
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JIRA Issue 'FECRU-3757"

FishEye Crucible Development / FECRU-3757
9_ Commit message searches query changed in 3.1

Close Issue = Restart Progress

Details

Type: Development Task Status: # To be reviewed

Priority: - Minor Assighee: ¥ Lukasz Pater [Atlassian]
Description

In 3.1 currently the guery entered in commit message search is used (for comments) as:

« aWildCard query for the whole string if it ends with a *
« a PhraseQuery to match an exact phrase in the commit message

Click on the linked issue key to see details for the issue, as described next.

See the details for JIRA Software issues FISHEYE 3.1+

Click a linked issue key anywhere in FishEye to see the details of that issue in a dialog. And you can click the
issue key at the top of the dialog to go straight to the issue in JIRA Software:

.'T Conor MacMeill
i ¥ [E] 77b0as6 changed 3 files 1’ 3.1-FECRU-3772-FixNativelnfoPath @ CR-FE-7755

FECRU-3772: Always determine the path from the URL and do it in one place consistently

Erendan Humphreys
» [El 245i6e1 changed 2 files Pa 1-FECRU-3771-fix-race-condition-in-repo-property-manager @ CR-FE-7756

FECRU-3771: use DML to remove property, avoiding race condition

75

Transition JIRA Software issues from within FishEye FISHEYE 3.1+

You can easily transition a JIRA issue from within FishEye. For example, when viewing a commit, you may
want to transition the related JIRA Software issue into QA. Click on a linked JIRA issue anywhere in FishEye

to see a dialog with the available workflow steps:

JIRA Issue 'CRUC-6942'

Crucible / CRUC-6942
K’ Review CLI| Tool should be able to

QA  Stop Progress = More ~

Details
Type: (7] Improvement
Priority: + Minor
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Click on a step in the dialog, and complete any displayed fields as required. If there are custom required
fields that are unsupported by FishEye, just click Edit this field in JIRA to transition the issue directly in
JIRA.

See issues from multiple instances of JIRA Software FISHEYE 3.1+

FishEye can link to more than one JIRA server at a time, so different teams can work with their own projects
in different JIRA Software instances, or a single team can link to issues across multiple JIRA Software server
s.

Integrating FishEye with Bitbucket Server

This page... Set it up... Bitbucket Server is...

... describes the benefits for ... with our short guide to help ... Atlassian's on-premise Git

you and your team, when FishEye admins connect repository management

FishEye is integrated with Bitb FishEye to Bitbucket Server. solution for enterprise teams.

ucket Server (formerly known Read about getting started

as Stash). with Git and Bitbucket Server.
Easily keep FishEye repositories synced with Bitbucket Server FISHEYE 3.5 +

STASH 3.1 +
Once you add a Bitbucket Server Git repository to FishEye, a push to
the repository automatically triggers FishEye to run an incremental index. You don't have to configure polling
to detect new commits, or set up dedicated FishEye web hooks in your Bitbucket Server instance.

A FishEye administrator only needs to set up an application link with Bitbucket Server for FishEye to be
ready to respond to 'refs changed' notifications published by Bitbucket Server.

Note that FishEye may not receive the notifications published by Bitbucket Server under some
circumstances, for example if FishEye is being restarted, or if there are intermittent network issues.
Therefore, we don't recommend disabling polling completely, but that the polling period be extended to 2
hours or even 24 hours, so FishEye can catch up with any missed events. See Updater.

Note also that Bitbucket Server was formerly known as Atlassian Stash.

Easily add Bitbucket Server repositories to FishEye FISHEYE 3.4 +

STASH 2.11.4 +

When FishEye is integrated with Bitbucket Server, a FishEye administrator can easily add Bitbucket
Server repositories to FishEye with a single click. Once added, the repository behaves just like a native
repository in FishEye, so your team gets all the benefits of FishEye indexing, browsing and searching.
Furthermore, the repository becomes available to Crucible (when integrated), so you can perform in-depth
code reviews for changes in the repository.

For detailed instructions for adding a Bitbucket Server repository to FishEye, see Adding an external
repository.

Transitioning issues in JIRA

Transition a JIRA Software issue from within FishEye in any of the following ways:

® Transition an issue automatically
® Transition an issue manually from FishEye
® Transition an issue with your commit message

Transition an issue automatically FISHEYE 3.5.2+
JIRA 6.3.3+

Your JIRA Software workflow can now respond to events in your linked
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development tools. For example, when a commit is pushed, your JIRA
Software workflow can be configured to automatically transition the related
issue. Configure this using triggers for transitions within the JIRA Software
workflow editor.

) In Progress
Information and advanced
configuration fgr the currently £ Edit | Delete transition
selected transition D
Properties (0)
QA KICKOFF [ A Triggers (2)
Conditions (1)
In Progress  IN PROGRESS {An ] Validators (0)
Post Functions (6)
Blue line indicates currently | (UGEUE ]
selected transition
QA DEMO { A |
El o

The events published by FishEye are:

® Commit created
® Branch created

A FishEye administrator can disable event publishing if required. See JIRA
workflow triggers.

Transition an issue manually from FishEye FISHEYE 3.1+

You can easily transition a JIRA Software issue from within FishEye. For example, when viewing a commit,
you may want to transition the related JIRA Software issue to the QA status. Click on a linked JIRA Software
issue key in FishEye to see a dialog with the available workflow steps:

JIRA Issue 'CRUC-6942'

Crucible / CRUC-6942
K’ Review CLI Tool should be able to

QA  Stop Progress  More ~

Details
Type: Improvement
Priority: + Minor

Click on a step in the dialog, and complete any displayed fields as required. If there are custom required
fields that are unsupported by FishEye, just click Edit this field in JIRA Software to go to JIRA Software to
transition the issue.

Transition an issue with your commit message FISHEYE 2.7+

Use Smart Commits when you are committing to a repository hosted in FishEye to transition JIRA Software
issues. Smart commits allow you to embed commands into your commit messages, which FishEye detects
and actions.

For example, if you include the following text in your commit message, FishEye will add the comment 'Task
completed ahead of schedule' and resolve the issue, when you perform your commit:
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.........................................................................................................................................................................

JRA-123 #comment Task conpl et ed ahead of schedul e
#resol ve

Read more about Using Smart Commits.

FishEye FAQ

FishEye FAQ

Answers to frequently asked questions about configuring and using FishEye.

® Top Evaluator Questions
How do | fix problems with indexing my repository?
How do | setup JIRA integration?
How do | setup LDAP or external user management?
How do | speed up slow CVS updates?
How do | start FishEye as a Windows service?
How do | view changesets and diffs?
How is FishEye licensed?
What kind of search capabilities does FishEye have?
® \What programming languages are supported?
® General FAQ
® About database encoding
About the Lines of Code Metric
Cannot View Lines of Code Information in FishEye
Finding your Server ID
How Do | Archive a Branch within Perforce
How do | Avoid Long Reindex Times When | Upgrade
Mercurial Known Issues
Ordering of Branches Important When Visualizing Git Changesets
Permanent authentication for Git repositories over HTTP(S)
Perforce Changesets and Branches
What SCM systems are supported by FishEye?
Automating Administrative Actions in Fisheye
®* How are indexing requests handled when they are triggered via commit hook
® |nstallation & Configuration FAQ
Can | deploy FishEye or Crucible as a WAR?
Does Fisheye support SSL (HTTPS)?
Improve FishEye scan performance
Migrating FishEye Between Servers
Setting up a CVS mirror with rsync
What are the FishEye System Requirements?
How to reset the Administration Page password in FishEye or Crucible
How Do | Configure an Outbound Proxy Server for FishEye
How to remove Crucible from FishEye 2.x or later
® How to run Fisheye or Crucible on startup on Mac OS X
® Licensing FAQ
® Are anonymous users counted towards FishEye's license limits?
® Restrictions on FishEye Starter Licenses
® Updating your FishEye license
® Git or Hg Repository exceeds number of allowed committers
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© Example EyeQL Queries
How do find changes made to a branch after a given tag?
How do I filter results?
How do | find changes between two versions, showing separate histories?
How do | find changes made between two version numbers?
How do | find commits without comments?
How do I find files on a branch, excluding deleted files?
How do I find files removed from a given branch?
How do | find revisions made by one author between versions?
How do | select the most recent revisions in a given branch?
® How do | show all changesets which do not have reviews?
® Integration FAQ
® How do I disable the Source (FishEye) tab panel for non-code projects?
®* How do | enable debug logging for the JIRA FishEye plugin?
® How do I uninstall the JIRA FishEye plugin?
®* How is the Reviews (Crucible) tab panel for the JIRA FishEye Plugin populated?
® What do | do if | discover a bug with the JIRA FishEye plugin?
C Subversmn FAQ
® Configuring Start Revision based on date
® Errors 'SEVERE assert' or '‘Checksum mismatch'
® FishEye fails to connect to the Subversion repository after a short time of successful
operation.
How can FishEye help with merging of branches in Subversion?
Subversion Changeset Parents and Branches
SVN Authentication Issues
What are Subversion root and tag branches?
Why do | need to describe the branch and tag structure for Subversion repositories?
Why don't all my tags show up in FishEye?
About merges in Subversion
* CVS FAQ
® How does FishEye calculate CVS changesets?
® How is changeset ancestry implemented for CVS?
® Support Policies
® Bug Fixing Policy
®* New Features Policy
® Security Bugfix Policy
® Troubleshooting
® After | commit a change to my CVS repository, it takes a long time before it appears in
FishEye.
FishEye freezes unexpectedly
I have installed FishEye, and the inital scan is taking a long time. Is this normal?
I have installed FishEye, but there is no data in the Changelog.
Initial scan and page loads are slow on Subversion
JIRA Integration Issues
Manually Generating a Thread Dump
Message 'org.tigris.subversion.javahl.ClientException svn Java heap space’
Problems with very long comments and MySQL migration
URLs with encoded slashes don't work, especially in Author constraints
Manually Generating a Thread Dump (Draft)
® All Repositories fail - Could not execute query (MySQL database)
® FishEye Developer FAQ
® Contributing to the FishEye Documentation
® FishEye Documentation in Other Languages
® FishEye Resources
® Glossary
® Collecting analytics for FishEye

Do you have a question, or need help with FishEye? Please create a support request.

General FAQ
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About database encoding

About the Lines of Code Metric

Cannot View Lines of Code Information in FishEye

Finding your Server ID

How Do | Archive a Branch within Perforce

How do | Avoid Long Reindex Times When | Upgrade — If reindexing your repository takes longer
than you can allow, you can use a temporary copy of your repository and FishEye instance to reduce
downtime during the reindexing process.

Mercurial Known Issues

Ordering of Branches Important When Visualizing Git Changesets

Permanent authentication for Git repositories over HTTP(S)

Perforce Changesets and Branches

What SCM systems are supported by FishEye?

Automating Administrative Actions in Fisheye

How are indexing requests handled when they are triggered via commit hook

About database encoding

It is possible to have files in your repository whose names differ only in case, e.g. Foo. j ava and f 0o. j ava.
Hence, your database will need to use rules for comparing string values which recognize that upper and lower
case letters are different, that is, the database should use 'case sensitive collation'.

If your database was originally configured to use case-insensitive and/or non-UTF8 collation, FishEye will
display the following message at the bottom of your screen:

| "Your database is not using a case sensitive UTF8 encoding for character fields." |

The following sections provide instructions for changing your database collation for each database type
supported by FishEye and Crucible.
On this page:

MySQL
Oracle
PostgreSQL
SQL Server

Related pages:

® Migrating to an external
database

MySQL

Please take a backup of your database before changing its collation.

To change your collation to ut f 8_bi n you need to change your database's default collation, but as this only
affects newly created tables you will also need to change the collation on the table for which case sensitivity is
critical.

Change your database's collation

Use the ALTER DATABASE command, as follows:

al ter database character set utf8 collate utf8_bin;

Change collation for the CRU_STORED_PATH table
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Use the ALTER TABLE command, as follows:

alter table cru_stored path convert to character set utf8 collate
utf8 bin;

Oracle

Oracle collation encoding must be configured when installing the database server. It cannot be configured on a
per database level. When installing Oracle, you should select the AL32UTF8 encoding.

PostgreSQL

Please take a backup of your database before changing its collation.

If you have created your PostgreSQL database with the incorrect encoding, you will need to dump your
database, drop it, create a new database with the correct encoding and reload your data.

You can do this using the standard database migration procedure — instead of migrating from HSQLDB to
PostgreSQL, you migrate from a PostgreSQL database with the incorrect encoding to one created with the
correct encoding.

SQL Server

Please take a backup of your database before changing its collation.

Unfortunately, changing the database collation for an existing SQL Server database (even using the ALTER
DATABASE ... COLLATE... statement) does not change the collation for existing objects stored in the database.
See http://blogs.msdn.com/b/gingsongyao/archive/2011/04/04/do-not-alter-database-collation-in-your-server.asp
x for an explanation of this.

The recommended route for changing the collation for SQL Server is to migrate to a new database that has the
correct collation configuration. You can do this using the standard database migration procedure — instead of
migrating from HSQLDB to SQL Server, you migrate from a SQL Server database with the incorrect collation to
one created with the correct collation.

The correct collation to use when you create the new SQL Server database is Latinl_General_CS_AS.
About the Lines of Code Metric

This page contains information about the Lines of Code metric and how it is processed and represented by
FishEye.

On this page:

Definition
Disadvantages
LOC in FishEye
User-Specific LOC

Definition

Lines of Code or LOC (also known as Source Lines of Code - SLOC) is a quantitative measurement in computer
programming for files that contains code from a computer programming language, in text form. The number of
lines indicates the size of a given file and gives some indication of the work involved.

LOC is literally the count of the number of lines of text in a file or directory. In FishEye, blank lines and comment
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lines are counted toward the total lines of code.

LOC for a file/directory is the total number of lines in the relevant files, while LOC for an author is the number of
lines blamed on that author. Neither of these should ever be less than zero. However, the change in LOC over
a period of time can be negative if there was a net reduction in the LOC over the period.

Disadvantages

While it can be useful, LOC has some well documented disadvantages. Keep these disadvantages and
limitations in mind when using LOC in your work environment.

In addition, the nature of branching in SCM applications means that calculating a LOC value for a whole project
is not possible. A naive summation of the LOC of all the branches will give a meaningless number that jumps
every time a branch is copied to create a new branch. Thus, in FishEye we usually look at the LOC of the trunk,
unless we can infer from the context that another branch is more appropriate.

LOC in FishEye

FishEye calculates the LOC for the trunk only. For SVN repositories it can calculate LOC for a branch if it is "trick
ed" to see the branch as part of the trunk. FishEye also calculates the LOC for each user, unless that facility is
turned off in the repository (see Store Diff Info). The LOC count will include all files except those identified by the
SCM as binary.

FishEye presents LOC data as charts of the change in LOC over time, and as informational statistics in various
places:

® Chart pages
The best way to explore the evolution of LOC in your project is the LOC chart report where you can easily
filter the LOC by branch, author, file extension and date range. Here you can investigate what caused a
particular spike in the LOC charts, or find the user whom has the most lines of code blamed on them and
how this has changed over time.

® Repository-specific activity pages
These show trunk LOC statistics for the repository, limited to the directory being viewed and its
subdirectories. The LOC charts show the LOC for the directory, using trunk LOC unless the directory can
be identified as a branch.

® User pages
Here, the statistics pane in the sidebar shows the trunk LOC blamed on the user for the all repositories
that have user-specific LOC enabled. The chart shows the trunk LOC from all the repositories that the
user has contributed to.

® The global User List page
This shows the trunk LOC for all users from the repositories that have user-specific LOC enabled.
Repository-specific user lists (in repositories that have user-specific LOC enabled) show the trunk LOC
for the users and committers, limited to the directory being viewed and its subdirectories.

® Project pages
This shows a chart of the LOC for all associated repository paths, and statistics include the trunk LOC for
those paths.

User-Specific LOC

The evolution of user-specific LOC over subsequent commits can appear at first glance to be counter-intuitive. It
is important to keep in mind that the LOC for a given user is the number of lines in the repository that were last
changed by them (as calculated by Fisheye).

A couple of simple examples:

® Alice adds a files with 30 lines to the SCM. Her LOC for this file is now 30. She then edits the file, deletes
10 lines and adds 20 (+20 -10). Her LOC is now 40, as is the LOC of the file.

® Alice adds a files with 30 lines to the SCM. Her LOC for this file is now 30. Now Bob edits the file, deletes
10 lines and adds 20 (+20 -10). Alice now has LOC of 20, because Bob deleted 10 lines that were blamed
on her, and Bob has LOC of 20, from the 20 lines he added. The total LOC is still 40.
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A user can have LOC on a branch that they have never committed on, if something that has been blamed on
them is copied. For example, a developer may have never committed to a particular branch, but FishEye may
still report a lot of LOC for them in that area.

One current limitation of FishEye's user-specific LOC calculation is the handling of merging. For example, if a file
has been changed on both trunk and branch, and the changes made on the branch are merged to trunk, the
changes made on branch will generally be blamed on the person who did the merge; not the person who made
the change.

Cannot View Lines of Code Information in FishEye

Symptoms

The LOC (Lines of Code) information in FishEye cannot be seen, for example in charts or when viewing the
statistics for a user.

@ see About the Lines of Code Metric for more information about the usage of the LOC (Lines of Code) metric
in FishEye.

Cause

There are four possible causes:

® LOC data will not be shown for users if the Store diff info setting is disabled. If a page is being viewed in
FishEye that relates to a particular user or committer, and the Store Diff Info setting is disabled, no LOC
information for the user will be visible.

® LOC data is currently not supported for Mercurial repositories.

® | OC data is currently not supported for Git repositories.

® The SVN repository is indexing branches only.

Resolution

Cannot view LOC information for specific users or committers:

® Enable the Store Diff Info setting for the repository in Admi ni stration > Repository Settings >
Reposi t ori es, click on the repository name, and then "SCM Details". A full re-index needs to be
performed on the repository after enabling this setting for FishEye to collect the diff information for all
revisions in the repository. Please note that the Store Diff Info setting is always enabled for CVS
repositories.

The SVN repository is indexing branches only:
® FishEye can calculate LOC for a branch if it is "tricked" to see the branch as part of the trunk.

Finding your Server ID
Your Server ID can be found in the FishEye administration area.

To find your Server ID:

1. Navigate to FishEye's administration area.
2. Click System Info (under 'System Settings').

The Server ID for your FishEye server is displayed in the 'License' section.
The Server ID should match the one set for your license. You can check this at http://my.atlassian.com.

How Do | Archive a Branch within Perforce

In SVN, a branch exists as a separate directory. However in Perforce, files are given a label to identify them as
belonging to the branch. Thus it may not be possible to download the branch as a tarball via FishEye.

You may be able to download the branch as a tarball, depending on your structure:

If it is not a single folder, then it is not possible to download the tarball in your perforce repository.
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In FishEye, navigate to your perforce repository.
In the Constraint section on the left, select the branch. This will return the directories that belong to that

branch.
If it is one single folder, download the tarball of it. Under constrai nt and sub directories,thereis

a panel tarball giving options on how to download the directory.

How do | Avoid Long Reindex Times When | Upgrade

Mitigating lengthy reindex times

If reindexing your repository takes longer than you can allow, you can use a temporary copy of your repository
and FishEye instance to reduce downtime during the reindexing process.

Most upgrades (even major ones) do not require a reindex. If a reindex is required, this will always be
explicitly mentioned in the Upgrade Guide for that release.

On this page:

® Mitigating lengthy reindex times
Reindexing with a temporary copy of your FishEye
instance
®* How to make a temporary copy of your FishEye
instance
®* How to make a temporary copy of your repository
®* How to reindex a single repository on a test server
® Upgrading your cross-repository index using a temporary
staging server

Reindexing with a temporary copy of your FishEye instance

This section describes how to perform a full reindex of a particular repository. Note that, depending on the
repository size, the reindex could take up to several days.

To reindex a temporary copy of your FishEye instance:

1.

2.

Make a copy of your FishEye instance to another server. See 'How to make a temporary copy of your
FishEye instance' below for instructions.
Upgrade the temporary FishEye, then start it up, connected to your repository. It will automatically begin
the scanning process.
0 If you are concerned about the repository being overloaded by the scanning process, you can make a
copy of that as well. See 'How to make a temporary copy of your repository' below for instructions.
If you do that, you must edit the conf i g. xm of your temporary FishEye instance to point to your
temporary repository.
The copied instance will run its course without affecting your production instance.

a. Shutdown both your servers completely.

b. Make a backup of your FI SHEYE_| NST directory.

c. Replace the FI SHEYE_| NST/ var / cache directory on live FishEye with the FI SHEYE_| NST/ var

/ cache from your test server.

d. Download the latest FishEye/Crucible from Atlassian downloads.

e. Follow the instructions in the Upgrade Guide to upgrade to the new version.
The scan of the temporary FishEye instance (and repository, if you copied that also) is complete. You're
now free to delete the temporary copy(s).

How to make a temporary copy of your FishEye instance

To make a copy of your FishEye instance, follow the instructions for Migrating FishEye Between Servers.

How to make a temporary copy of your repository
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To make a copy of your repository use rsync (for CVS repositories in the Linux environment) or svnsync docume
ntation (for Subversion only).

How to reindex a single repository on a test server

If you need to reindex your repository on your production system but don't want to burden your production
server, carry out the following steps:

1. Install another instance of FishEye on a test server (the same FishEye version as the one you are using).

2. Add a repository to FishEye with the exact same name and details as that referenced by the production
server.

3. Let it finish indexing. Go to Administration > View Repository List > Stop (shown next to the name of your
repository) and disable on both production and test.

4. Copy the FI SHEYE_| NST/ var / cache/ REPOdirectory from the test server over the FI SHEYE_| NST/ var/ ¢
ache/ REPOdirectory on the production FishEye.

5. Trigger a review revision data re-index: Administration > Repository > Maintenance > Review-Revision
Data Index.

@ For this procedure, neither server needs to be shut down.

Upgrading your cross-repository index using a temporary staging server

This section describes how to upgrade the cross-repository index for selected repositories. Note that, depending
on the repository size, the reindex will typically finish in a few hours, but should never take longer than a few
days.

In this procedure it is assumed that you have a production server (referred to as PROD in these instructions) that
is running a FishEye version earlier than 3.1, and a separate staging server (STAGING) that will be used to
perform the cross-repository index upgrade offline.

1. Make a live backup of the PROD server with the following options:
a. Repository and application caches
b. SQL database

You can do this either from the FishEye Admin area (go to Administration > System Settings > Backup
), or from a command line, for example:

$ ./bin/fisheyectl.sh backup -f ~/Docunents/backup.zip --no-upl oads
--no-tenpl ates --no-plugins --cache --no-ao

N

Install FishEye 3.1, or a later version, on the STAGING server.
3. Restore the backup of PROD to the STAGING server.
4. Start FishEye on the STAGING server. Note that:
® The cross-repository index upgrade will start automatically on the STAGING server. If you want to
perform the cross-repository index upgrade for selected repositories only, it is safe to remove
unwanted repositories from the STAGING server now, either by going to Administration > Reposi
tories, or by using REST endpoints (see below).
®* The STAGING server doesn't need to have access to configured SCM's as the cross-repository
upgrade task does not interact with them.
® You may want to disable polling on the STAGING server. You can either go to Administration > R
epository Settings > Defaults > Updater to disable polling for all repositories (although this will n
ot affect particular repositories that have been configured to ignore default settings), or go to Admi
nistration > Repository Settings > Repositories > Repository X > Updates to disable polling
for just Repository X. Disabling polling is not required, but will avoid logging errors to the FishEye
log file if the SCMs are not accessible from the STAGING server.
5. Wait for the cross-repository index upgrade to finish on the STAGING server. Check by going to Adminis
tration > Repositories.
Stop the STAGING server.
7. Make a full backup of the PROD server and then stop it.

o
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8. Install the same version of FishEye on the PROD server as used on the STAGING server (as in step 2
above).

9. Delete the following FishEye indexes on the PROD server and replace them with the equivalent caches
from the STAGING server. You can choose your preferred option to copy files between machines using
ssh/scp/rsync, possibly combined with tar/zip tools. The example below shows how the scp command
could be used:

ssh PROD

cd FISHEYE INST # replace FISHEYE INST with the |ocation of your

FI SHEYE | NST f ol der

rm-rf cache/ gl obal fe

rm-rf var/cache/repoX # repeat for each repository repoX that was
upgraded on STAGQ NG server

scp -r STAG NG STAG NG _FI SHEYE | NST/ cache/ gl obal fe cache/

scp -r STAG NG STAG NG _FI SHEYE | NST/ var/ cache/ repoX var/cache/ #
repeat for each repository repoX that was upgraded on STAGQ NG
server

10. Start the PROD server.
11. All the changesets that were added to SCMs after backing up the PROD server in step 1 will now be
indexed on the PROD server.

The only drawback with this procedure is that changeset comments added for changesets in PROD after step 1
will not get indexed, so they will not appear in the activity stream. There is no easy way to reindex them, apart
from fully reindexing each affected repository, which is what this procedure is intended to avoid. A new REST
endpoint could be implemented to address this (see

FECRU-3764 - new REST endpoint to reindex changeset comments for a repo | CLOSED| ),

Note: the following REST endpoint could be used to force a cross-repository index upgrade for a selected
repository: /rest-service-fecru/admin/repositories-v1l/repoX/reindex-search. There should be no need to use this,
but it may be useful if something goes wrong.

Mercurial Known Issues

® CRUC-3474: If afile is removed and then another file is copied or moved over the same file within one
commit, the ancestor revision is miscalculated and can result in errors in "diff to previous".

® CRUC-3470: Permission changes (and prop changes in repos converted from svn) may result in revisions
that have no ancestors - subsequent changes will consider it's parent revision to be their parent revision.

® CRUC-3468: Scanning repositories converted from svn (especially using hgsubversion) can result in
commits that take a long time to scan (due to the changes produced by merges from other branches).

Ordering of Branches Important When Visualizing Git Changesets

FishEye 2.6 introduced the repository commit graph. The commit graph allows you to visualize changesets in
their branches by showing them in configurable branch "swimlanes". One of the ways in which you can configure
the commit graph is by reordering the swimlanes. Reordering swimlanes is useful for non-Git repositories, if you
want to show branches in a certain order. However, ordering swimlanes is vital for Git repositories, as it is the
only way of determining which branch a commit is displayed in, when a commit belongs to multiple branches.

Git Branches and Changesets in FishEye

Before considering how Git repositories are visualized in the commit graph, it is important to understand how
FishEye relates Git changesets to branches.

In FishEye 2.6 and later, FishEye considers the ancestry of a Git changeset when determining which branch it is
a part of. Branches can effectively be considered as pointers to changesets. Hence, merging and branching can
change the branches that a changeset is considered part of.

For example, if a branch ‘fisheye-2.6' is merged back to the 'master' branch, then all changesets that were seen
as part of the 'fisheye-2.6' branch only will also be considered to be part of the 'master' (e.g. the changeset will
be seen as part of 'master' and 'fisheye-2.6' in the activity stream).
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Viewing Git Changesets and Branches in the Commit Graph

The previous section describes how a changeset can be associated with multiple branches, due to its ancestry.
Instead of showing the changeset in every branch swimlane on the commit graph, FishEye represents these
changesets as described below.

When you view the commit graph for a Git repository, FishEye works from the leftmost swimlane to the right
doing the following:

® For each swimlane, FishEye checks if the commit is in that branch. If the commit is in the branch, a dot is

shown representing the commit.
® |f the commit is not in the branch, the dot for the commit is moved to the next column on the right.

For example, if the 'master' swimlane is to the left of another swimlane, e.g. ‘'fisheye-2.6' branch, there will be no
changesets shown in the ‘fisheye-2.6' swimlane, as all the commits will be picked up in the 'master' swimlane.
However, if you move the ‘fisheye-2.6' swimlane to the left of the ‘'master’ swimlane, it will pick up all of the

FishEye 2.6 commits.

This allows you to visually isolate changesets in the desired branches by reordering the swimlanes. For
example, if you want to see the lineage of a branch, 'fisheye-2.6', but not ‘fisheye-2.5" after both branches have
previously been merged to 'master’, you could arrange your swimlanes to ‘fisheye-2.6', ‘master’, ‘fisheye-2.5'
from left to right. You will be able to see the ‘fisheye-2.6' changesets and where the merge back to 'master' was
made. The ‘fisheye-2.5' changesets will just be seen as part of the 'master’ branch.

Screenshots below: Example of how ordering swimlanes affects the branches that changesets are displayed on
(click to view full-size images)
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Permanent authentication for Git repositories over HTTP(S)

Currently, FishEye only supports HTTP or HTTPS for pushing and pulling from Git repositories. Git has no
method of caching the user's credentials, so you need to re-enter them each time you perform a clone, push or

pull.

Fortunately, there is a mechanism that allows you to specify which credentials to use for which server: the . net
r c file.

Warning!

Git uses a utility called cURL under the covers, which respects the use of the .netrc file. Be aware that
other applications that use curl to make requests to servers defined in your . net r c file will also now be
authenticated using these credentials. Also, this method of authentication is potentially unsuitable if you
are accessing your FishEye server via a proxy, as all curl requests that target a path on that proxy
server will be authenticated using your . net r ¢ credentials.

Warning!
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cURL will not match the machine name in your .netrc if it has a username in it, so make sure you edit
your . gi t/ confi g file in the root of your clone of the repository and remove the user and '@’ part from

any clone url's (url fields) that look like ht t ps: // user @machi ne. domai n. coni . . . so instead they
look like ht t p: / / machi ne. donai n. coni . . .

Linux or OSX

1. Create afile called . net r c in your home directory (~/ . net r c). Unfortunately, the syntax requires you to
store your passwords in plain text - so make sure you modify the file permissions to make it readable only

to you.

2. Add credentials to the file for the server or servers you want to store credentials for, using the format
below. You may use either IP addresses or hostnames, and you do not need to specify a port number,
even if you're running FishEye on a non-standard port.

machi ne fisheyel. myconpany.com
| ogi n myuser nane

password nypassword

machi ne fi sheye2. nyconmpany. com
| ogi n myot her user nane

password mnyot her password

3. And that's it! Subsequentgit clone,git pull andgit push requests will be authenticated using
the credentials specified in this file.

Windows

1. Create atext file called _net r ¢ in your home directory (e.g. c: \ user s\ kannonboy\ _netr c). Curl has
problems resolving your home directory if it contains spaces in its path (e.g. ¢: \ Docunents and
Set ti ngs\ kannonboy). However, you can update your %440OVE%environment variable to point to any
old directory, so create your _net r ¢ in a directory with no spaces in it (for example c: \ cur| - aut h\) th
en set your %10OVEY%environment variable to point to the newly created directory.

2. Add credentials to the file for the server or servers you want to store credentials for, using the format from
the Linux or OSX section above.

Perforce Changesets and Branches

Why does FishEye say this changeset is on more than one branch? Why does that changeset have multiple

parents?

Perforce allows a single changeset to include files on multiple branches, so FishEye marks those changesets as
being on all of the branches involved.

When a changeset is on multiple branches FishEye may consider it to have multiple parents from the different
branches.

FishEye does not track merges in Perforce, so merges are not shown in the graph.

Changeset branches and parents are only annotations at the changeset level --- the individual file revisions will
each only have a single branch and at most one parent.

What SCM systems are supported by FishEye?

To see the list of SCM systems that is supported by FishEye, see Supported platforms.
Automating Administrative Actions in Fisheye
With some command line scripting and a tool like wget, and Live HTTP Headers for firefox you can automate

actions. In this example, Fisheye will automatically rescan revision properties of an SVN when the commit
message is updated to reference a new JIRA issue.

1. Enable live HTTP headers in firefox, then perform the action you want to perform automatically via the
Fisheye Adminstration Ul.
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2. In the live HTTP headers window you should see some output similar to the following:
[ NN Live HTTP headers —

fHeaders | Generator Config About ]

HTTP Headers

http:/ ferdinger.sydney.atlassian.com/fisheye/admin/indexMaint.do

POST [fisheye/adminfindexMaint.do HTTP/1.1
Haost: erdinger.sydney.atlassian.com
User-Agent: Mozilla/5.0 (Macintosh; U; Intel Mac OS5 X 10.5; en-U5; nv:1.9.1.5) Gecko/20091102 Firefox/3.5.5
Accept: text/html,application/xhtm|+xml application/xml.g=0.9,*/*.q=0.8
Accept-Language: en-us,.en;q=05 m
Accept-Encoding: gzip,deflate
Accept-Charset: 1S0-8859-1,utf-8,9=0.7.%,9=0.7
Keep-Alive: 300
Connection: keep-alive
Referer: http:/ ferdinger.sydney.atiassian.com/fisheye fadmin/indexMaint-default.do?rep=2
Cookie: crucibleprefs1="D%3D1257476957691"; remember=amyers:16:fd7863ec0113e5762955467ec79c125a; FESESSIONID=19. ..
Content-Type: application fx-www-form-urlencoded
Content-Length: 39
startRev=1&endRev=2&rep=2&action=rescan

HTTP/1.x 200 OK

Date: Mon, 08 Nov 2009 00:15:10 GMT

Server: Server: Jetty(6.0.x)

Expires: Thu, 01 Jan 1970 00:00:00 GMT

Set-Cookie: remember=amyers:16:fd7863ec0113e5762955467ec79¢c125aExpires=Thu, 01 Jan 1970 00:00:00 GMT
Content-Type: text/html; charset=utf-§8

Content-Encoding: gzip

Keep-Alive: timeout=5, max=100

Connection: Keep-Alive

— - ~ i 5 -

] <>
(SaveAll...j [i Replav...:] ECapture ( Clear j [ Close j

3. The important parts are the URL I've highlighted above (http://erdinger.sydney.atlassian.com/fisheye/adm
in/indexMaint.do) and any GET/POST parameters (st art Rev=0&endRev=58&r ep=2&act i on=r escan

)

4. Now we can construct a script with wget to automate this:

P e i N e e o -

wget --keep-sessi on-cooki es --save-cooki es cooki e. t xt

htt p://erdinger.sydney. atl assi an. com fi sheye/ adm n/ | ogi n. do

- - post -dat a="ori gUr | =&adm nPasswor d=adni n"

wget --1oad-cooki es cookie.txt

- - post - dat a=" st art Rev=0&endRev=58&r ep=2&act i on=r escan"

htt p://erdinger.sydney. atl assi an. conl fi sheye/ adm n/i ndexMi nt . do

With that you could generate a post - r evpr op- change hook in svn that will update the repositories
automatically.

How are indexing requests handled when they are triggered via commit hook

The indexing requests are performed in order of receipt by the usual incremental indexing threads. If there is
already a pending request for indexing a particular repo, a subsequent request will be ignored.

Installation & Configuration FAQ
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FishEye Installation & Configuration FAQ

® Can | deploy FishEye or Crucible as a WAR? — Unfortunately FishEye and Crucible can not be
deployed as a WAR http://en.wikipedia.org/wiki/WAR_%28Sun_file_format%29.
Does Fisheye support SSL (HTTPS)?
Improve FishEye scan performance — Background information
Migrating FishEye Between Servers — This page describes the process for migrating FishEye
between servers.
® Setting up a CVS mirror with rsync — In situations where running FishEye on the same server as
your CVS repository is not practical or possible, you can use the Linux utility 'rsync' to mirror the CVS
repository contents onto the FishEye server.
What are the FishEye System Requirements?
How to reset the Administration Page password in FishEye or Crucible
How Do | Configure an Outbound Proxy Server for FishEye
How to remove Crucible from FishEye 2.x or later
How to run Fisheye or Crucible on startup on Mac OS X

Can | deploy FishEye or Crucible as a WAR?

Unfortunately FishEye and Crucible can not be deployed as a WAR. FishEye has some special needs for
performance reasons that are not easily supported on third-party containers. While this is an often requested
feature, there are no immediate plans to provide a WAR version of FishEye or FishEye+Crucible. However the
upcoming separate edition of Crucible (i.e. without FishEye) may at some stage be available as a WAR.

Does Fisheye support SSL (HTTPS)?

FishEye has built-in SSL support from FishEye 2.4 onwards. Read FishEye SSL configuration for more
information.

Improve FishEye scan performance
This page contains information about improving the performance of FishEye repository scans.

Background information

When you add a repository, FishEye needs to perform a once-off scan through the repository to build up its initial
index and cache. This scan can take some time. Until this scan is complete, you may find that some data is not
displayed. As a guide, FishEye should be able to process about 100KB-200KB per second on an averaged-size
PC. If FishEye is accessing the repository over the network (e.g. over a NFS mount), then you should expect the
initial scan to take longer.

General improvements
You can increase the speed of your scans using the following options:

® [f your repository is non-local, set up a local repository mirror on the FishEye server. This will provide a
major speed boost for anyone scanning a repository across a network.
® Exclude unused file types, unused directories and specific large files from FishEye.

Improve update performance during initial scan

One option is break large repositories into multiple smaller repositories. While this technique will not improve the
overall initial scan time, it allows for all fully scanned repositories to be updated while the initial scan is still being
performed on those remaining.

In FishEye 1.3.4 and later, the initial and incremental scans happen in separate, single threads. So, splitting the
repositories will allow incremental scans to run concurrently alongside the initial scans. You may also wish to
split projects into separate repositories, since permissions in FishEye are applied on a per-repository basis.

Improving initial scan performance for an SVN repository

svnsync is not an atomic protocol. It generally performs the commit as the svn sync user and then
updates the r evpr ops to match the original commit, under some circumstances, this can cause the
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wrong user to be attributed as the author of a changeset. More information available at Wrong User
Reported When Indexing SVN Mirror Repository.

The http/s protocol has the slowest performance during the initial scan. The svn protocol (svn://) is faster and the
file protocol (file:///) is the fastest.

Therefore if you find your initial scan takes an extended amount of time (more than a day or two), you should
consider switching over from the http/s protocol to the svn or file protocol to define the location of your SVN
repository. (Use svnsync to mirror the repository onto the fisheye server, so that you can access it with the file
protocol.)

E.g. Switch from

htt ps://exanpl e. coni svn/ proj ect/

to

svn: // exanpl e. com svn/ pr oj ect/

or

file:///home/user/some/l ocation/svn/project

In order for SVN protocol to work you need to have set up an svnserve based server.

More information on how to troubleshoot SVN indexing related issues can be found here.

Performance support

If you have implemented at least one of the suggestions above but are still experiencing slow performance, ask
us for help:

1. First read the Tuning FishEye performance document.

2. Turn on debug logging using the command line debug flag.

3. Allow FishEye to continue its initial scan overnight.

4. Create a new support request in the FishEye project, including your server environment and log files with
the problem description.

Migrating FishEye Between Servers
This page describes the process for migrating FishEye between servers.

If you have defined the FI SHEYE | NST environment variable, then upgrades and migrations of your FishEye
instance will be relatively simpler.

If you have defined FI SHEYE | NST

1. Shut down your current FishEye server completely.

2. Copy the FI SHEYE_| NST directory to your destination server.

3. Copy and set up all of your environment variables from your source server to your destination server
(remembering to set up your FI SHEYE | NST directory to point to the location where you copied the data
to in Step 2.

Install FishEye on your destination server.

Read the note about external databases below.

Start FishEye. It should pick up your environment variables, and from that access your FI SHEYE | NST di
rectory, which contains your configuration.

o0k

If you have not defined FI SHEYE | NST but would like to set it up

1) Shut down your current FishEye server completely.
2) Copy the following three items into to a new folder on your destination server (for example, fi sheye_i n
st):

® <FishEye installation directory>/config.xmn
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® <FishEye installation directory>/var
® <FishEye installation directory>/cache

3) Copy and set up all of your environment variables from your source server to your destination server. In
addition to this, set up the FI SHEYE_| NST environment variable as follows, replacing the / pat h/ t o/ fi sh
eye_i nst with the fully qualified path to the fi sheye_i nst folder you set up in Step 2:

export FlI SHEYE | NST=/ path/to/fi sheye i nst

4) Install FishEye on your destination server.
5) Read the note about external databases below.

6) Start FishEye. It should pick up your environment variables, and from that access your FI SHEYE | NST
directory, which contains your configuration. If you are using JIRA for User Management you might need to
update the whitelist of the corresponding application connector in JIRA with the IP address of the new
FishEye server to retain user authentication.

External Databases
If you are using an external database it must be accessible from the new server since the steps above
only include installing a new application and relocating your configuration data and repository indexes.

If you wish to migrate both the application, data, and your external database to a different server (e.g. to
create a development or test server) then you will need to make a copy of your external database and
update the confi g. xm file (depending on the setup, located in either <FishEye/Crucible installation
directory>/config.xml or FISHEYE_INST/config.xml) with the new database location prior to starting up
the instance. See Backing up and restoring FishEye data for more information.

Setting up a CVS mirror with rsync

In situations where running FishEye on the same server as your CVS repository is not practical or possible, you
can use the Linux utility ‘'rsync' to mirror the CVS repository contents onto the FishEye server.This is possible
because CVS data is stored in a reasonably simple form in the file system.

We recommend this to achieve best performance when FishEye and CVS cannot be hosted on the same
machine.

ﬂ This workaround requires the ability to SSH into both machines. Linux and Mac OS X operating systems
have rsync built in. For Windows, you will need to install rsync.

Diagram: A scenario where rsync is required
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CVS Server

FishEye Server

- CVS data is mirrored via rsync
@ - Cron job schedules rsync activity
- FishEye scans local mirror.

To set up a CVS mirror with rsync:

1.

2.

You will need to set up a local directory on the FishEye server for the mirrored CVS content, ensuring that
this server has ample disk space to store the current CVS database and any future space requirements.
We will refer to the CVS instance (on your CVS Server, ) as <CVS_HOMVE> and the new 'mirror directory'
(on your FishEye server) as <M RROR_HOVE>.

Type the following r sync command on the console at the command-line of the FishEye server:

...................................................................................................................................................................

...................................................................................................................................................................

rsync --backup user @vs_server:/ CVS server/path/to/instance
/ dat ast or e/ Fi shEye/ cvs-m rror

. Schedule the rsync command to run regularly with a cron job. Running hourly is a good default interval.

Under Windows, use a native task scheduler.

With the cron job active, you will have established rsync to run an hourly comparison of the two
directories and copy any changes across to the mirror directory as they occur. Note that running the rsync
process will impact the FishEye server's performance (and also the CVS server's) to a certain degree.

In the FishEye admin interface, add the local 'mirror directory' as a new CVS repository and run the initial
scan. As this is local data on the same file system, FishEye's scanning of this data will be optimal.

Adjust the FishEye Updater Full Scan period to one hour (the default is 15 minutes).

The rsync configuration is now complete. Monitor the disk space on both servers to ensure there is
adequate headroom for the mirroring process.

For more information on the syntax for rsync, visit the rsync home page.
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What are the FishEye System Requirements?

Visit the FishEye Supported platforms.
How to reset the Administration Page password in FishEye or Crucible

If you have forgotten or misplaced the password for the Admin page (htt p: / / <FECRU_URL>: <FECRU_PORT>
/ adni n/ adni n. do), you can reset it manually.

To manually reset the admin password, please edit your FI SHEYE | NST/ confi g. xnl file (make a backup as
well before editing).

You will see something like:

<?xm version="1.0" encodi ng="UTF-8"?>
<config control -bi nd="127.0.0. 1: 8059" version="1.0"
adm n- hash="352353256326369233A801FC3" >

To reset the password to "admin”, please change the admi n- hash value so that it appears as adni n- hash="
21232F297A57A5A743894A0E4A801FC3"

<?xm version="1.0" encodi ng="UTF-8"?>
<config control -bi nd="127. 0. 0. 1: 8059" version="1.0"
adm n- hash="21232F297A57A5A743894A0E4A801FC3" >

Restart Fisheye for this to take effect. You should now be able to access the FishEye Admin page (htt p: // <FE
CRU_URL>: <FECRU_PORT>/ admi n/ adni n. do) with the password "admin". Please change this password
immediately from the Admin area: click Change Admin password (under "Security Settings").

See also Best practices for FishEye configuration.

How Do | Configure an Outbound Proxy Server for FishEye

The Java Virtual Machine provides support for outbound proxy servers. To take advantage of this some
additional parameters need to be passed to the JVM via the FISHEYE_OPTS environment variable:

..............................................................................................................................................................................

export FlI SHEYE_OPTS="-Dhtt p. pr oxyHost =pr oxy. exanpl e. org
-Dhtt p. proxyPort =8080 -Dhtt p. nonProxyHosts=*.fo0o.coni | ocal host
- Dht t p. proxyUser =user nanme - Dhtt p. proxyPasswor d=passwor d"

See Environment variables for instructions on how to set these parameters.
How to remove Crucible from FishEye 2.x or later

Use the same process to remove FishEye and keep Crucible; just remove the FishEye license instead.

Want to know What happens if | decide to stop using FishEye with Crucible?

Remove Crucible from a FishEye installation

1. Go to the Admin area (choose Administration from your user menu) and click System Info (under
"System Settings").

2. Click Edit License (in the "License" section).

3. Remove the Crucible license from this screen:
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Support

Information
Mew licenses can be acquired from my.atlassian.com

Your Server ID is BT5B-TJIC-GVD6-69C7

Licenses

FishEye License

Crucible License

_/Upda[e\ Cancel

4. Click Update to save. Crucible will now be disabled and you will no longer see any reference to it in the
application.

How to run Fisheye or Crucible on startup on Mac OS X

This article is only provided as a guide and has only been tested on Mac OS X 10.5

launchd does not provide support for service dependencies so if you are using an external database,
this may not work for you. Fisheye assumes the database is available when it starts, and the startup
scripts will not wait for the database to become available.

You need to create a .plist file to create items that will start at boot time. Please refer to http://developer.apple.co

m/MacOsX/launchd.html for details.

Here is an example .plist that should work for Fisheye/Crucible:
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..............................................................................................................................................................................

<?xm version="1.0" encodi ng="UTF-8"?>
<! DOCTYPE plist PUBLIC "-//Apple//DTD PLI ST 1.0//EN'
"http://ww. appl e. coni DTDs/ PropertyList-1.0.dtd">
<plist version="1.0">
<di ct >
<key>Label </ key>
<string>com at | assi an. fi sheye</string>
<key>Pr ogr amAr gunent s</ key>
<array>
<string>/path/to/<Fi shEye install directory>/bin/run.sh</string>
</array>
<key>OnDemand</ key>
<fal se/ >
<key>RunAt Load</ key>
<true/>
<key>St andar dCut Pat h</ key>
<string>/path/to/ Fl SHEYE | NST/ var/| og/ fi sheye. out</string>
<key>St andar dEr r or Pat h</ key>
<string>/path/to/ Fl SHEYE | NST/var/| og/fisheye.out</string>
<key>Envi ronnent Vari abl es</ key>
<di ct >
<key>FI SHEYE | NST</ key> <string>/path/to/ Fl SHEYE_| NST/ </ stri ng>
<key>F|I SHEYE OPTS</ key> <string>-Xns512m - Xmx1024m
- XX: MaxPer nSi ze=128nx/ stri ng>

</ di ct >
</dict>
</plist>

Customize the / pat h/ t o/ FI SHEYE_| NST/ and / pat h/ t o/ <Fi shEye install directory>/ withthe
FISHEYE_INST and FishEye install directories respectively and make any required modifications to FI SHEYE_O
PTS. Save the file as com.atlassian.fisheye.plist and then try to load it with:

[anyers@rdi nger:fecru-2.1.3]% | aunchct! | oad
com at | assi an. fi sheye. pl i st
[amyers@rdinger:fecru-2.1.3]% launchctl start com atl assi an. fisheye

FishEye should now start up and you will be able to access it in your web browser.

Licensing FAQ

® Are anonymous users counted towards FishEye's license limits? — Users accessing FishEye
anonymously are, for all intents and purposes, unlimited users.

® Restrictions on FishEye Starter Licenses

® Updating your FishEye license

® Git or Hg Repository exceeds number of allowed committers

Are anonymous users counted towards FishEye's license limits?

The short answer is no. If you are using FishEye in your organization but most users require only anonymous
access (that is, you have not set access restrictions on the content in your repositories), then an unlimited
number of anonymous users can be accomodated regardless of the FishEye license you are using.

Users accessing FishEye anonymously are, for all intents and purposes, unlimited users.
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However, if your users require permissions and controlled access to specific content in your repositories, then
they will need to log in to FishEye. Hence, these users will need to create accounts and will be factored into the
license limit.

Restrictions on FishEye Starter Licenses

This page explains the limitations of the FishEye Starter license and provides general information about using
this license in production.

On this page:

® What is a Starter License?

What are the Starter License restrictions?

What happens if | exceed the Starter License limits?
® Evaluate
® Upgrade
® Reconfigure your repository

®* Frequently Asked Questions

What is a Starter License?

Starter licenses are low-cost licenses that allow small teams to make use of Atlassian products (see more
information ). FishEye Starter licenses were introduced with the release of FishEye 2.0.5 (October 2009).

What are the Starter License restrictions?

FishEye Starter Licenses are restricted to no more than:

® 5 FishEye users
® 5 repositories
® 10 historic committers per repository

See FishEye Licensing and Purchasing for more details.

Note that all other FishEye licenses support unlimited repositories and unlimited committers per repository.

What happens if | exceed the Starter License limits?

If you have more than 5 user accounts in FishEye, your users will not be able to log in to FishEye until an
administrator reduces the number of user accounts.

If you have more than five repositories, FishEye will prevent more than five repositories from being enabled at
any given time. Administrators can control which five repositories are enabled.

If you exceed more than ten committers in a repository, the following warning will appear at the top of pages for
the entire system:

NOTE: This repository, <repository-name> has more than 10 committers which exceeds the limits for
your Starter license. Indexing has stopped. To fix this, you can Evaluate, Upgrade or Reconfigure
your repository.

The links in this warning will lead you to the following solutions:

Evaluate

30-day evaluation licenses are available to allow you to try out FishEye and other Atlassian products. You can
select a license that allows more users than your current license.

Upgrade

You can upgrade your license at any time (via the Atlassian online store), which will remove the committer and r
epository limits which apply to the Starter License. Please ensure to restart your repository, after the license
upgrade, to ensure the changes are picked up for the new committer limit.

Reconfigure your repository

Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
http://www.atlassian.com/starter/
http://www.atlassian.com/starter/
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Committer
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Repository
https://www.atlassian.com/licensing/fisheye
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Committer
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Repository
https://my.atlassian.com/license/evaluation?product=fisheye
http://my.atlassian.com
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Committer
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Repository
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Repository

This option lets you configure your repository to remain within the limits of the Starter License. You can take the
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following actions to reduce the scope of FishEye's indexing:

1. Change the repository definition to look at a subset of your repository

Typically this involves setting the path within your repository that you wish FishEye to index. Read more.

2. Exclude parts of the repository
You can exclude portions of your repository that you are not interested in. Committers that are active in
only these areas will not appear in FishEye and not be included in the committer count. Read more.

3. Set a starting point

Some of the FishEye SCM integrations allow you to configure a starting revision from which to start
indexing. All commits prior to this starting point are not included in FishEye and do not contribute to the
committer count. Read more.

4. Map Committers

If your developers have not correctly configured their committer names for Git or Mercurial, they may

have committed with multiple identities. It is then possible to remap these to correct the problem. See the

knowledge base article, Git or Hg Repository exceeds number of allowed Committers

Once you have reconfigured your repository, you will need to re-index the repository, allowing you to remain
under the limits of the Starter license.

Frequently Asked Questions

Question

What happens when the 11th
unigue committer is
encountered during
indexing?

What happens when a
FishEye instance with a
Starter license is started,
using existing indexes with
more than five repositories?

What happens when a
FishEye instance with a
Starter license is started,
using existing indexes with
one or more repositories with
more than ten committers?

What happens on upgrade
from a Starter license, if
indexing has been paused
due to the committer limit
being reached?

What happens when
upgrading from a Starter
license, when repositories
have not started due to the
repository limit being
reached?

Answer

For all SCMs other than CVS FishEye will index all revisions up to but not
including the revision that introduced the 11th committer. Since CVS is
indexing is file-by-file based, FishEye will index files until it reaches the
committer limit. Remaining files in the repository are not indexed. This means
only files which have been indexed will be displayed in changesets and
changesets may be incomplete.

FishEye will only start indexing on the first five repositories. An administrator
can use admin Ul to adjust which repositories are enabled and hence control
the five repositories that are started. FishEye should then be restarted.

FishEye will display all information currently indexed but for each repository
that has reached the ten committer limit, no further revisions will be indexed.

On restart of FishEye, indexing will resume for all repositories. Each
repository can restarted individually to avoid restarting FishEye. Due to the
nature of CVS indexing, we recommend reindexing any CVS repositories
which have reached the committer limit prior to the license upgrade.

On restart of FishEye, all enabled repositories will start. Each repository can
restarted individually to avoid restarting FishEye.

Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.

98


http://creativecommons.org/licenses/by/2.5/au/
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Repository
https://confluence.atlassian.com/display/FISHEYE040/Configuring+repository+details
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Committer
https://confluence.atlassian.com/display/FISHEYE040/Configuring+repository+details
http://confluence.atlassian.com/display/FISHEYE/Glossary#Glossary-Commit
https://confluence.atlassian.com/display/FISHEYE040/Configuring+repository+details
https://confluence.atlassian.com/display/FISHKB/Git+or+Hg+Repository+exceeds+number+of+allowed+Committers

User Documentation for FishEye 4.0

What happens if my As described above, a maximum of five repositories will start and for any
evaluation license has repository with more than 10 committers, no further indexing will occur. All
expired and | upgrade to a existing indexed content is retained and can be viewed.

Starter license, however |
have exceeded the Starter
license limitations?

What happens when A maximum of five of your configured repositories will start running. The
downgrading to a Starter remainder will not start but will continue to be available.

license, where the repository

limit has been exceeded?

What happens when No further indexing will occur for the repositories where the
downgrading to a Starter committer limit has been exceeded.

license, where the committer

limit has been exceeded for

one or more repositories?

Updating your FishEye license

When you upgrade or renew your FishEye license, you will receive a new license key — you'll need to update
your FishEye server with the new license.

Note that you can access your current license, or obtain a new license, by going to my.atlassian.com.
Related pages:

® Upgrading from FishEye to Crucible

To update your FishEye license key:

1. Log in to FishEye Admin area.

2. Click System Info (under 'System Settings").

3. Click Edit License and paste your new license key into the appropriate text box.

4. Paste your new license into this box. Obtain a new license by clicking my.atlassian.com in the
'Information’ section.

5. Click Update.
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Support
Information
Mew licenses can be acquired from my.atlassian.com.
Your Server ID is BMRI-3AS3-HMMD-PGXX
Licenses

FishEye License |Evaluation

g

Crucible Licenze |AAAABgDODAOPeNptkEIrwzAMxe/+FladPWa7hzXgQ5eELRAnpecmgh15UoB62G1A3+EDZwv3Yt
f‘l%%?(%P PIS7TRJvDRAWNT TNeMZnNO26K p64J AUGA+0Y 7TcGp3CdjitwNuMIpOMCQ4TOnudacpl
:ffmm rHZhpOAfVjiA3EIONAGYB/R+uMyvqPgDbdl+i779eA/0g
Z2KctP4TnAOX2CIOEINFdzOAIXbCySkO/Y S+KISLXIVMLjrJ3rQu2PJ1vSZd2ahTsVgKZzGXklzz
ER‘I Vdzb3l+6TN7sIOD/v3IWwDPHS51STAIARRYKbBDq2j 1NpXxLp5wsBaClhAgBwIVA JceVTPzGB
;?;www‘: SadD+EX02c0 P

P
[ Update ) Cancel

Git or Hg Repository exceeds number of allowed committers

Symptoms

Adding a Git repository to FishEye with a Starter license (10 users) installed will sometimes produce an error
stating that there are more than 10 committers, even though there are less than 10 real people who have
committed:

Repository index failed due to error - class

com at | assi an. fi sheye. dvcs. handl er. DvcsProcessRunt i mneExcepti on:

com cenqua. fi sheye. Li censePol i cyExcepti on: Exceeded number of all owed
conmmitters

Cause

You have exceeded the number of committers allowed by the Starter License. This is either a legitimate
occurrence (you have more than 10 actual committers) or this problem can also affect git and Mercurial Starter
License users over time when their committers use different ids to commit to the repository.

FE-2496 - user Mapping across multiple repositories needs to be easier
Due to this change ( [CLOSED]| ) in FishEye 2.6,

when we scan a git repository, we now combine the author and email fields from the commit into a single field
that FishEye uses to determine who the committer is. This allows automatic email mapping to map the commit
by that committer to a FishEye User with the same email address.

Unfortunately, if your committers use different email addresses for their commits, they will now count as more
than one committer, where previously they did not.

Resolution

For Mercurial, the only solution is to rewrite the history of your repository to map these committers to a single
consistent committer id for each real committer you have (and to encourage them to be consistent in future).
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This means getting all developers to delete their clones of the repository and re-clone once the history re-write is
complete. Otherwise, they will probably end up pushing the old commits back into the repository being scanned
by FishEye and the problem will reoccur.

Warning

Be very sure you know what you are doing during this process: you are re-writing history and the wrong
command could lose all of your repositories history and your source code. Keep a backup clone of your
repository in case something goes wrong.

Rewriting history is also valid for git (detailed below), but git has an easier alternative, using the .mailmap file.
This allows the git repository to report to FishEye different names and email addresses than were actually used
by the author - this will not affect any other repositories, unless they also get the .mailmap file in their local
repositories. See the git shortlog man page for more details.

FishEye will use the version of the . mai | nap file that is checked in at HEAD. This is normally the latest commit
on mast er (or your default branch, if you have set it to other than nast er).

Once you set this up, you will need to go to the administration console in FishEye for your repository and under
the 'Maintenance' tab, select 'Re-clone and Re-index'. Any changes you make to the . mai | map file will not take
affect until you 'Re-clone and Re-index'.

Note that if you want to map multiple email addresses to one author, you need to specify them on multiple lines.
E.g.

John Doe <john. doe@ewconpany. cont> <j ohn@l dconpany. cone
John Doe <john. doe@ewconpany. cont> <j ohndoe@l dconpany. con®
John Doe <john. doe@ewconpany. cont> <j doe@l dconpany. cone

Mercurial

In Mercurial, we use the Convert Extension to rewrite the committer names, using an authormap file. In the
repository that FishEye is scanning, you will need to use the Mercurial Queues Strip command to remove all the
current commits once the converted repository is ready, otherwise you will simply add a new set of commits next
to the originals.

1. Get a copy of the repository and use:

hg log --tenplate "{author}\n" | sort | uniq

to list the current committer names.

2. Identify those you want to rewrite and add an entry into a authormap file to rewrite them to another
address.

3. Run:

hg convert ny-clone rewitten-clone

4. Strip the repository that FishEye is indexing and push the rewr i t t en- cl one into it. Make sure all your
developers use clones of the new copy of the repository from now on, otherwise they will possibly push
back all the old commits and the problem will reoccur).

5. Go to the administration console in FishEye for your repository and under the '‘Maintenance' tab, select 'R
e-clone and Re-index'.

Git
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This method will rewrite your commits with undesired author/emails in them, changing history. An easier
approach (see above) is to use the .mailmap file as mentioned in the git shortlog man page. You will need to
reclone and re-index after setting that up.

FishEye uses the git author name and email fields on a commit to identify who made the changes (which in
FishEye is referred to as the "committer”, but in git is the author; in git, the committer is who committed, possibly
on behalf of the author), so we need to remap them.

1. To rewrite the committer names in git, use the git filter-branch. You need to create a script to check for
each committer you want to remap, and replace the name and email fields. The command needs to be
run for each branch you have that you wish to modify:

...................................................................................................................................................................

git filter-branch --conmt-filter
if [ "$G T_AUTHOR NAME" = "<Od Nanme>" ];
t hen
G T_AUTHOR_NAME="<New Name>";
G T_AUTHOR_EMAI L="<New Emai | >";
elif [ "$G T_AUTHOR_NAME' = "<Cther A d Name>" ];
t hen
G T_AUTHOR_NAME="<Ct her New Name>";
G T_AUTHOR_EMAI L="<Ct her New Emai | >";
fi;
git conmmt-tree "$@"' Branch

Replace Br anch with each branch you need to modify.
Note the warnings on the git filter-branch page.

2. Once the process is complete and your repository only contains the rewritten author names and email
addresses, go to the adminstration console in FishEye for your repository and under the 'Maintenance'
tab, select 'Re-clone and Re-index'.

Example EyeQL Queries

EyeQL
How do find changes made to a branch after a given tag?
How do I filter results?
How do | find changes between two versions, showing separate histories?
How do | find changes made between two version numbers?
How do | find commits without comments?
How do | find files on a branch, excluding deleted files?
How do | find files removed from a given branch?
How do | find revisions made by one author between versions?
How do | select the most recent revisions in a given branch?
How do | show all changesets which do not have reviews?

For more information on using EyeQL, see the Reference guide.
How do find changes made to a branch after a given tag?

Find changes made to Ant 1.5.x after 1.5 FINAL:

..............................................................................................................................................................................

sel ect revisions where on branch ANT_15 BRANCH and after tag
ANT_MAI N_15FI NAL group by changeset

How do | filter results?
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This query, finds files removed on the Ant 1.5 branch, but just returns the person and time the files were deleted:

..............................................................................................................................................................................
i

sel ect revisions where nodified on branch ANT_15 BRANCH and i s dead
return path, author, date

How do | find changes between two versions, showing separate histories?

As above, but show the history of each file separately:

..............................................................................................................................................................................
i

sel ect revisions where between tags (ANT_MAI N_15FI NAL, ANT_151 FI NAL]

group by file

How do | find changes made between two version numbers?

Find changes made between Ant 1.5 and 1.5.1:

..............................................................................................................................................................................
i

sel ect revisions where between tags (ANT_MAI N 15FI NAL, ANT_ 151 FI NAL]
group by changeset

How do | find commits without comments?

Using the Advanced Search and EyeQL you can find commits that do not have comments using the following
query:

..............................................................................................................................................................................
i

select revisions fromdir / where conment = "" group by changeset

How do I find files on a branch, excluding deleted files?

Find files on branch and exclude delete files:

..............................................................................................................................................................................
i

sel ect revisions where nodified on branch ANT_15 BRANCH and not is
del et ed group by changeset

How do | find files removed from a given branch?

Find files removed on the Ant 1.5 branch:

..............................................................................................................................................................................
i

sel ect revisions where nodified on branch ANT_15 BRANCH and i s dead
group by changeset

How do | find revisions made by one author between versions?

Find changes made by conor to Ant 1.5.x since 1.5.0:

Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

User Documentation for FishEye 4.0 104

..............................................................................................................................................................................

sel ect revisions where between tags (ANT_MAI N _15FI NAL, ANT_154] and
aut hor = conor group by changeset

How do | select the most recent revisions in a given branch?

Find Java files that are tagged ANT_151 FINAL and are head on the ANT_15 BRANCH: (i.e. files that haven't
changed in 1.5.x since 1.5.1)

..............................................................................................................................................................................

select revisions fromdir /src/main where is head and tagged
ANT 151 FINAL and on branch ANT_15 BRANCH and path like *.java group by
changeset

How do | show all changesets which do not have reviews?

The following query will return any changesets that have not been reviewed.

..............................................................................................................................................................................

sel ect revisions where (not in any review)

Integration FAQ

The following FAQs relate to integrating FishEye with other Atlassian applications. You may also wish to refer to
Troubleshooting JIRA FishEye Plugin in the FishEye Knowledge Base.

How do | disable the Source (FishEye) tab panel for non-code projects?

How do | enable debug logging for the JIRA FishEye plugin?

How do | uninstall the JIRA FishEye plugin?

How is the Reviews (Crucible) tab panel for the JIRA FishEye Plugin populated?

What do | do if | discover a bug with the JIRA FishEye plugin?

How do | disable the Source (FishEye) tab panel for non-code projects?

By removing all users and groups from the 'View Development Tools' permission (called the 'View Issue Source
Tab' permission prior to JIRA 6.1) in your project's permission scheme, the Source and Reviews tabs will be
effectively disabled for that project.

How do | enable debug logging for the JIRA FishEye plugin?

For Plugin versions prior to 3.0

You can enable DEBUG logging for the JIRA FishEye plugin temporarily (until JIRA is shutdown) by accessing
the following URL in a web browser when logged in as an administrator:

http://YOUR- JI RA- BASE- URL/ secur e/ adm n/ Conf i gur eLoggi ng. j spa?l ogger Name=
com atlassian.jira.ext.fisheye& evel Name=DEBUG

To enable debug logging across JIRA restarts, update the CLASS-SPECIFIC LOGGING LEVELS section of
your VEB- | NF/ cl asses/ | og4j . properti es file by inserting the following:
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| og4j .category.com atlassian.jira.ext.fisheye = DEBUG console, filelog
| og4j .additivity.comatlassian.jira.ext.fisheye = fal se

and restarting JIRA.

For Plugin versions 3.0+

You can enable DEBUG logging for the JIRA FishEye plugin temporarily (until JIRA is shutdown) by accessing
the following URL in a web browser when logged in as an administrator:

http://YOUR- JI RA- BASE- URL/ secur e/ adm n/ Conf i gur eLoggi ng. j spa?l ogger Nanme=
com at | assi an. jirafisheyepl ugi n& evel Name=DEBUG

To enable debug logging across JIRA restarts, update the CLASS-SPECIFIC LOGGING LEVELS section of
your VEB- | NF/ cl asses/ | og4j . properti es file by inserting the following:

| og4j . category.com atl assian.jirafisheyeplugin = DEBUG console, filelog
| og4j.additivity. comatlassian.jirafisheyeplugin = fal se

and restarting JIRA.
How do | uninstall the JIRA FishEye plugin?

Plugin versions prior to 3.0

To uninstall, simply remove the j i ra-fi sheye- pl ugi n-*. j ar from your VVEB- | NF/ | i b directory.

Plugin version 3.0+

To uninstall, simply remove any j i ra-fi sheye- pl ugi n-*. j ar jars from your \EB- | NF/ cl asses/ coni at |
assi an/jiral plugin/atlassian-bundl ed-pl ugi ns. zi pand % RA_ HOVE% pl ugi ns/instal | ed-p
| ugi ns directory.

How is the Reviews (Crucible) tab panel for the JIRA FishEye Plugin populated?

The Crucible 'Reviews' tab is populated differently depending on the version of the FishEye JIRA plugin you are
using:

® Prior to Version 2.3 of the plugin, a review is displayed on the Crucible tab panel if (and only if) it
contains a revision that is displayed on the FishEye tab panel. Having the issue key in the description will
not automatically link it to the issue.

® In Version 2.3+, you can configure the Crucible tab panel to use the method described above and/or sear
ch for issue keys in the title/description of reviews.

If you associate reviews with JIRA issues from the Crucible user interface, they will not necessarily show
up in the issue tab panel. We are working on this issue (see FISH-316), but in the meantime, a
workaround is to include the related issue key in the title of the review.

What do | do if | discover a bug with the JIRA FishEye plugin?

If you need assistance or think you've encountered a bug with the JIRA FishEye plugin, please raise an issue in
the JIRA FishEye Plugin project.

Subversion FAQ
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® Configuring Start Revision based on date — For Subversion repositories Fisheye has the ability to
configure a Start Revision parameter to allow you to only index content from a given point in your
repository.

® Errors 'SEVERE assert' or '‘Checksum mismatch' — SVNKit may have problems with older version
Subversion servers - versions 1.1.x and prior.

® FishEye fails to connect to the Subversion repository after a short time of successful operation.
— On Unix systems, the svn:// protocol is usually handled by inetd or xinetd. These daemons apply, by
default, a connection per second limit to incoming connections. Any connections above this rate are
rejected by the server.

®* How can FishEye help with merging of branches in Subversion? — In merge management, the
main advantages of FishEye come from its search functionality. If you record the revisions merged when
you check in a merge result, you can find this information in FishEye easily for the next merge operation.

® Subversion Changeset Parents and Branches

® SVN Authentication Issues — If multiple repositories have been defined in FishEye for the same SVN
Server and those repositories use different credentials, FishEye may not use the correct credentials.

® What are Subversion root and tag branches?

® Why do | need to describe the branch and tag structure for Subversion repositories? — In
Subversion, branches and tags are defined by convention, based on their path within a repository, and
not directly defined by the repository. A few different layout alternatives are commonly used. It is also
possible that you are using your own custom layout. As a result you need to describe to FishEye which
paths in your repository are used as branches and tags.

® Why don't all my tags show up in FishEye?

® About merges in Subversion

Configuring Start Revision based on date

For Subversion repositories Fisheye has the ability to configure a Start Revision parameter to allow you to only
index content from a given point in your repository.Quite often users will find it helpful to index from a revision on
a given date. For example, you may want to only index SVN data in the past year. To determine the revision
based on date, you can use the following command:

svn log -r {YYYY-IMM DD}: HEAD <SVN URL> -| 1

The output of this command will reveal the revision number closest to the date that you provide.
Errors 'SEVERE assert' or 'Checksum mismatch’

When using SVNKIit, you may see errors in the FishEye log such as 'SEVERE: assert #B' or 'Checksum
mismatch'.

SVNKIit may have problems with older version Subversion servers - versions 1.1.x and prior. If this is the case
you should either use the native JavaHL layer or upgrade your Subversion server to a more recent version.

FishEye fails to connect to the Subversion repository after a short time of successful
operation.

If you use the svn: // protocol to access a Subversion repository, you may notice that FishEye fails to connect
to the repository after a short time of successful operation.

On Unix systems, the svn: // protocol is usually handled by i net d or xi net d. These daemons apply, by
default, a connection per second limit to incoming connections. Any connections above this rate are rejected by
the server.

Two options for fixing this problem:

® Ask your system administrator increase the connection rate allowed for the svn connection by updating
the xi net d configuration, or

® Specify a connection per second limit in your FishEye repository definition, to prevent FishEye from
exceeding the xi net d limits.
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How can FishEye help with merging of branches in Subversion?

FishEye gives you a logical view of your branched files so you can see activity on a single file across multiple
branches/trunk.

In merge management, the main advantages of FishEye come from its search functionality. If you record the
revisions merged when you check in a merge result, you can find this information in FishEye easily for the next
merge operation.

As an example, let's say you have a branch dev created at revision 1300 from t r unk. Development has
proceeded on both t r unk and dev. At some point you wish to add the latest t r unk changes into the dev branc
h. Let's say that is at revision 1400. When you check in the results of this merge, you would use some standard
format checkin comment such as:

nerge fromtrunk to dev 1300: 1400

When you come to do the next merge, say at revision 1500, you can use FishEye search to find this checkin
comment and know what the starting point for the merge should be. You can then check this in as:

nmerge fromtrunk to dev 1400: 1500

Merges back to t r unk from the dev branch are managed in the same way.
Subversion Changeset Parents and Branches

Why do some changesets have more than one branch? Why do these changesets have more than one parent?

In Subversion, a single changeset can have files and directories that are on different branches, as defined by the
SVN tag and branch structure. In this situation, the changeset is considered to be on all of the branches of its
constituent file revisions. If a changeset is on more than one branch it can have a parent changeset of each of its
branches, giving the changeset multiple parents.

FishEye does not track SVN merges, so merges are not indicated on the graph.

When | create a complex branch, how does FishEye determine which is its parent changeset? When | create a

complex tag, how does FishEye decide which changeset to tag?

In Subversion, a simple branch or tag is created by copying a source directory, e.g. copying "/ t r unk" to "/ br an
ches/ branchl" or "/ t ags/t agl". The tag or branch is considered complex if a part of the copied directory is
replaced with another version, e.g."/ t r unk" is copied to "/ t ags/ t agl", and then "br anches/ branchl/dir1
"is copiedto "/ tags/tagl/dir1l"

For the purpose of the commit graph, FishEye looks at where the root directory was copied from, to determine
where the branch or tag originated. In the example above, the label "t ag1l" would be applied to the latest
changeset on trunk when the tag was created, even though part of the tag was copied from branchl. This only
affects the annotation of the changeset, not the file revisions that are tagged — the tagged file revisions are still
those on t r unk or br anchl as appropriate.

SVN Authentication Issues

If multiple repositories have been defined in FishEye for the same SVN Server and those repositories use
different credentials, FishEye may not use the correct credentials.

FishEye does not control directly when authentication information is used to access Subversion repositories. It
delegates this operation to the JavaHL layer in use. JavaHL will then ask FishEye to supply credentials when
required, using a callback. The default JavaHL layer shipped with FishEye, SVNKit, can cache credentials at the
server level rather than at the repository level.

There are different approaches to solving this issue:

Specify the username as part of the URL when defining your repository location (Recommended)

When using FishEye/Crucible 2.10, or later, we recommend that you simply include the username in the URL
when defining the repository in FishEye. For example, use htt p: / / user name@ost . com
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Use the native JavaHL implementation

FishEye can be configured to use the native JavaHL implementation, which will correctly apply the appropriate
credentials.

Use the same authentication for the SVN server

The simplest solution is to have the same credentials for accessing the Subversion Server.

Use mock hostnames in the hosts file

Alternatively, SVNKit can be tricked into thinking that different servers are being used. For each connection to a
repository a hostname in the hosts file can be defined.

All these entries then point to the same IP address of the SVN Server, but to SVNKIit they look like different
servers, thus bypassing the problem.

Example hosts entries (replace the IP address with the address of the SVN Server):

123.45. 6. 78 accountl
123.45.6. 78 account 2

Replace these new server names in the SVN URLs:

http://account 1/ svn/ proj ect - a/
htt p://account 2/ svn/ pr oj ect - b/

What are Subversion root and tag branches?

FishEye identifies branches and tags in your Subversion repository by applying your specified SVN tag and
branch structure.

The "root:" branch

Any files or directories that fall outside the tag and branch structure are identified as being on the special branch,
"r oot : ". Some directories will almost always fall outside this structure. In general, root directories of branches
are considered to be on the "r oot : " branch. This means that any changeset in which a branch is created is
considered to be on branch, "r oot : ". Additionally, any files or directories that fall outside the defined structure
will be assigned branch, "r oot : ". If you're seeing a lot of files and changesets on "r oot : ", you may need to
update your branch and tag structure in FishEye and rescan your repository, or exclude parts of your repository
that don't follow your defined structure.

"tag:" branches

When FishEye detects that a tag has been created, it looks at the files that were tagged and adds the tag as an
annotation to those file revisions. No file revisions are created at this point.

If a tag is modified after it has been created and committed, FishEye promotes the tag to a branch to preserve
the history of the modification. For example, a user may create the tag "bui | d1" by copying "t r unk" to "t ags/
bui | d1". If they then modify contents of t ags/ bui | d1, a new branch "t ag: bui | d1" will be created for the
modification.

Why do | need to describe the branch and tag structure for Subversion repositories?
In Subversion, branches and tags are defined by convention, based on their path within a repository, and not
directly defined by the repository. A few different layout alternatives are commonly used. It is also possible that

you are using your own custom layout. As a result you need to describe to FishEye which paths in your
repository are used as branches and tags.
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It is very important that you correctly define in FishEye the layout you are using. If you do not, FishEye will not
know which paths represent tags and branches. This will prevent FishEye from relating different versions of the
same logical file across separate paths within your repository. It will also mean that FishEye's cache will be
much larger as each tagged path will be indexed separately. This will result in an increase in the initial scan time
and may reduce runtime performance.

If you are having trouble using Subversion tags, see How tags work in Subversion.

Why don't all my tags show up in FishEye?

This page gives a detailed technical explanation of why certain issues affect Subversion users.
On this page:

Introduction

How Subversion processes tags and branches
An example from an Subversion repository
Avoid modifications in the tag area

Conclusion

Introduction

When accessing Subversion from FishEye, you may see references to tags in the branches drop-down menu. In
the example below, we can see tagl and tag3 in the drop-down menu but not tag2:

Screenshot: The Branches Drop-Down Menu in FishEye

Branch: | (any) ?I Committer: | {any) ?I
(any)
File MName: \any, Log Comment:
N . branchl P —
File Extension: roat: : End Date: [ Apply constraints )
help tag:tagl
| tag:tag3

In actual fact, the branches drop-down menu shows only branch names. It does not show tags, but in some
instances FishEye will synthesize a branch name to record certain operations. To understand how this occurs,
you will need some background knowledge on Subversion tagging (introduced in the following segments of this

page).

How Subversion processes tags and branches

In Subversion, tags are only a convention and are typically the result of a copy operation from the trunk to a tag
area in the tags directory. When FishEye processes this copy operation, it recognizes that the destination is a
tag directory and tags the source file on trunk with the name of the tag.

That is, FishEye is interpreting the Subversion copy to a tag directory as a tagging operation on the trunk files.

For regular changes in your Subversion repository, FishEye records each change against a branch where the
change took place. If, however, after tagging, you make a change to a file in the tagged area, you are making a
change outside trunk or a recognized branch. FishEye records such changes by creating an artificial branch
name and associating that branch name with the change. The branch name is derived from the tag name by
prepending "tag:" (in other words, the characters "tag:" appear as the first part of the name). The same thing will
occur if you create a new file in the tagged area which does not come from an existing branch or trunk.

This is the reason you see some of your tags in the branch drop down. It means that for those tags, you have
made a modification after the tagging operation.
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An example from an Subversion repository

For example, consider tag4 in this screenshot:

® - testgen , tags , tagd

E;b [0 branches/branchi/ E tag4
= tags/ : —
0 tagl/ Files Activity Users Reports Query
g B2 tag2/ =TI o | Reviews
2 taga/
tag4/ Conor MacNeill
E3 trunkf El committed 10 to testgen

Add new file in tagged area

added test2.txt

® testeixt (+1) B & &
[E] committed 9 to lestgen

Create new tag, tag4

®tagd (+0) B @ &

There are two changes here. The first creates the tag and the second adds a new file in the tagged area. This
will result in the creation of an artificial branch, called "tag:tag4" within FishEye.

Avoid modifications in the tag area

In general, it's not good practice to make changes in the tag areas of a Subversion repository. Such changes
can easily get lost if they are not applied to trunk or a current branch. It is preferable to make the change in trunk
or a branch and then create a new tag to capture the update. Nevertheless, since Subversion tagging is merely
a convention, this is sometimes convenient. FishEye handles this situation as described above.

Conclusion

In general a lot of systems have a large number of tags which would make the drop-down unworkable. This is
the reason the tag field is a text-entry box below the branch drop-down menu in FishEye.

Since tags and branches are based on location convention in Subversion, the constraint is less effective than on
other SCMs. You can always see the tag or branch you are interested in, based on its location in the repository.
For example, the subdirectory list here shows all tags:
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= 3 branches/branchi/f
= tags/
o tagls
Lo taga/
3 tagdl
tagd/

2 trunks/

o If you want to constrain to a tag, enter the tag name in the tag field of the constraint filter.

About merges in Subversion

DO NOT PUBLISH BEFORE 4.1 release

This page explains how FishEye manages merge operations in Subversion, and provides examples of supported
and unsupported merge formats.
® Merge definition
® How FishEye shows merge information
® Commit graph
® Changeset view
® Acceptable path property format
® Merge targets and sources
® Unsupported operations
® Advanced merging

Merge definition

Subversion allows you to reapply changes made on other branches to the current working branch using the mer
ge operation. For example, merging allows you to reintegrate a feature branch with trunk, or to reapply changes
made on trunk to the current working branch. Subversion tracks this information in the dedicated svn: ner gei n
f o path property. FishEye detects changes in those properties and uses those to mark parents of a changeset
accordingly, effectively exposing merges between branches.

Notes:

® Although the path property might be set manually by using the propset command, FishEye trusts this
information blindly, which means that if you add a required property in a correct format, FishEye will

resolve parents for a changeset accordingly.
® The versions of the Subversion client and server used to perform merges both need to be version 1.5 or
higher, since earlier versions do not have svn: ner gei nf 0. FishEye supports only branch and trunk path

roots merges.

How FishEye shows merge information

Changeset merges are exposed in three places:

® commit graph
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¢ changeset view
® REST and Java API

Note: Although merge information is processed, changes on different branches are not reflected in the file
ancestry history.

Commit graph

16 May 16 & reintegrated long

] 16 May 16 & on branch long
] 16 May 16 L Ontrunk
] 16 May 16 & on long branch
] 16 May 16 & on long branch
L 16 May 16 1 reintegrated sub1
i 16 May 16 1 file.txt on subi
i 16 May 16 1 Created branch sub1
] 16 May 16 & Merge from trunk
T 16 May 16 & Changed branch-long file after trunk modifications
[ ] 16 May 16 2 Changed fileOnBrnach1 on trunk after long branch creation
[ ] 16 May 16 L Created long branch
[ ] 16 May 16 L Reintegrated branch-1 with trunk
T @ 16 May 16 & Modified files on branch-1
i 16 May 16 & Created branch-1
[ ] 16 May 16 & Files on trunk

Changeset view

glewandowski committed 11 3 days ago & B8+10
merge branch 2 to trunk Ir trunk

I trunk View as Patch  View in Activity Stream  View in graph Blame j 1 next, k : prey
T fileO.txt Create Review

Acceptable path property format

FishEye uses the svn: ner gei nf o property. It is set on a target path to which revisions has been merged and
contains information about the revisions or revision range that has been merged, and the source of the merge.
FishEye supports only base branches merge, which means that only the following format is acceptable:

(Source branch): (Range revision start)-(Range revision end)

For example:
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/ branches/ f eat ur e- br anch- 1: 10- 15

However if none of the changesets in the range <10,15> made actual changes to f eat ur e- br anch,
(or those changes are not recognised as such by FishEye due to, for example, the included/excluded
paths), the merge information won't be reflected.

Merge targets and sources

FishEye supports only branch and trunk path merges, which means that proper configuration of the repository
structure is crucial. If the ner gei nf o property is applied on a path that isn't identified as a branch or trunk root

by SVN rules, it won't be processed. The same applies to ner gei nf o value which describes the source of a
merge. If it's not a branch/trunk root, or it's excluded by include/exclude paths, it won't be processed or reflected
in FishEye.

Considering the basic(built-in) rules and recommended repository structure, the following merge properties will
be recognized:

Property changes on: branches/exanpl e-branch

Added: svn:nergeinfo
Merged /trunk:r2-3

But the following will not be recognizrd:

Property changes on: trunk/directory

Added: svn: nergeinfo
Mer ged / branches/ exanpl e-branch/directory:r2-5

Unsupported operations

Advanced merging

None of the operations described on this site are supported by FishEye. Cherry picking revisions may result in m
er gei nf o formats similar to the following, which won't be recognized:

/ branches/ exanpl e- br anch: 5703
/trunk: 4622, 5065, 5300, 5395, 5403, 5410- 5414, 5419, 5423- 5425

However, if you cherry pick revisions to create a valid revision range, it will be reflected in FishEye. For example,
doing a couple of consecutive merge operations might result in a ranged svn: mer gei nf o property format.

Such a situation happens on the second merge command, which will transform svn: nmer gei nf o to contain the
value / exanpl e- br anch: 8- 9. In that case, FishEye will recognize it as a valid merge in the latest commit and

mark it accordingly.
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$ svn nerge -c 8 "/ branches/ exanpl e-branch &% svn comnt
$ svn merge -c 9 * branches/exanpl e-branch && svn comm t

CVS FAQ

®* How does FishEye calculate CVS changesets? — FishEye's goal is to allow changesets to be seen
as a consistent stream of atomic commits. Revisions are collated into the same changeset provided that:
® How is changeset ancestry implemented for CVS?

How does FishEye calculate CVS changesets?

FishEye's goal is to allow changesets to be seen as a consistent stream of atomic commits. Revisions are
collated into the same changeset provided that:

They have the same commit comment.

They are by the same author.

They are on the same branch.

The changeset does not span more than 10 minutes.

The same file does not appear in a changeset more than once.

How is changeset ancestry implemented for CVS?

About Changeset Ancestry in FishEye

When FishEye indexes a CVS respository, it synthesizes a changeset identifier to group file-level changes into a
single consistent changeset. The grouping is described in this FAQ: How does FishEye calculate CVS
changesets?.

Changeset ancestry was added in FishEye 2.6. Changeset ancestry refers to the linking of a changeset to a
preceding/parent changeset(s). This allows you to view the development progress of your repository using the
Commit Graph (see Viewing the Commit Graph for a Repository).

Changeset Ancestry for CVS
For CVS respositories, changeset ancestry is implemented, as follows:

® For all but the first change on a branch, FishEye chooses the most recent change on that branch as the

parent changeset.
® For the first change on a branch, FishEye examines the branchpoints of all files in the branch and
chooses the latest changeset that affected any such files as the parent changeset.

This approach ensures that a branch, whose first change is to a file which is very old, is not considered to have
been branched at the time that file was last changed. It is considered to be branched at the last change to the
repository instead.

Support Policies

Welcome to the support policies index page. Here, you'll find information about how Atlassian Support can help
you and how to get in touch with our helpful support engineers. Please choose the relevant page below to find
out more.

® Bug Fixing Policy

®* New Features Policy

® Security Bugfix Policy

To request support from Atlassian, please raise a support issue in our online support system. To do this, visit su
pport.atlassian.com, log in (creating an account if need be) and create an issue under FishEye. Our friendly
support engineers will get right back to you with an answer.

Bug Fixing Policy
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Summary

® Qur Support team will help with workarounds and bug reporting
* We'll generally fix critical bugs in the next maintenance release
® We schedule non-critical bugs according to a variety of considerations

Report a bug

Building an add-on

Are you developing an add-on for an Atlassian product or using one of our APIs? Report any related bugs here.

Bug reports

Atlassian Support is eager and happy to help verify bugs—we take pride in it! Create an issue in our support
system, providing as much information as you can about how to replicate the problem you're experiencing. We'll
replicate the bug to verify, then lodge the report for you. We'll also try to construct workarounds if possible.

Search existing bug reports

Use our issue tracker to search for existing bugs, and watch the ones that are important to you. When you watch
an issue, we'll send you an e-mail notification when the issue's updated.

How we approach bug fixing

Maintenance (bug fix) releases come out more frequently than major releases, and attempt to target the most
critical bugs affecting our customers. The notation for a maintenance release is the final number in the version
(the 1 in 6.0.1, for example).

If a bug is critical (production application down or major malfunction causing business revenue loss or high
numbers of staff unable to perform their normal functions) we'll fix it in the next maintenance release, provided
that:

® The fix is technically feasible (it doesn't require a major architectural change)
® |t doesn't impact the quality or integrity of a product

For non-critical bugs, the developer assigned to fixing bugs prioritises the bug according to these factors:

How many of our supported configurations are affected by the problem
Whether there is an effective workaround or patch

How difficult the issue is to fix

Whether many bugs in one area can be fixed at one time

Developers responsible for fixing bugs also monitor comments on existing and new bugs, so you can comment
to provide feedback if you need to. We give high priority to security issues.

When considering the priority of a non-critical bug, we try to determine a value score for a bug. The score takes
into account the severity of the bug from our customers' perspective, how prevalent the bug is, and whether new
features on our roadmap may render the bug obsolete. Our developers combine the value score with a complexi
ty score (how difficult the bug is) when selecting issues to work on.

Further reading

See Atlassian Support Offerings for more support-related information.
New Features Policy

Summary

®* We encourage and display customer comments and votes openly in our issue tracking system, http://jira.a
tlassian.com.
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We do not publish roadmaps.

Product Managers review our most popular voted issues on a regular basis.
We schedule features based on a variety of factors.

Our Atlassian Bug Fixing Policy is distinct from this process.

Atlassian provides consistent updates on the top 20 issues.

How to track what features are being implemented

When a new feature or improvement is scheduled, the 'fix-for' version will be indicated in the JIRA issue. This
happens for the upcoming release only. We maintain roadmaps for more distant releases internally, but because
these roadmaps are often pre-empted by changing customer demands, we do not publish them.

How Atlassian chooses what to implement

In every major release we aim to implement highly requested features, but it is not the only determining factor.
Other factors include:

® Customer contact: We get the chance to meet customers and hear their successes and challenges at
Atlassian Summit, Atlassian Unite, developer conferences, and road shows.

® Customer interviews: All product managers at Atlassian do customer interviews. Our interviews are not
simply to capture a list of features, but to understand our customers' goals and plans.

® Community forums: There are large volumes of posts on answers, of votes and comments on jira.atlassi
an.com, and of conversations on community forums like groups on Linkedin.

® Customer Support: Our support team provides clear insights into the issues that are challenging for
customers, and which are generating the most calls to support

® Atlassian Experts: Our Experts provide insights into real-world customer deployments, especially for
customers at scale.

® Evaluator Feedback: When someone new tries our products, we want to know what they liked and
disliked and often reach out to them for more detail.

® In product feedback: The JIRA Issue Collectors that we embed our products for evaluators and our
Early Access Program give us a constant pulse on how users are experiencing our product.
Usage data: Are customers using the features we have developed?

®* Product strategy: Our long-term strategic vision for the product.
Please read our post on Atlassian Answers for a more detailed explanation.

How to contribute to feature development

Influencing Atlassian's release cycle

We encourage our customers to vote on issues that have been raised in our public JIRA instance, http://jira.atlas
sian.com. Please find out if your request already exists - if it does, vote for it. If you do not find it you may wish to
create a new one.

Extending Atlassian products

Atlassian products have powerful and flexible extension APIs. If you would like to see a particular feature
implemented, it may be possible to develop the feature as a plugin. Documentation regarding the plugin APIs is
available. Advice on extending either product may be available on the user mailing-lists, or at Atlassian Answers.

If you require significant customisations, you may wish to get in touch with our partners. They specialise in
extending Atlassian products and can do this work for you. If you are interested, please contact us.

Further reading

See Atlassian Support Offerings for more support-related information.
Security Bugfix Policy

See Security @ Atlassian for more information on our security bugfix policy.

Troubleshooting
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® After | commit a change to my CVS repository, it takes a long time before it appears in
FishEye. — If you do not have a CVSROOT/history file, then a commit will not appear in FishEye until
after FishEye has done a periodic full scan of your repository. You can configure the period of this scan in
the Admin pages.

® FishEye freezes unexpectedly — If your FishEye 2.0 or 2.0.1 instance freezes unexpectedly, this
could be caused by a known issue with FishEye and MySQL database technology.

® | have installed FishEye, and the inital scan is taking a long time. Is this normal? — As a guide,
FishEye should be able to process about 100KB-200KB per second on an averaged-size PC. If FishEye
is accessing the repository over the network (e.g. over a NFS mount), then you should expect the initial
scan to take longer.

® | have installed FishEye, but there is no data in the Changelog. — When you add a repository,
FishEye needs to scan through the repository to build up its index and cache. This scan can take some
time. Until this scan is complete, you may find that some data is not displayed.

® |nitial scan and page loads are slow on Subversion — It's possible that you've mis-configured your
tag and branch structure and caused FishEye to process some or all files as trunk files. You should
recheck your tag configuration.

* JIRA Integration Issues
Manually Generating a Thread Dump
Message 'org.tigris.subversion.javahl.ClientException svn Java heap space' — The Java heap
space needs to be increased to an acceptable size. See the FishEye Tuning documentation for more
information.

® Problems with very long comments and MySQL migration — There is a known issue with FishEye
2.0.x and very long comments when migrating your database to MySQL.

® URLs with encoded slashes don't work, especially in Author constraints — If the author names in
your repository contain slashes or back-slashes, and you are using Apache, you may run into a problem
where these characters are incorrectly escaped.

® Manually Generating a Thread Dump (Draft)

® All Repositories fail - Could not execute query (MySQL database)

FishEye Knowledge Base

See the troubleshooting guides and technical announcements in the FishEye knowledge base.

After | commit a change to my CVS repository, it takes a long time before it appears in
FishEye.

If possible, FishEye will monitor and parse the CVSROOT/ hi st or y file in your repository to quickly work out

what has changed. You may want to check with your CVS administrator to ensure this feature of CVS is turned
on.

If you do not have a CVSROOT/ hi st or y file, then a commit will not appear in FishEye until after FishEye has
done a periodic full scan of your repository. You can configure the period of this scan in the Admin pages.

FishEye freezes unexpectedly

Issue Symptoms

If your FishEye 2.0 or 2.0.1 instance freezes unexpectedly, this could be caused by a known issue with FishEye
and MySQL database technology.

This issue manifests itself in some FishEye pages returning a server timeout error. To identify the issue, check
the FishEye error log. For this issue, the following output will appear in the error log:
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2009-07-15 15: 34: 45,555 ERROR [ bt pool 0-519] fi sheye. app

H bernateUtil-commitTransaction - Conmit fail nsg-0: Could not execute
JDBC bat ch update

2009- 07- 15 15: 34: 45,556 ERROR [ bt pool 0-519] fi sheye. app

H bernateUtil-commtTransaction - Conmit fail nsg-1:Lock wait tineout
exceeded; try restarting transaction

2009- 07-15 15: 34: 45, 557 ERROR [ bt pool 0-519] fi sheye. app

H bernateUtil-comritTransaction - Conmit failed rolling back.

Caused by: java.sqgl.BatchUpdat eExcepti on: Lock wait timeout exceeded;
try restarting transaction

at
com nysql . j dbc. Server Prepar edSt at enent . execut eBat ch( Server Pr epar edSt at em
ent.java: 647)

at
com nthange. v2. c3p0. i npl . NewPr oxyPr epar edSt at enrent . execut eBat ch( NewPr oxy
Prepar edSt at enent . j ava: 1723)

at
org. hi bernat e. j dbc. Bat chi ngBat cher. doExecut eBat ch( Bat chi ngBat cher. j ava: 4
8)

at
org. hi bernate. j dbc. Abst ract Bat cher . execut eBat ch( Abstract Bat cher. java: 246
)

163 nore

The FishEye error log can be found under FI SHEYE | NST/ var/| og/ fi sheye-error.| og. YYYY- MM DD.

See the JIRA issue for more information.

Workaround

Until the issue is solved, the suggested course of action is to restart your FishEye instance. This will return
FishEye to normal operation.

The FishEye development team is actively working on a solution and this be part of an upcoming point release of
FishEye.

Requesting Support

If you require assistance in resolving the problem, please raise a support request under the FishEye project.
| have installed FishEye, and the inital scan is taking a long time. Is this normal?

When you add a repository, FishEye needs to scan through the repository to build up its index and cache. This
scan can take some time. Until this scan is complete, you may find that some data is not displayed.

As a guide, FishEye should be able to process about 100KB-200KB per second on an averaged-size PC. If
FishEye is accessing the repository over the network (e.g. over a NFS mount), then you should expect the initial
scan to take longer.

For more details, see Improve FishEye scan performance.

| have installed FishEye, but there is no data in the Changelog.

When you add a repository, FishEye needs to scan through the repository to build up its index and cache. This
scan can take some time. Until this scan is complete, you may find that some data is not displayed.

As a guide, FishEye should be able to process about 100KB-200KB per second on an averaged-size PC. If
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FishEye is accessing the repository over the network (e.g. over a NFS mount), then you should expect the initial
scan to take longer.

Initial scan and page loads are slow on Subversion

Background Information

When you add a repository, FishEye needs to perform a once-off scan through the repository to build up its initial
index and cache. This scan can take some time. Until this scan is complete, you may find that some data is not
displayed. As a guide, FishEye should be able to process about 100KB-200KB per second on an averaged-size
PC. If FishEye is accessing the repository over the network (e.g. over a NFS mount), then you should expect the
initial scan to take longer. Read on if your scan appears to be considerably slower than expected.

Solutions

It's possible that you've mis-configured your tag and branch structure and caused FishEye to process some or
all files as trunk files. You should recheck your tag configuration.

If that fails, then the Atlassian support team will be happy to help you with this issue. Please sign up for a
support account if you don't have one already, then login and create a FishEye support request.

Users with very large or non-local repositories may be able to improve their FishEye scan performance.
JIRA Integration Issues

Users are mapped to their own accounts when using Trusted Applications.

If you (or the general account used for JIRA access, if not using Trusted Applications) do not have the
permissions to carry out the JIRA actions linked from FishEye, an error will occur. Depending on the error
returned from JIRA, FishEye may not display the error correctly or display it at all, simply reporting that "An error
has occurred". To investigate what the error was, you can access the FishEye debug log, named f i sheye- deb
ug. | og. YYYY- MM DD under the di st . i nst/ var/ | og folder of your FishEyee installation and look for the
date and time when your error took place. Here, you will be able to follow the links and see what error the JIRA
instance was producing by clicking through to JIRA.

Manually Generating a Thread Dump

If FishEye/Crucible stops responding or is showing poor performance, providing thread dumps
to Support can help diagnose the problem.

Note: If you were asked by Atlassian technical support to create thread dumps please take at least six
thread dumps — one every ten seconds for one minute so we can identify what the application is doing.
Attach all generated files to the support ticket in addition to a Support Zip (the default Support Zip
options includes f i sheye. out which is the file to which thread dumps are sometimes written).

Generating a Thread Dump for Windows

Method 1: Windows scripts

We now have scripts for generating thread dumps externally on Windows. Download them from this Bitbucket
Repository.

Method 2: CTRL+BREAK (only if FishEye/Crucible is running in a console window)

1. Right click on the titlebar for the command console window where FishEye/Crucible is running to open
the Properties dialog box.

Select the Layout tab.

Under Screen Buffer Size, set the Height to 3000 and click OK.

Press CTRL-BREAK on your keyboard.

This will output the thread dump to the command console.

Scroll back in the command console until you reach the line containing "Full thread dump”.

ook wbd
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© ©xN

Right click the title bar and select Edit -> Mark.

Highlight the entire text of the thread dump.

Right click the title bar and select Edit -> Copy.

Open a text editor and paste the thread dump and save the file.

Method 3 - VisualVM:

VisualVM is only provided as part of the Java Development Kit (JDK) distribution of Java. The JDK is
not packaged with FishEye/Crucible, and will need to be downloaded separately. Your JAVA_HOME en
vironment variable specifies which version of the Java Virtual Machine (JVM) FishEye/Crucible uses. If
no JAVA_HOME environment variable is set, FishEye/Crucible uses the Java Runtime Enviroment
(JRE) version packaged with the application.

Scenario 1: FishEye/Crucible is using the JVM provided by the JDK - AND - FishEye/Crucible is running as a
console application:

agprONPE

Start VisualVM (<JDK installation directory>\bin\jvisualvm.exe)

Select com.cenqua.fisheye.FishEyeCtl application in the left-hand pane under Local.
Select the Threads tab in the right pane.

Click Thread Dump.

Select the Threads tab to return.

Scenario 2: FishEye/Crucible is not using the JVM provided by the JDK - AND - FishEye/Crucible is running as a
console application:

1.
2.
3.

1
1

POOXXNOO

Stop FishEye/Crucible.

Edit <FishEye/Crucible installation directory>\bin\fisheyectl.bat

Add the following JMX parameters to the %_EXECCMD% %FISHEYE_OPTS% property (within the
existing quotes)

...................................................................................................................................................................

- Dcom sun. managenent . j nxr enot e. port =6080
- Dcom sun. managenent . j nxr enot e. aut hent i cat e=f al se
- Dcom sun. managenent . j nxr enot e. ssl =f al se

You must choose a free port for IMX to bind to — this example uses port 6080

Restart FishEye/Crucible.

Start VisualVM: <JDK installation directory>\bin\jvisualvm.exe

Select File > Add JMX Connection.

Type: localhost:<your JMX port>

Select com.cenqua.fisheye.FishEyeCtl application in the left-hand pane under Local.
Select the Threads tab in the right pane.

Click Thread Dump.

Select the Threads tab to return.

Scenario 3: If FishEye/Crucible is running as a service:

1.
2.
3.

Stop FishEye.
Go to Start > Apps (in Windows 8.1/Server 2012) or All Apps (in Windows 8) > Configure FishEye.
Add the following JMX parameters to the service configuration on the Java tab under Java:

...................................................................................................................................................................

- Dcom sun. managenent . j nxr enot e. port =6080
- Dcom sun. managenent . j nxr enot e. aut henti cat e=f al se
- Dcom sun. managenent . j nxr enot e. ssl =f al se
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You must choose a free port for IMX to bind to — this example uses port 608

Click Apply, then OK

Restart FishEye.

Open Task Manager.

Look for the Process Name Common Daemon Services Runner.

Open the tree for the process and look for the sub-process "Atlassian FishEye". The PID for the process
will be located under the PID column.

© N agA

If you are running multiple Atlassian products on the same server, each will have a separate
Process Name Common Daemon Services Runner.

9. Start VisualVM: <JDK installation directory>\bin\jvisualvm.exe
10. Select File > Add JMX Connection.
11. Type: localhost:<your JMX port> and click OK.
12. Select localhost:<your JMX port> in the left-hand pane under "Local".
13. Select the Threads tab in the right pane.
14. Click Thread Dump.
15. Select the Threads tab.

Generating a Thread Dump on Linux, including Solaris and other Unixes

Method 1 - jstack:

1. Find the process ID of FishEye/Crucible the JVM using the ps command.

...................................................................................................................................................................

FC PID="ps aux | grep -i fisheye | grep -i java | awk -F '[ ]*'
"{print $2}'°;

...................................................................................................................................................................

...................................................................................................................................................................

top -b -H-p $FC PID -n 1 > fisheye_cpu_usage. date +% .txt;
jstack -1 $FC PID > fisheye_threads. date +%  .txt

3. Look in the resulting CPU usage files (fisheye_cpu_usage.<timestamp>.txt) to identify which threads are
consistently using a lot of CPU time.

4. Take the PID of the top 10 threads which are using CPU time and convert them to Hexadecimal (Eg:
11159 becomes 0x2b97).

5. Find the Hex values in the thread dump (fisheye_threads.<timestamp>.txt) files to figure out which
threads are occupying CPU.

Method 2 - Kill Signal:

1. Find the process ID of FishEye/Crucible the JVM using the ps command:

...................................................................................................................................................................

ps aux | grep -i fisheye | grep -i java | awk -F '[ ]*" "{print
$2}!

2. Run the following command 6 times with a 10 second interval:

The Kill -3 command will NOT terminate your FishEye/Crucible process.
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...................................................................................................................................................................

Kill -3 <pid>

The thread dump will be printed to FishEye/Crucible's standard output (fisheye.out).

Tools for analyzing thread dump files:

Samurai - http://samuraism.jp/samurai/en/index.html
° Thread Dump Analyzer (TDA) - https://java.net/projects/tda

Message 'org.tigris.subversion.javahl.ClientException svn Java heap space'

When adding a new repository and on the initial scan, you may receive messages similar to this in the logs: or g
.tigris.subversion.javahl.dientException: svn: Java heap space

The Java heap space needs to be increased to an acceptable size. See the FishEye Tuning documentation for
more information.

Problems with very long comments and MySQL migration

Issue Symptoms

There is a known issue with FishEye 2.0.x and very long comments when migrating your database to MySQL.In
some circumstances, this might result in truncation of very long comments, causing data loss.

Depending on your configuration, you may see an error message like this while migrating to MySQL, causing the
migration to fail:

2009-07-16 16:56: 12,390 ERROR [ Thr eadPool 1] fi sheye. app

com cenqua. cruci bl e. acti ons. adm n. dat abase. DBEdi t Hel per - doGet -

Dat abase migration fail ed:

j ava. sql . Bat chUpdat eException: Data truncation: Data too |long for colum
'cru_nessage' at row 1

j ava. sql . Bat chUpdat eException: Data truncation: Data too long for colum
‘cru_message' at row 1

@ You may not see the message if you are running MySQL with default settings.

For more information, see the JIRA issue.

Workaround

If your data contains very long comments or review descriptions (longer than 21,845 multibyte unicode
characters), consider avoiding use of MySQL until this issue is resolved fully. Alternatively, use PostgreSQL or
the default (built-in) HSQLDB database.

The FishEye developers are actively working on a solution to this problem and it will be addressed in an
upcoming FishEye point release.

Requesting Support

If you require assistance in resolving the problem, please raise a support request under the FishEye project.
URLs with encoded slashes don't work, especially in Author constraints

If the author names in your repository contain slashes or back-slashes, and you are using Apache, you may run
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into a problem where these characters are incorrectly escaped. By default Apache explicitly forbids encoded
slashes or back-slashes in URLs. You can change this behavior with the following httpd.conf directive:

..............................................................................................................................................................................

This directive is documented here.

FishEye Developer FAQ

This page contains answers to frequently asked questions posed by FishEye developers. For detailed
information about developing in FishEye, see the Fisheye Developer documentation.
Feel free to comment, make submissions, or pose your own question on FishEye Development here.

®* Q: I'm getting the error "API access is disabled" as a response from htt p: //fi sheye/ api/rest/rep
osi tori es on my installation. How do | enable the API as a Fisheye administrator?

~ Click here to expand...
A: A toggle to enable the API under "Server Settings" in the web admin interface existed in versions
prior to 2.9 (see Configuring the FishEye web server for more details).

See the FishEye 2.9 Release Notes

® Q: Is there any way to return unique results from an EyeQL query?
~ Click here to expand...

A: It is not currently possible to return unique results.
An improvement request exists: FE-1136. Your vote and comments on that issue are appreciated.

Contributing to the FishEye Documentation

Would you like to share your FishEye hints, tips and techniques with us and with other FishEye users? We
welcome your contributions.

On this page:
® Blogging your Technical Tips and Guides — Tips of the Trade
® Contributing Documentation in Other Languages
® Updating the Documentation Itself
® Getting Permission to Update the Documentation
® Qur Style Guide
* How we Manage Community Updates
Blogging your Technical Tips and Guides — Tips of the Trade

Have you written a blog post describing a specific configuration of FishEye or a neat trick that you have
discovered? Let us know, and we will link to your blog from our documentation.

Contributing Documentation in Other Languages

Have you written a guide to FishEye in a language other than English, or translated one of our guides? Let us
know, and we will link to your guide from our documentation. More....

Updating the Documentation Itself

Have you found a mistake in the documentation, or do you have a small addition that would be so easy to add
yourself rather than asking us to do it? You can update the documentation page directly

Getting Permission to Update the Documentation

Please submit the Atlassian Contributor License Agreement.
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Our Style Guide

Please read our short guidelines for authors.

How we Manage Community Updates

Here is a quick guide to how we manage community contributions to our documentation and the copyright that
applies to the documentation:

® Monitoring by technical writers. The Atlassian technical writers monitor the updates to the
documentation spaces, using RSS feeds and watching the spaces. If someone makes an update that
needs some attention from us, we will make the necessary changes.

® Wiki permissions. We use wiki permissions to determine who can edit the documentation spaces. We
ask people to sign the Atlassian Contributor License Agreement (ACLA) and submit it to us. That allows
us to verify that the applicant is a real person. Then we give them permission to update the

documentation.
® Copyright. The Atlassian documentation is published under a Creative Commons CC BY license.

Specifically, we use a Creative Commons Attribution 2.5 Australia License. This means that anyone can
copy, distribute and adapt our documentation provided they acknowledge the source of the
documentation. The CC BY license is shown in the footer of every page, so that anyone who contributes
to our documentation knows that their contribution falls under the same copyright.

RELATED TOPICS

Author Guidelines
Atlassian Contributor License Agreement

FishEye Documentation in Other Languages
Below are some links to FishEye documentation written in other languages. In some cases, the documentation
may be a translation of the English documentation. In other cases, the documentation is an alternative guide

written from scratch in another language. This page presents an opportunity for customers and community
authors to share documentation that they have written in other languages.

Please be aware that these are external guides.

Most of the links point to external sites, and some of the information is relevant to a specific release of
FishEye. Atlassian provides these links because the information is useful and relevant at the time it was
written. Please check carefully whether the information is still relevant when you read it, and whether it is
relevant to your version of FishEye. The information in the linked guides has not been tested or reviewed

by Atlassian.

On this page:
® No guides yet

No guides yet

We do not yet have any guides to link here. Be the first to suggest one!

Adding Your Own Guide to this Page

Have you written a guide for FishEye in another language? Add a comment to this page, linking to your guide.
We will include it if the content fits the requirements of this page.

Giving Feedback about One of the Guides

If you have feedback on one of the guides listed above, please give the feedback to the author of the linked
guide.

If you want to let us know how useful (or otherwise) one of these guides is, please add a comment to this page.
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Other Sources of Information

FishEye documentation
Atlassian website
Atlassian blog

FishEye plugins

FishEye Resources

Resources for Evaluators

® Free Trial
® [eature Tour

Resources for Administrators

FishEye Knowledge Base

FishEye FAQ

Guide to Installing an Atlassian Integrated Suite
The big list of Atlassian gadgets

Downloadable Documentation

® FishEye documentation in PDF, HTML or XML formats

Plugins

® FishEye Developer Documentation
® Add-ons for FishEye

Support
® Atlassian Support
® Support Policies
Forums
® FishEye Forum
® FishEye Developers Forum
Mailing Lists
® Visit http://my.atlassian.com to sign up for mailing lists relating to Atlassian products, such as technical
alerts, product announcements and developer updates.
Feature Requests

® Issue Tracker and Feature Requests for FishEye

Glossary

Code repository or SCM (Source Code Management) software terminology can be confusing. This page
provides definitions for some of the most commonly used terms.

On this page:

® Branch
® Changeset
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Commit
Committer
CSID
Head
Linker
Repository
SCM

Slurp

Tag

Trunk

FishEye and its documentation uses the following terms:

Branch

A branch is an independent stream of work in a repository. For example, you might copy a set of files in the
repository into a new branch, where you can carry on with a separate stream of work without cluttering up the
main production area on trunk.

Different SCMs handle branching and merging in different ways. The common aspects allow users to create a
branch in which to make changes which do not affect the files in other branches and the trunk development
stream. These changes can then be merged into the trunk in a controlled fashion when a development unit of
work is complete. Branches can also be used for experimental changes so that these do not affect the main
development.

Changeset

A changeset is a collection of changes to files in a repository which are committed to the repository in a single
operation with a single commit message. Not all SCMs support atomic commit operations. For these SCMs,
FishEye will determine the file revisions which make up the changeset using a reliable heuristic (set of rules).

Different SCMs use different terms for the concept of a changeset, such as "changelist", which is generally
interchangeable with changeset.

Commit

A commit is a single entry of content (usually source code) into a repository. It can be a single file or comprised
of multiple file versions.

Committer

A committer is a user of an SCM repository who is adding content to the repository (where it will be permanently
archived). Typically, a committer is a programmer who is committing source code but SCMs can also store other
files such as documents, images and schematics.

CSID

An abbreviation for 'Changeset ID', this is a code that is used to reference every set of files that is committed to
a repository. For example, if you commit three files to a repository, they are collectively a changeset, and will
share the one CSID. CSIDs normally appear as a number, for example '31905'. In FishEye, CSIDs appear as
links that you can click to visit the '‘Changeset View', which shows a list of the files in the left column, and the file
contents or diffs in the right hand pane. In some circumstances you can hover your mouse over the CSID to see
the 'Changeset Hover' dialog, which displays the commit message, author, timestamp and files in the
changeset.

Head

The "head" revision is the latest change to be made to a file in either a trunk or a branch part of a repository.
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Linker

FishEye can render issue IDs or Bug IDs that appear in commit messages or comments as hyperlinks to the
relevant issue/bug in your issue/bug tracker. The "linker" patterns used to detect the ID substrings can be
configured separately for each repository. See Linkers.

Repository

A repository is a area managed by an SCM where you store a set of related files, typically from a project or set
of projects. The SCM is responsible for version controlling the files in the repository and maintaining their change
history. A repository will contain the trunk and all branches for the files of the various projects. A single SCM
instance can typically house multiple repositories.

SCM

SCM (Source Code Management) software is a category of computer software that archives complex sets of
files, for example, all the source code comprised in a large multi-part software project. SCM systems keep
copies of every version of every file, allowing you to completely restore and build any version of the software
from any point in time.

Committers typically add new versions of code to the SCM once it is tested and approved by peer code review o
r quality assurance.

Each instance of an SCM can host multiple repositories.

Slurp

"Slurping" is a term that is synonymous with "repository scanning”. FishEye must do intensive scans of the
contents of repositories (SCM systems) in order to provide its lightning-fast web-based browsing of their
contents. This can be referred to as a slurp, or slurping.

Tag

In SCM terminology, a "tag" is a label that is added to a number of files, to capture their collective state at a
particular moment in time. A typical tag would be a specific software version number, that could be referenced to
see all the files that belong to a specific version build of a software project.

Trunk

In SCM terminology, the "trunk" is the central part of the version control "tree". For example, you might copy a
set of files in the repository into a new branch, where you can do new experimental work without cluttering up
the main production area on trunk.

Collecting analytics for FishEye

We are continuously working to make FishEye better. Data about how you use FishEye helps us do that. We
have updated our Privacy Policy so that we may collect usage data automatically, unless you disable

collection. The data we collect includes information about the systems on which your installation of FishEye is
operating, the features you use in FishEye, and your use of common IT terminology within the product. For more
details, see our Privacy Policy, in particular the 'Analytics Information from Downloadable Products' section.

See also our End User Agreement.

How to change data collection settings?

You can opt in to, or out of, data collection at any time. A FishEye admin can change the data collection settings
by going to Analytics (under 'Global Settings') in the FishEye admin area.
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How is data collected?

We use the Atlassian Analytics plugin to collect event data in FishEye. Analytics logs are stored locally and then
periodically uploaded to a secure location.
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